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Introduction
ImagePrint Black Printing Software is a full featured RIP employing an easy to 
use graphical interface that is available for both Windows and Macintosh comput-
ers.  

Features include the use of ICC/ICM color profiles for screen to print and print 
to print matching utilizing a proprietary Color Management Engine with a large 
and - constantly expanding library of high quality paper profiles, advanced queue 
management with Spoolface (the Spooler interface), auto-layout controls with 
optional media optimization, tonal curves, histograms and selective color adjust-
ment, decorative text, annotations, crop marks, borders/backgrounds, step/repeat 
and photo packaging (templates).  ImagePrint also offers unique grayscale print-
ing technology for Epson Ultrachrome printers with split toning and colorized 
grayscales as well as full toning (wide gamut) for effects such as brown toning.  
In addition to the standard interface, “hot folder” support  is available via the 
AutoPrint utility, and printing directly from applications is supported via the PTA 
option, along with print to tiff file functionality.

Documentation Conventions
This manual is designed to be viewed online, using the Adobe Acrobat reader. 

Hyperlinks are available throughout the document to allow you to easily jump to 
sections of interest.  Hyperlinked text is displayed in blue--click these links to 
immediately move to the part of the manual describing the linked text in greater 
detail.

Cross Platform:  This manual is intended for users of both the Macintosh and 
Windows version of ImagePrint. Throughout this document, screen images may 
be presented from either platform, since in virtually all cases differences between 
the platforms are only cosmetic.  In those rare instances where there are sub-
stantial differences between versions, both screen images will be provided.

This guide assumes that you are familiar with the computer interface of your 
operating system. For detailed information on your computer and its interface, 
refer to your computer’s installation guide. 
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Configuration Requirements
Before installing ImagePrint Black, make sure your system meets the minimum configuration 
requirements indicated below.
Macintosh OSX

-   10.11 (El Capitan),10.12.x (Sierra), 10.13.x (High Sierra) and 10.14.x (Mojave)

-	 800 MHz Intel processor with 64 bit support

Windows

-	 Windows 7, Windows 8.x and Windows 10.x (64-bit Operating Systems Only)

-	 800 MHz or above processor

All Platforms

-	 1 Gigabyte of RAM

-	 800 Megabytes of free hard drive space (1 gigabyte free space recommended)

-	 CD-ROM drive

-	 800x600 or above screen resolution

 -   Appropriate connection to the printer

-  Free USB port on computer (or USB hub) for the copy protection dongle

IMPORTANT: The USB copy protection dongle is unique to your installation of ImagePrint. 
It represents the full cost of the software and can not be replaced if lost or stolen. In some 
cases, replacements for damaged dongles may be purchased but require the return of the 
original dongle to ColorByte.

An internet connection to the computer is helpful for installing updates and printer profiles, 
but is not required to operate the software.

Note on minimum requirements: Although any computer meeting the minimum require-
ments listed above should be able to print, speed of printing can be affected by factors 

specific to your particular workflow.  For optimal printing speed, consider increasing the pro-
cessor speed and RAM if multiple-printers are attached or if the computer is also used as a 

workstation to perform other tasks while printing.   
 

Also, some large format printers (such as the Epson 11880) which have the ability to receive 
large amounts of data very quickly can be greatly affected by the computer processing 

speed as well as the speed of the data connection to the printer.  (In cases where the com-
puter is not keeping up with the printer you may see the print head pause at the end of each 

print pass.)
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Contacting Technical Support
Most issues with ImagePrint can be solved by consulting the Troubleshooting guide (located 
in your ImagePrint folder), however, there are times you need a helping hand to get past 
some problems. For that, there’s ColorByte’s technical support department.

ImagePrint comes with phone and email support for the initial installation of the software.  
Once you are up and printing, support shifts to email only for a year after purchase.  But don’t 
be discouraged--ColorByte’s email support is among the best in the business, and responses 
are typically quick and accurate. (In fact, email response times are often much faster than 
those for phone calls during busy times of the day).

That said, support is always more efficient if, when contacting us, you include useful infor-
mation on the problem you are experiencing.  Please consult the following guidelines when 
corresponding with our support dept. to receive a solution to your problem more quickly. 
ColorByte’s email support address is:  support@colorbytesoftware.com

Recommended:  “ImagePrint Diagnostic Utility” 
 

The ImagePrint Diagnostic Utility is an application located in your 
ImagePrint folder that contains several useful functions.  One of them, Send a 
diagnostic snapshot to ColorByte, is a convenient and thorough way to pro-
vide the ColorByte Support department with information that can help them to 

trouble-shoot technical issues.   
 

Launching the Diagnostic Utility from your ImagePrint folder and choosing 
the Send Diagnostic Snapshot to ColorByte option will cause the utility to 

gather information about your ImagePrint installation including recent job files, 
log files, configuration files, and computer settings. You’ll be given the option 
to upload the diagnostics to ColorByte’s online server or save a text copy to 
attach to an email. This is the easiest and most thorough method of pro-

viding ColorByte’s Support Dept. with information on your system. 

Things to include in all correspondence with ColorByte Support:

•	 Your name

•	 Your 6 digit dongle number

•	 The printer you are using

•	 The version and build number of ImagePrint (this can be found by choosing “About” 
under the ImagePrint HELP menu)

•	 The platform (Mac or PC) and the OS (e.g., OSX 10.12.2, or Windows 10).
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Contacting Technical Support (continued)

•	 A brief (but detailed) description of the problem you are having.  Make sure to include any 
error messages exactly as they appear.  Some questions you may also wish to include 
answers for are:

- 	 Have you consulted the Troubleshooting guide?

- 	 Is this a brand new installation of ImagePrint on this computer?

- 	 Has anything changed on your system prior to the problem?

- 	 How are you connected to the printer?

- 	 Have you reproduced the problem, or did it just happen once?

- 	 Does the problem only happen with certain images? (If possible, try printing the “sam-
ple portrait.tif” image that is located in the Test Images folder off the ImagePrint folder 
as a test.)

- 	 What have you already done to try to correct the problem?

Support Availability

Colorbyte Technical Support is available during regular business hours: 9:00 am to 5:00 pm, 
Eastern Standard Time.  Most emails are responded to within 2 hours of receipt (often much more 
quickly) however volume received and other factors may affect response times.  If you have not 
received a response within 24 hours, please resend the email.  

If you are not using the current version of ImagePrint and are not under a support/maintenance 
agreement with ColorByte, you may receive an automated response detailing your support 

options.
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Other ImagePrint Resources
Online Tutorials: The tutorials located on our web site: www.colorbytesoftware.com 
are a great resource for learning ImagePrint by seeing its features in action. It is 
strongly recommended that new users use these as their first introduction to the fea-
tures and workflow of ImagePrint.

Troubleshooting:  The ImagePrint Troubleshooting guide is a separate document 
that contains solutions for most problems you may encounter with ImagePrint.  This 
guide is the recommended first stop when you have a problem with the software.

The TroubleShooting guide is installed in your ImagePrint folder and can be accessed 
from the HELP menu in ImagePrint, and the latest revision of the guide is also avail-
able on our web site’s (www.colorbytesoftware.com) Help  page.  

Reference Manual: What you’re reading now.  The reference manual is available 
from the HELP menu when in ImagePrint, and the latest revision is always available 
on our web site’s (www.colorbytesoftware.com).  The manual is large and compre-
hensive, and is often best used as a general online reference.  Though not meant 
to be read cover to cover, Chapters 4 (the Basics) may be useful for new users 
of ImagePrint to read in its entirety to achieve a good general knowledge of the 
ImagePrint workflow, and chapter 6 is a useful to learn about ImagePrint’s use of 
color management and printer profiles.

Users Group: The Yahoo ImagePrint Users Group is a great source of informa-
tion about ImagePrint.  Users of the software share their advice, tips, solutions (and 
complaints) in an often lively discussion.  ColorByte Software is not affiliated with this 
group in any way, but many of the participants are long time users of ImagePrint and 
gurus in the ways of printing.  To access the group use the following link:

    http://tech.groups.yahoo.com/group/colorbyte_imageprint/

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce 
workshops or seminars, there are existing ones that utilize and teach with ImagePrint.  
Also, ColorByte personnel sometimes appear at industry trade shows or participate in 
dealer seminars.  For information on upcoming events in your area, contact the sales 
department at: 

 	            sales@colorbytesoftware.com

www.colorbytesoftware.com
www.colorbytesoftware.com
http://tech.groups.yahoo.com/group/colorbyte_imageprint/ 
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Installing and Licensing ImagePrint Black
It is recommended that you disable any anti-virus software prior to installing.

Note that Windows users may be prompted to reboot their computer one to two times during 
installation.  The installation will resume after each reboot.
1. If installing on Macintosh, you can insert the USB dongle now.  
    Windows users should wait until prompted (after step 7, below).   
Skip this step if using the software in Demo mode.

2. Retrieve your license number by following the below steps: 
Skip this step if using the software in Demo mode.

► Using a web browser, visit the ImagePrint Black Setup web page: http://print-black.info
► Click the Get Code button below the Activate heading to access a web form where you can 

enter the 6-digit dongle number listed on the dongle and the 6-letter login code included in 
your packaging, along with your email address.  Your license number will be emailed imme-
diately when you click Submit. Hang on to that number--you’ll need it in just a few steps.

3. Click Download for OSX or Download for Windows on the ImagePrint Black Setup page 
(http://print-black.info) to download the ImagePrint Installer to your computer.

4. Once the software has fully downloaded:

 �Windows: Double-click the downloaded file: ImagePrint Installer.exe to begin the instal-
lation. You may be prompted to reboot your computer one or two times during the installa-
tion. The installation will resume automatically after each reboot.

 �Macintosh: Double-click ImagePrint_Installer.dmg to mount the disk image. Then double-
click the file: ImagePrint Installer.pkg in the window that appears to begin the installa-
tion.
If you receive an “Unknown Developer” warning when launching the Installer pkg file, 
right click (or control click) the installer icon instead of double-clicking it and then choose 
OPEN from the context menu that appears.  

5. After reading the License Agreement, click the “I Agree” check box and click the Install button.  

6. Macintosh users only: You will be prompted for your computer password.  After entering it, 
click Continue. 

7. Wait a few seconds while the Installer copies the necessary files on to your computer.

8. Windows users only: At the prompt, insert the USB dongle into an available USB port or 
USB hub attached to your computer.

http://print-black.info
http://print-black.info
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9. A Launch IPSetup button will appear in the installer window.  Click this button to configure and 
license the printer(s) you plan to use with ImagePrint Black. 

 If the Launch IPSetup button never appears you can quit the installer and launch 
IPSetup manually from your ImagePrint folder in Applications (MAC) or  
c:\program files (x86) (WINDOWS).

9. In the IPSetup window click the Add Printer button.

10. Click Continue in the introduction window that appears.

11. Paste or type the license number you received in step two into the LICENSE field and click 
Continue. 

 If you don’t have a license number, choose the Install in Demo Mode option and click 
Continue.  Then choose ImagePrint Black as the installation type and continue the installa-
tion.  (You can always license the software at a later time by relaunching IPSetup from your 
ImagePrint folder and clicking the License button.)

12. In the Choose Printer window, select the printer model that you wish to install from the drop 
down menu and click Continue.

13. Printer Name and Installation Type

Printer Name: 

Type in a name for the printer or use the provided default in the top part of this window. This 
is the name that will be used when choosing the printer in ImagePrint.  (Spaces should not 
be used.) 

Installation Type (Host or Remote Client) 

► If this is the computer that will be communicating with the printer, choose Yes.  (In most 
cases this is the proper selection.) 

► Click No only if you have already installed ImagePrint and licensed ImagePrint on 
another computer and plan to use this computer as a remote client.  Remote clients run 
the ImagePrint interface but send their jobs to the Host computer for printing.  If you 
select this option, in the next window you will be asked to specify the IP Address of the 
ImagePrint Host computer after which the installation will be complete. More information 
on Host/Client printing can be found in the Appendix: ImagePrint Host/Client Setup.

Installing ImagePrint Black - (continued)



14. ���Specify the interface to the printer. 

     Depending on the printer, you will see one or more of the following three options:

System Printer    �(Canon Pro 1000, 2000, 4000, 6000 and Epson P5000, P6000, P7000, 
P8000, P9000, P10000 and P2000 only)

If you are presented with a list of installed system drivers, pick the one used by the printer 
you are installing. ImagePrint will pass its data through this driver connection when print-
ing.  If you don't see your printer listed, see the section at the end of this chapter for 
important information on installing your printer's system driver.

USB 

► Macintosh: Select USB if your printer is connected via a USB cable to the computer.

► Windows: Click the Choose Port button.  In the list of printer drivers that appears, select 
your printer.  Then click OK.

Local Network Connection 
 

If the printer connection is via the network (Ethernet or wifi), click Local Network and provide 
the IP Address of the printer.  This must be a static (unchanging) address

 In most cases you can determine the IP Address of the printer and set it to Static 
(sometimes called Manual or Panel) via its front menu panel.  Check your printer manual 
for specific information.

 				     

Once you have specified your connection, click Done to complete the printer configuration.

15. Your installed printer will now be listed in the IPSetup window.  If you have no other printers 
to set up, close IPSetup by choosing Quit from the menu at the top of the screen. (If you do 
need to setup an additional printer, click Add Printer again and follow the prompts as before).

Your Installation is now complete! 

Choose to Quit, or to get started with ImagePrint Black right away, choose Launch to open 
ImagePrint.

To launch ImagePrint at a later time, on Mac double-click the ImagePrint app icon within the 
Imageprint folder within your Applications folder. On Windows, choose ImagePrint from the 
ColorByte Software group in your Windows Start menu.

Installing ImagePrint (continued)
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Problems?
The following trouble-shooting tips will help you to overcome the two most common 
issues that you might encounter when installing ImagePrint.  Remember, there’s MUCH 
more help available in our Trouble-shooting guide located in your ImagePrint folder, or by 
contacting ColorByte Technical Support (support is available for all users of the current 
version of ImagePrint.) 

Can’t launch the Installer!

If you have downloaded the installer--make sure the download is complete. Double-
clicking the installer before it is fully downloaded will result in an error.

UNKNOWN DEVELOPER message -- If you get a message on a Macintosh computer 
that says the Installer is from an Unknown Developer, that means Apple’s Security soft-
ware, Gatekeeper, is unsure of the source of the installer and won’t let it launch for secu-
rity reasons.  To get around this problem--instead of double-clicking the Installer, Right-
click it (or CONTROL-Click it).  A drop-down window will appear with an option to OPEN 
the installer.  Choose this option, then in the window that appears you’ll have a new 
button that allows you to launch the software.  Note:  You may see this behavior when 
launching ImagePrint or other utilities.  If so, the same procedure applies.

No Dongle Detected!

If the dongle number does not show up at the top of IP Setup when configuring your 
printers, you will not be able to license the software (even a valid license number will be 
reported as INVALID).

Try re-inserting the dongle, then quit and relaunch IP Setup to see if it “sees” it.  

You can relaunch IP Setup from your ImagePrint folder, which is in the Applications 
folder on a Macintosh, in the Program Files (x86) folder for a Windows PC.

If reinserting it fails, you should try a different USB port, or a powered USB hub.  
(Quitting and relaunching IP Setup each time so it re-scans for it).  If that fails, reboot the 
computer and relaunch IP Setup.  If THAT fails, you may have a faulty dongle or some 
issue with your computer’s ability to read the device.  Check our Trouble-shooting guide 
for further recommendations and/or contact ColorByte’s Support dept. at  
                               support@colorbytesoftware.com  
with specific details on the issue, including your computer platform, what steps you have 
taken to correct the problem and the dongle number labeled on the dongle itself.

Installing ImagePrint - (continued)
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Where to go from here?

To launch ImagePrint Black after installing and get to printing, double-click the ImagePrint 
icon from within the ImagePrint folder in Applications (Mac) or choose it from the Programs 
group in your Start menu (Windows).  Mac users may wish to drag the ImagePrint application 
icon to your Macintosh Dock for convenience.

If you need to remove or reconfigure your printers, or uninstall ImagePrint completely, follow 
the instructions later in this chapter.

Further Documentation

The ImagePrint PDF manual you are reading now is located in the ImagePrint folder and can 
be accessed by choosing Manual from the ImagePrint Help menu. In addition to this instal-
lation guide, it describes all ImagePrint features, and is a valuable reference for getting the 
most out of your software.  If you’re new to ImagePrint, Chapter 4 (The Basics) is a great 
place to start, providing a walkthrough of the most commonly used features.  

Need help? A troubleshooting guide is available in the ImagePrint folder, or by choosing 
TroubleShooting from the Help menu when in ImagePrint.  Most problems encountered with 
ImagePrint can be resolved by referencing this guide but email support is available for all 
ImagePrint Black users. The first section of the Troubleshooting guide contains support con-
tact information and recommendations on what information to provide our support dept.

Installing ImagePrint - (continued)



Removing, Reconfiguring or Adding Printers

Removing a printer

To remove a printer, first, make sure that ImagePrint, and Spoolface, are NOT running.  

Then, navigate to the folder where you installed the ImagePrint software,  

The default is \applications\ImagePrint (MAC) or c:\program files\ImagePrint 
(WINDOWS).

Now, double-click the IPSetup application.  

The IPSetup window will be displayed.

To remove an ImagePrint printer, choose its name from the list of printers within the IP 
Setup window, then click the Delete button.

Reconfiguring a printer

To reconfigure a printer to change a configuration option (such as its network address) 
you can simply ADD it again using the previous instructions on Adding a printer.  As long 
as the Printer Name is the same, the newly added configuration for the printer will over-
write the previous one.

Adding an additional printer

If you need to add another printer, just follow the instructions earlier in this manual (start-
ing at page 1-3).

Installing ImagePrint - (continued)
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Completely Uninstalling ImagePrint
To uninstall ImagePrint, and remove it from your system, perform the following steps:

Macintosh

•	 Locate the ImagePrint folder that was created during installation, and drag it to the 
Macintosh Trashcan.  The normal location for the ImagePrint folder is within the 
Applications folder of your hard drive.

•	 Remove the ImagePrint,  IP Setup, and Spoolface icons from your desktop and/or 
dock if they exist.

•	 Remove the ImagePrint preferences file:

			   “com.colorbytesoftware.ImagePrint11.0.plist”

		 This file is located in the /Users/”user name”/library/preferences folder.

Windows

•	 To uninstall ImagePrint, and completely remove it from your system, open your 
Windows Control Panel. (There are several ways to access it.  Here’s two:  On 
Vista/Windows 7 you can choose Start->Run and type “Control Panel”.  On 
Windows 8/8.1, type “Control Panel” when in your Windows Start (Metro Tiles) 
screen.)

•	 Once in the Control Panel, choose Programs and Features.

•	 Double-click the ImagePrint 10 entry in the Programs list that appears, and 
choose UNINSTALL in the window that appears.  Note you can choose to com-
pletely uninstall the software, or leave your old jobs, printer configuration and pro-
files in place (useful if you plan on reinstalling the software at a later date).

Note that a REPAIR option is also available to repair ImagePrint if a problem is occurring 
due to corrupt files.

Installing ImagePrint - (continued)
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Additional Features

 
In addition to the “normal” interface, each copy of ImagePrint also has other 
workflow options available, allowing you to tailor the software to your printing 
needs.

Printing can be done via AutoPrint, the downloadable hot folder applica-
tion.  Also, with the PTA option, you can print directly through applications via 
ImagePrint’s included system driver.

These additional features are described in the following pages.
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Additional Features:

AutoPrint
Printing via “Hot Folders”

If you have a large number of images, using hot folders can be a much more efficient method 
of printing. Just drag your images to a designated folder to have them automatically laid out 
according to your specifications and sent to the printer. ImagePrint comes with a hot folder appli-
cation called AutoPrint.  With AutoPrint, you don’t need to open the ImagePrint interface at all--
just use AutoPrint’s settings menus to specify how images should be laid out, how many images 
should be on each page, and what folder on your computer is the “hot” folder.  Then begin drop-
ping files into the hot folder and watch your layouts build.  As each page is filled, the jobs are 
sent to the ImagePrint spooler, Spoolface, just as though they had been sent from ImagePrint 
itself.

In addition to its high volume printing features, AutoPrint also has some abilities not available 
with ImagePrint’s interface, allowing you to achieve some workflows that are normally not pos-
sible.  

	 •	 You can automatically add watermarks and borders to your TIFF and JPEG files.

	 •	 You can take advantage of more annotation options, such as font and color choices, and 
custom text.

	 •	 You can automatically assign templates, and specify how images are cropped into them.

	 •	 You can set AutoPrint to automatically launch and begin checking multiple hot folder as 
soon as your computer is started

Setting it up

On Macintosh computers, you must first install AutoPrint by double-clicking the AutoPrint_
installer.app located in your ImagePrint folder. 

 Applications -> ImagePrint -> AutoPrint_installer.app

Once the installation is completed, just double-click the AutoPrint.app file in that same folder to 
launch AutoPrint.

On Windows computers, no installation step is needed.  Just double-click the AutoPrint.exe file 
located in your ImagePrint folder to launch it.  (The first time you launch it, it may take up to a 
minute to copy necessary files before the interface launches.)

 \ program files (x86) \ ImagePrint \ AutoPrint.exe

After AutoPrint launched, you can find a user’s guide under it’s VIEW menu.  There are also 
videos showing AutoPrint in use on the ColorByte web site (www.colorbytesoftware.com).  And--
most AutoPrint functions show help text when hovering your mouse over the item.
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Additional Features:

Print Through Application (PTA)
Printing from other programs into ImagePrint’s Spooler

In addition to printing directly from the main ImagePrint interface, or using hot 
folders via AutoPrint, ImagePrint also allows you to print directly from virtually 
any other application, including Photoshop and InDesign.  If the application 
can utilize the Windows Spooler or Macintosh Print Center, then it can print to 
the ImagePrint spooler with PTA.  

With PTA, you can choose your ImagePrint printer from the list of printers 
in your application’s print dialog box, just like any printer.  Clicking Print will 
cause the job to be printed via the ImagePrint spooler, utilizing ImagePrint’s 
color management and high quality printer control.

Installing and using PTA is described in detail in Chapter 17 of this document, 
PTA, Print Through Applications.
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Installing a System Printer Driver
Some printers require the installation of the printer manufacturer's driver in order for ImagePrint 
to communicate with the device.  Currently the printers that require this are the Canon Pro 1000, 
2000, 4000, 6000 and the Epson P5000, P6000, P7000, P8000, P9000, P10000 and P20000.

For these printers the system printer driver should be installed prior to installing ImagePrint as you 
will need to specify it as part of the setup.  If not already installed on your computer, the driver can 
be downloaded from the printer manufacturer's web site. 

For Canon printers you can search for your particular printer driver here:

https://www.usa.canon.com/internet/portal/us/home/support?tab=drivers

For Epson printers, you can search for your printer's driver here:

https://epson.com/Support/Printers/Single-Function-Inkjet-Printers/SureColor-Series/sh/s116

Driver Requirements

Important: Only the United States version of the driver is supported.  If using a non-US version 
you will need to remove it and install the US version instead from the above web sites.

Requirements for Windows: When downloading and installing a Canon printer driver, the XPS 
version of the driver should be used.

Requirements for Macintosh: Be careful not to add the printer as an "Air Print" device which will 
cause it to have limited functionality and not work with ImagePrint.  You can see if your printer is 
installed as an Air Print version via the following procedure:

From your Apple menu, choose System Preferences, then Printers & Scanners.  

Click the printer from the list of printers.  

In the right side of the Printers & Scanners windows the printer "Kind" will be listed.  

If it shows Air Print, the printer is configured as an Air Print printer and must be removed and re-
added to work with ImagePrint. 

► To remove the printer, click on the printer name in the list of printers and click the minus (-) but-
ton.

► To add the printer in the standard (non-Air Print) configuration, choose the plus (+) button at 
the bottom of the printer list, but do not choose your printer from the list of "Nearby printers" in the 
drop-down menu.  Instead, choose Add Printer or Scanner... in the "plus" drop-down menu. A 
window will then appear with a list of printers. Choose your printer and make sure that at the bot-
tom of the window (in the "Use" field) Air Print is not displayed. Instead, choose the printer driver 
name in the drop-down menu.  Then click the ADD button to complete the installation. 

https://www.usa.canon.com/internet/portal/us/home/support?tab=drivers 
https://epson.com/Support/Printers/Single-Function-Inkjet-Printers/SureColor-Series/sh/s116 
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Overview
To help you get oriented, this chapter gives a very brief orientation for the various tools and 
components along with pointers to detailed documentation on each.  

ImagePrint - The Main Interface

The main application, ImagePrint, is the control center for laying out images and sending 
them to your output device.  

• 		 To get printing very quickly without a lot of extra details, see chapter 3, Printing 
Quickstart.  

• 		 For a more detailed walkthrough of using ImagePrint, see Chapter 4, ImagePrint 
Basics. This is the recommended starting chapter for new users of ImagePrint.

• 		 Chapter 5 is a complete reference that steps through all the menus and features 
including the Dashboard.

• 		 The important subject of ICC/ICM profiles and color management is discussed in 
chapter 6, Color Management including information on the Profile Valet.

• 		 Preferences and Image settings are described in chapter 7: Preferences and Image 
Properties.

• 		 Using Automatic Layout Settings to automatically size and position images as you 
open them is discussed in chapter 8: Layout Styles and Auto Layout Settings.

• 		 ImagePrint’s Color Correction tools, as well as Output Sharpening and Narrow and 
Wide Gamut Toning, are discussed in chapter 9: Color Correction.

• 		 ImagePrint’s powerful layout and design tools are described in chapters 11 The 
Border Browser , chapter 12: Templates, chapter 14: Boundaries, and chapter 13: 
Adding Backgrounds, Frames and Gallery Wrap.

• 		 The details of sending a job to your printer, including printer specific options,  are 
discussed in chapter 15: Printing and Print Setup. 

• 		 Print through Applications (PTA) allows you to print to the ImagePrint spooler from 
your applications.  It’s described in detail in chapter 17: PTA .

• 		 Finally, important information for specific printers (such as available ink sets), infor-
mation on network printing, phatte black, profile naming conventions and keyboard 
shortcuts can be found in the Appendix.  

• 		 A stand-alone Troubleshooting guide is available as a separate document in your 
ImagePrint folder or from the ColorByte web site.
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SpoolFace - The ImagePrint Spooler

SpoolFace, the ImagePrint Spooler is an advanced print manager capable of controlling multiple 
print spools.  With SpoolFace, jobs can be prioritized, cancelled, and re-sent.  For details on 
using the ImagePrint spooler, see chapter 16, The ImagePrint Spooler.

AutoPrint - The Hot Folder Application

The AutoPrint utility automates the printing process through the use of user specified “hot” fold-
ers. AutoPrint constantly monitors these folders for new TIFF, JPEG, PDF or Photoshop PSD 
files, and automatically fits them onto a  page and sends them to the AutoPrint Spooler accord-
ing to parameters that you specify.  

On Macintosh computers, you must first install AutoPrint by double-clicking the AutoPrint_
installer.app located in your ImagePrint folder. 

 Applications -> ImagePrint -> AutoPrint_installer.app

Once the installation is completed, just double-click the AutoPrint.app file in that same folder to 
launch AutoPrint.

On Windows computers, no installation step is needed.  Just double-click the AutoPrint.exe file 
located in your ImagePrint folder to launch it.  (The first time you launch it, it may take up to a 
minute to copy necessary files before the interface launches.)

 \ program files (x86) \ ImagePrint \ AutoPrint.exe

After AutoPrint launched, you can find a user’s guide under it’s VIEW menu.  There are also 
videos showing AutoPrint in use on the ColorByte web site (www.colorbytesoftware.com).  And--
most AutoPrint functions show help text when hovering your mouse over the item.

Printing to and from other computers - Host and Client printing
ImagePrint offers two options for printing from one computer to another, including a mixed 
Macintosh and Windows PC network.

	 • 	 By default, ImagePrint is installed as a HOST.  The HOST is the computer that is 
licensed (and has the USB dongle attached), and is the computer that will communicate 
with the printer.  
 
After installing and licensing ImagePrint as a HOST, you can then install the software 
as a CLIENT on any number of other computers on the same network. A CLIENT install 
enjoys all the layout features of the ImagePrint interface but, when print is clicked, it 
will send all jobs to the HOST computer for actual printing. A CLIENT computer does 
not have a USB dongle or license--all license checking takes place on the HOST as the 
job is printed. For more information on CLIENT/HOST printing, see the Appendix of this 
manual.
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Printing (Very) Quickstart 
This chapter is for those who wish to skip the details and get printing right away. 

These instructions do not dwell on details within the interface, and are provided as 
a quick means to “get your feet wet” by doing a very basic test print without worrying 
too much on the specifics. 

Those who want a more comprehensive overview may want to skip this chapter and 
proceed to the chapter 4, ImagePrint Basics.

Note: Another method of quickly getting up to speed with ImagePrint is via our 
Interactive Tutorials.  These small movies can be accessed from the ColorByte 

web site (www.colorbytesoftware.com). 

Before proceeding, make sure you have installed ImagePrint according to the installa-
tion instructions in Chapter 1. 
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Step 1: Launch ImagePrint and pick your printer

Double-click the ImagePrint executable:

   - 	 For Macs, ImagePrint is in the /Applications/ImagePrint folder

   - 	 For Windows, ImagePrint is in the \Program Files (x86)\ImagePrint folder or on 
your desktop.

The ImagePrint Main window will appear.  By default, you’ll be set to a single page layout-
-that’s fine for now.  

The page is the big white area 
where you’re images will appear--if 
you don’t see it, you may need to 
reset your window positions.  Go 
to the View menu at the top of the 
screen and choose Reset Window 
Positions to get the software back 
to its default look.

For this basic print you’ll just 
need to pick your printer, specify 
a page size and a paper profile, 
and set the print for roll or sheet. 
ImagePrint makes it easy--all those 
settings are laid out conveniently 
right there in the Dashboard.

Let’s start with 
choosing the Printer.

Printer is the sec-
ond entry in the 
Dashboard.  Click the 
small triangle beside 
the word printer to 
expand the section 
and see the Printer 
menu.

Choose the Printer

If you’ve only have one printer 
installed you can skip this step
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Step 2: Select the Paper Size and Roll or Sheet

          Making a custom paper size

What about ROLL paper?

If you’re using roll media, specify the exact WIDTH of the paper.  For the 
HEIGHT specify a value that will accommodate the images you plan to print.  
Don’t worry about wasting paper--by default ImagePrint uses Inked Area 
Only mode--it will only output the portion of the paper with images on it.

If you chose to create 
a User Defined page the 

Custom Page Size window 
will appear.

Just type a name for the 
new size in the Name field 

and specify the actual paper 
dimensions in the Width/

Height fields.  

Then click SAVE

Your new size will appear 
in the list on the left--pick it 
by clicking on its name then 

choose OK to load it.

Expand the PAPER SIZE menu 
beside the Printer drop-down by clicking 
the small arrow.  Then pick a pre-select-
ed page size or choose User Defined 
to create a custom size (more on that 

below).

You should also specify if you are print-
ing on roll or sheet.



Step 3: Select the Printer Profile

Now it’s time to pick a Printer Profile for the paper you plan to use.  If you have an internet con-
nection the new Profile Valet makes this a snap for most printers.  (If you don’t have an inter-
net connection on your ImagePrint computer or are using an Epson Stylus 2200, 4000, 7600 or 
9600, sorry--the Profile Valet is not available--you’ll need to use the Choose by Profile method 
described on the next page).  

3-5 ImagePrint Black User’s Guide

Expand the PRINTER 
PROFILE section of the 

Dashboard to see the Profile 
Valet.

The Profile Valet will use 
your computer’s internet con-
nection to access ColorByte’s 
online profile repository and 
install the profile based on 
the options you choose.

Use the buttons to specify the 
type of black ink the paper should 

use (typically Matte or Photo)...

...and choose between a 
Color or Grayscale profile.
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Finally, click Download and Apply to automat-
ically download the profile.  

Next, choose the Brand of 
Paper from the Brand drop-

down menu.

Then choose the Paper 
Name from the Paper drop-

down menu.

For this test print leave 
the Quality and Display 
Lighting at their default 

selections.

Another method -- Choose by Profile

If you don’t have an 
internet connection or 
are using a printer that 
isn’t compatible with 
the Profile Valet, you’ll 
need to pick profiles by 
filename just as it was 
done in previous ver-
sions of ImagePrint.    

Profiles you don’t 
have can be manu-
ally downloaded via the 
Profile Manager utility.  
This method is fully 
described in chapter 
6, Color Management, 
later in this manual.
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Step 4: Add images

We’ll use the Image Strip to choose the images you want to print.  (You can also use 
File->Open or just drag images right from their folders onto the layout area).   

If the Image Strip is not already open, choose it from ImagePrint’s View menu. 

The Image Strip will show thumb-
nails of image files within your 

IMAGE STRIP folder. How to choose 
that is described on the next page.

You can dock the strip on the bottom 
or left side of your ImagePrint window 
by dragging it close to an edge--or you 
can choose to leave the Image Strip as 

a free floating window.

Avoid the clutter!

You can also drag the Image Strip on 
top of the Dashboard to combine the 
two into one window.  Simply click the 
label at the bottom to switch between 

them. Combined Image 
Strip and Dashboard 

Window
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Step 4: Add images (cont)

Once you specify your Image Location, the image files will 
appear as thumbnails in the Image Strip.

Now--just drag images right on to the ImagePrint page to have them automatically laid out.

ImagePrint will fit them as you drag them in, but you can always arrange images yourself by 
clicking them and dragging.

Image Too Big?  Images open 
at their saved size, but there’s 
lots of ways to resize images in 
ImagePrint.

- Type the Width/Height into 
the fields in the Controls and 
Positions window located by 
default at the top of the screen. 
The dashboard also has an 
“Image Properties” section with 
width/height fields.

- You can also proportionally resize images by clicking their EDGE (not the corner or it will be 
non-proportional) and drag. 

- Or, just click the Fit to Printable Area  button, in the floating  tool palette (that’s the 
long bar with the magnifying glass and other icons) to grow the selected image quickly to fill 
the whole page.  

Expand the Image Strip 
Folder section at the top 

of the Dashboard and use 
the Folder tree to locate the 
folder where you keep your 

images.

ImagePrint can open TIFF, 
JPEG, PNG, PDF and 

Photoshop PSD files only.

If you don’t have images of 
your own ready to print, you 

can print the “sample portrait” 
tiff file located in the Test 
Images folder within your 

ImagePrint folder.
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Step 5. Print! 

Now that you have your page size picked, your profiles selected and  your images in place, 
click the Print button at the top of the Dashboard to send your layout to the printer!

Want to print some more?

After clicking print, you can use the scissors in the tool palette to remove the images in the 
lay out and add more or close ImagePrint--printing happens in the background so no need to 
wait.

You should hear the printer kicking in about now.  If you don’t, or just want to check the print 
status--move to the next step to launch SpoolFace, the interface into the ImagePrint print 
queue, where all print jobs wait their turn to print.

In Spoolface, you’ll be able to cancel and reprint jobs, see the status of your print, and view 
any error messages. 
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Step 6. Check Spoolface to see the status of your print

Launch SpoolFace by clicking the Spooler button at the top of the Dashboard.

 ACTIVE

Currently printing jobs appear on the top 
left pane of the spooler

SAVED

Finished or cancelled jobs appear on 
the bottom left of the spooler

Click the Spooler button in the 
ImagePrint Dashboard...

...to have SpoolFace Appear
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Working with SpoolFace (cont.)

The bottom left corner of SpoolFace shows its status.  If it’s Paused, choose 
Queue from the Spoolface menu, then uncheck Pause Printing.

Printer problems (like running out of paper) or problems with your 
print jobs may make SpoolFace pause.  Nothing will be printed again 

until you unpause SpoolFace.

The top job on the left side will always be the next job to print--you may need 
to move older jobs to the right side before sending new ones.

Note on DEMO printing

If you don’t have a license number for ImagePrint but want to print in DEMO mode (with 
the word DEMO watermarked on your prints), make sure “Print if Demo” is selected within 

the QUEUE menu’s DEMO options. Otherwise, nothing will print at all!

To cancel a job, highlight it and drag it to the bottom pane.

To re-submit a job, highlight it on the bottom pane and drag it to the top.



ImagePrint Basics

4
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The General ImagePrint Workflow

There are typically three basic steps to any ImagePrint session:

1. Opening and laying out your images.

2. Choosing paper and page settings and the profile for your paper.

3. Sending the job to print.

In this chapter, each of these steps will be touched on, providing a general walkthrough 
of the core ImagePrint workflow.  While comprehensive information for all of ImagePrint’s 
features is available within subsequent chapters, reading through this chapter alone should 
provide the understanding needed to effectively use ImagePrint, with other chapters serv-
ing as a reference when needed.

Of course, each ImagePrint session must first start with launching the program.

The Basics: Starting ImagePrint

To start ImagePrint, double-click the ImagePrint icon.  

On Mac versions*, you can find the ImagePrint icon in the  
                        /Applications/ImagePrint folder

On PC versions, the ImagePrint icon should be on your Desktop, or in the  
                       C:\Program Files (x86)\ImagePrint folder.

The ImagePrint Main application will appear with 
it’s default elements in place. 

*Macintosh users: To launch the program conve-
niently in the future, drag its icon to your Dock.

Macintosh Version Shown
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The Basics: The Default ImagePrint Windows

When you first open ImagePrint, the default windows will appear docked within the Main 
Program window.  All ImagePrint windows are dockable and undockable, meaning you can 
choose to have them all fixed within the Main Window “container” or floating separately.   

The following elements appear when ImagePrint is first launched:

1. The Page Layout Window - This window contains the representations of all the pages with-
in your layout. This is where you will place the images you plan to print.

2. The Dashboard - This window is your “control center” for most ImagePrint functions.

3. The Floating Tool Palette - Icons for commonly used tools, like Zoom or Rotate, can be 
found in this tool bar.

4. The Image Strip - The Image Strip shows thumbnails of images within a selected folder for 
easy layout.

5. The Main Menu, Shuffle and Size and Position Controls - Along the top of the ImagePrint 
window you’ll find the File, Edit, View and Help menus that provide access to some ImagePrint 
functions and advanced tools such asTemplates and the Border Browser. Also, by default, the 
Size and Position Controls palette will appear here, which will let you dynamically adjust the 
size and position of the selected image or interface element.  Finally, the Shuffle buttons allow 
you to quickly alter the positioning of the images on the page to conserve paper or make for 
more efficient cutting.
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 The Basics: Docking and Undocking
With ImagePrint, almost every ele-
ment in the interface has become a 
Dockable window.  This means the 
window can be locked into position 
or moved independently of all other 
elements.

This feature allows for virtually 
unlimited flexibility in setting up 
your work environment, and can be 
especially useful for multiple-mon-
itor setups, allowing you to keep 
some tools, such as the Image Strip 
or Dashboard on one monitor while 
displaying your layout (pages) window full screen on the other.

To specify if a window dockable or undockable, use the 
View Menu at the top of the ImagePrint screen.  First, 
make sure the window is Viewable by selecting that option 
if it’s not already checked.

By choosing Dockable for any visible window, dragging 
that window to the top, bottom, or sides of the ImagePrint 
Main Window will cause it to dock.  You’ll see that it’s 
ready to dock when the Main Window changes color.

When you choose for a window to not be Dockable (no checkbox beside Dockable) then the win-
dow will be able to move freely anywhere on screen.

When you dock a window while other windows are docked in 
the main window, you may see them move to make room for the 

new window.  Sometimes it can be tricky to dock a 
window just where you want--it may “jump” to one 
side or another, or an already docked window may 
move to an undesirable position.  It may take a 
few tries to get your windows just where you want 
them.

If you want to go back to the way things were, just 
choose Reset Window Positions from the View 
menu at the top of the screen 
and the windows will go back 
to their default, docked, posi-
tions.

Docked--the image strip 
is now docked in place.

Ready to dock--other windows 
move out of the way and the 
main window changes color.
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The Basics: Creating a layout
The white area within the patterned boundary is the printable area 

The pink cross hatched border area represents the part of the page on 
which the printer can not print (the non-printable area).  Any portion of an 
image on the pink area will not print.

The dark gray area surrounding the page area is unused.  Any images in 
this area will not print. 

It’s very important to realize that the printable part of the layout area can be changed by vari-
ous page mode settings that affect the printable area of the printer, such as Roll vs Sheet, 
Borderless vs. non-Borderless, and Center Margins vs Regular Margins.

Specifying Roll or Sheet and Paper Size

In order to print correctly, you’ll need to specify if you are 
using Roll or Sheet media and choose a page size 
that corresponds to the paper loaded in the printer. 

Both settings are chosen within the ImagePrint 
Dashboard.  The Dashboard is where you’ll find 
all the settings you typically need for basic printing. 
Think of it as your printing control center.

Choose the triangle icon beside the word PRINTER 
in the dashboard to expand the Printer Selector. 
This is where you pick the printer you’ll be using, 
and most media related settings. Many of these 
are self-explanatory, and all of these settings are 
describe in detail in the following chapter but let’s go 
over two right now.

First--make sure your Printer is 
selected in the drop down menu 
on the left.

Next, the drop down menu to the 
right of the printer name is where 
you choose the Paper Size you 
want to use.  

Don’t see a paper size that matches what you’re using?  Click “User Defined” to create a 
custom page size (see below).
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The Basics: Creating a layout (Cont.)

Defining a Custom Page Size

To define a user defined page size, 
choose User Defined from the page 
size menu in the Dashboard.  

The Custom Page Size window will 
appear.

To specify a new custom page 
size:

Type the desired name of the 
new page size in the Page 
Size field of the Custom Page 
Size window. 

Define the page width and 
height in their respective 
fields. 

Click Save to have new page 
size added to the list of user 
defined pages on the left of 
the Custom Page Size win-
dow.

Finally, choose your new page size’s name in the Page Size list on the left and 
click the OK button.  The Printer Setup window will show the page size, and the 
currently selected custom page size will become the active page.

Important note on page sizes: Always specify a page size that exactly corre-
sponds to the physical page size loaded on the printer.  For sheet paper, make sure 

both the width and the height are the same, for roll, the height can vary, but the 
width should be the exact width of the roll paper.

The list of User 
Defined page sizes 
is displayed here
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 The Basics: Adding Pages
ImagePrint 10 introduces a new Page Window that makes creating and working with multiple 
page layouts simple.   

Make sure the Pages Window is visible.  If you don’t see it, go to the Views menu and make 
sure Visible is checked beside the Pages Window option.

In the top left corner of the Pages Window is the Page Creation tool.

Clicking on this icon and dragging will 
cause page icons to be displayed. 

As you drag, more icons will be shown-
-dragging to the right or left increases or 
decreases the number of horizontal col-
umns of pages, up or down controls the 
number of vertical rows of pages.

When you release the mouse, you’ll see the pages created within the Pages Window, ready to 
begin filling with images.

Page Numbers

Notice that the upper edge of each 
page displays it’s page number, fol-
lowed by it’s column and row number. 
Don’t worry--these numbers won’t print.  
They are just informational:

•	 	 As images are added, if they 
don’t fit on a page, they will be 
added to the next highest num-
bered page that has room. 

•	 	 Pages are printed in their page 
number order.

To see how page numbers are determined, see More on Creating pages on the next page.
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More on creating pages

Mind the Arrows!

When you drag to create pages, notice that there will be red arrows 
pointing to the left, or the right, and red text will specify “grow verti-
cally” or “grow horizontally”.  Both let you know in what direction new 
pages will be created as others are filled.  

Horizontal arrows means new pages will be added to the right side of 
your layout, while vertically means they will be added to the bottom.  

Note--these arrows do NOT specify where the images will be placed 
as pages are filled.  Image placement is always based on Page Number.  The first area 
large enough to fit the image in the lowest available page number will get the image. 
(Remember--each page shows its number in the lower section).

Page numbering

How pages are numbered is also based on the arrows, but in the opposite direction. This 
can be confusing, but since new pages will be added in the direction of the arrows (verti-
cally or horizontally) when all pages are filled, the page numbering will flow in the opposite 
direction.  That’s because all the existing pages will be filled before new pages can be 
added.

So--if you created pages that will added horizontally (right arrows) as they are filled, the 
page numbering will flow vertically (Page one will be in the upper left, and page two will be 
below it, etc.).

Don’t like your page layout -- Just recreate it!

Creating and removing pages is non-destructive.  
If you want to change the page layout, just click the 
Page Creation icon again and re-drag it.  No images 
will be deleted or moved (though, if you reduce the 
number of pages, some images may end up outside 
of any pages and won’t print until they are moved or 
new pages are created “under” them again.)

The Basics: Adding Pages  (Cont.)

Until these two images are 
within a page they won’t print
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The Basics: Spreads

Normally, when you create pages by dragging the Page 
Creation tool, you can create as many vertical columns of pages 
as you like.  

You can specify a special Layout Mode called “Spread Mode”, 
however, that limits you to two page spreads when creating 
pages.  

Spread mode is useful if you plan to create photo albums or 
other types of books from your images because, in addition 
to the normal page margins, you can specify a non-printable  
“binding gap” between facing pages when in Spread mode.  

You can switch between 
Normal and Spreads by click-
ing the View Menu at the top 
of the ImagePrint screen and 
choosing either option from 
the Page Layout selection.

Specifying the Spreads Mode Binding Gap

The Binding Gap represents the non-printable margin between two 
facing pages that allows for the pages to be bound together without 
obscuring portions of the print.

The Binding Gap is set in ImagePrint’s Preferences window.  

Choose Preferences from the View menu (if on Windows), or the 
ImagePrint menu (if on Mac).  

In the Preferences window, click the 
Pages Tab.  

In the Spreads section of the Pages window, you can enter a 
Binding gap value in the currently used units (inches or cen-
timeters). 

When you close the Preferences window, you’ll see the bind-
ing gap represented on your pages as a patterned area.   
This is a non-printable area. 

If you drag an image across the binding gap, it will split 
across it, allowing you to print one image across two facing 

pages.

When the Layout is set to 
Spreads, you can only create 

facing pages.
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The Basics: Choosing Profiles

Now that you have a page size picked, it’s a good time to check your profile settings. 
Profile Settings are discussed in much greater detail in chapter 6, 

A basic familiarity of Color Management concepts is strongly recommended to 
ensure a properly color managed workflow.  Books like Bruce Fraser’s “Real World 

Color Management” can be a valuable resource in understanding how ICC/ICM 
Profiles relate to digital output.

First, some background on Color Profiles (feel free to skip to the next page if you are 
already familiar with Color Management concepts.)

Color Profiles define color characteristics for images and devices.  For the purposes 
of printing, the colors within the image need to be converted to work within the color 
capabilities of the printer.  The way ImagePrint knows what the color boundaries are 
for both the image, and the printer, is via ICC (also called icm) profiles. Profiles are 
basically files containing color information corresponding to a device or image.

Color Management consists of 1) specifying what Color Profile defines the colors with-
in the image, 2) specifying the Color Profile that defines the colors the printer is capa-
ble of printing, and then 3) converting from one to the other to maintain the image’s 
appearance as closely as possible.

Printer (aka Paper) Profile: Of course, the colors the printer is capable of printing 
varies depending on the ink and paper used (among other things).  That’s why there 
are different printer profiles for different papers--each one defines the colors that the 
printer can print on that paper.  Picking the right printer profile for your paper is thus 
critical in achieving proper output.  Luckily, ImagePrint’s huge selection of top of the 
line printer profiles makes it easy.

Source (Image) Profile: Likewise, since all of the colors within the image have to be 
converted into the printer’s color space, it’s vital for the printing software to know what 
the color range (gamut) of the image is to do the conversion correctly.  That’s where 
the proper source profile comes in. It tells us the entire range of possible colors within 
a particular image.  Nowadays, most photographic images carry that profile with them 
as an embedded profile.  That simply means when the image was created, a copy of 
the source profile was saved with it--and that’s great for simplifying color management 
and avoiding mistakes.  With embedded profiles, half the work of profile selection is 
already done--programs like ImagePrint know right away what the proper source pro-
file as soon as it opens the image!



The Basics: Choosing Profiles (continued)

Printer Profiles are chosen within the ImagePrint Dashboard.  In the Dashboard, click the 
triangle beside PRINTER PROFILE to expand that section. You can also think of the Printer 

Profile as the Paper profile, since 
it applies to the paper you are 
using as well.

Choosing your printer (paper) pro-
file with the Profile Valet 

(Recommended)

If you have an internet connec-
tion the new Profile Valet is the 
recommended way to pick the 
right profile for your printer and 
paper.  (If you don’t have an inter-
net connection on your ImagePrint 
computer or are using an Epson 
Stylus 2200, 4000, 7600 or 9600 
the Profile Valet is not available-
-you’ll need to use the Choose by 
Profile method described on the 
next page).  

Make sure Profile Valet is selected at the top of the PRINTER PROFILE section. Then pick 
the options that apply to the paper you wish to use.  As you make your selections the Valet 
will narrow down its list of available profiles.

Ink: 	 This really is designating which Black ink should be used.  Matte papers use 
Matte Black ink.  Photo (any paper with a sheen) typically use Photo black 
ink.  Phatte black is a special mode ImagePrint offers that allows both Photo 
and Matte black to be used on printers that normally on support one black at 
a time.

Color: 	Specify if you plan to print using a Color printer profile or one of Image Print’s 
special grayscale profiles (for optimal b&w printing)

DCM:	 Dynamic Contrast Matching  profiles have enhanced contrast based on the 
characteristics of the paper.  All profiles for newer printers contain this tech-
nology (so the option won’t be selectable) but older printers may have both 
DCM and legacy non-DCM profiles available.

Brand:	Choose the maker of your paper
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Paper:	Choose the name of the 
paper you plan to use

Quality: The quality mode desig-
nates the ink droplet size that 
will be used.  Each profile is 
made for a specific quality 
mode.

Display Lighting: ColorByte gener-
ates multiple Color profiles 
optimized for the viewing 
conditions of the print’s display environment (for instance, a DAYLIGHT 
optimized print will look its best near a window or outside).  

Once you have selected all the options, the Profile Valet will choose the profile from its list 
of available profiles on ColorByte’s online profile repository.

Applying the Profile

- If you already have the profile on your computer, you’ll see a small house icon beside 
the profile name.  Click the Apply button to apply the profile.

- If the profile is NOT already on your computer, the button at the bottom of the Profile 
Valet will read Download and Apply.  Click this button to have ImagePrint acquire the 
profile from the online library and apply it automatically.

For additional information on ImagePrint’s use of Printer Profiles, including naming con-
ventions, profile types, and how to download additional profiles from the internet, please 

see chapter 6, Color Management.

The Basics: Choosing Profiles (continued)
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The Basics: (cont)

Choosing your printer (paper) profile without going online

If you don’t have an internet connection 
or are using a printer that isn’t compatible 
with the Profile Valet, you’ll need to pick 
profiles by the actual profile name rather 
than the paper name.  Because the file-
name of the profile uses will abbreviations 
due to character limitations, this method is 
less intuitive. Also, only profiles available 
on your system will be available for choos-
ing.    

In the PRINTER PROFILE section of the Dashboard, click Choose by Profile.  

Select the profile from the drop-down list--you can narrow down your selection by ink set 
(Photo, Matte, or Phatte) and Color vs Gray via the checkboxes above the drop-down.

When NOT using the Profile Valet, Profiles you don’t have can be manually downloaded via 
the Profile Manager utility.  This method is fully described in chapter 6, Color Management, 
later in this manual.  For now, if you don’t see a profile that matches the paper you’re using, 
you may want to select a similar one from the list for the purposes of this walkthrough--but 
be careful--the profile must be made for the INK Set (black ink type) that is available on 
your printer.  At the beginning of the profile name look for the correct ink set designa-
tion:

mk - Matte Black

pk - Photo Black

dk - Phatte Black

For additional information on ImagePrint’s use of Printer Profiles, including naming conven-
tions, profile types, and how to download additional profiles from the internet, please see 

chapter 6, Color Management.
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The Basics: (continued)

Specifying the Source (image) Profile

By default, ImagePrint will look for an embedded profile in each image it opens and use 
that as the source space.  For most workflows, that means nothing else needs to be 
done--if your images have embedded profiles (most do) you can move on to the next 
section--Creating a Layout.

For images that don’t have embedded profiles, ImagePrint  will use the default source 
profiles specified in its Preferences window.  For RGB images, the default is Adobe 1998.  
For single-channel grayscale images, the default is Gray Gamma 2.2.  And, for CMYK 
images, the default is US Web Coated SWOP. These are the most commonly used color 
spaces for those types of images.

If your images don’t have embedded profiles and they don’t use one of the above 
defaults, you should change the defaults to match your workflow.  To change the default 
profiles ImagePrint uses, choose preferences (via the View Menu on Windows or the 
ImagePrint menu if on Mac) then click PROFILE and change the defaults accordingly.

Not sure? 
If you’re not sure of the profile settings of your images, skip to the next section and 

begin laying out images.  ImagePrint’s display is fully color managed--if the image’s look 
fine on screen, chances are your source profile settings are correct.  If the color seems 

off then you may need to check what settings were used when they were created.

You are now ready to open images and place them on the page!
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The Basics: Working with Images

Now that you’ve made sure the page size and color management settings are correct, its time 
to open one or more images. Once opened, images can be arranged within the Pages window.

Opening Images

There are three ways to open images in ImagePrint.  

File -> Open

Choose File from the ImagePrint main menu, then choose OPEN to access a standard file 
open dialog allowing you to locate the files(s) you wish to open. The image will open on the first 
available page that has room for it.

Drag and Drop

You can also drag image files from any folder on your system to the ImagePrint layout window. 
If working with multiple pages, this method lets you specify which page to place the image on.

The Image Strip

The Image Strip is a 
graphical way to locate 
your images.  

If it’s not already visible, choose Image Strip from the View menu at the top of the screen. You 
can dock the Image Strip within the ImagePrint main window, or leave it free floating.

Filling the Image Strip with your images

To specify what images on your computer are 
shown in the Image Strip, expand the IMAGE 
STRIP FOLDER section of the Dashboard, 
and use the folder tree to locate your image 
folder.

Click Add to Favorites to save that folder into 
your Favorites list. Then, in the future, just 
choose it from the Favorites Tab.

Remember: ImagePrint works with TIFF, 
JPEG, PDF, PNG and Photoshop PSD files 
only.

To avoid clutter, you can drag the Image Strip over the dashboard to combine the two into one 
window with a selection button at the bottom.
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The Basics: Working with Images - Image Placement

Once you have the Image Strip populated with your images, just drag or double-click a thumb-
nail to add it to your layout. 

Dragging to a specific page 

If dragging an image from a folder or from the Image Strip, you can release the image on top 
of any page in your layout to place it on that page.  You’ll see the selected page turn gray, 
meaning it’s the current target page for the image. (If the image can’t fit, it will still automati-
cally move to the next page that can accommodate it.)

Page Origin Point - Where images open

Images will be positioned with their upper left corner at the page origin point. By default, the 
origin point is located at the upper left corner of the page’s printable area, but you can specify 
a different origin point in the Dashboard’s Layout Settings.  The Page Origin point is shown in 
blue on each page.

Nesting - Where images fit

Images will automatically “nest” as they are opened.  Starting from the upper left, the image 
will be placed into the first available space that can fit the image. If there’s no room on the cur-
rent page, it will attempt to fit on another one.  If the image is too big for the printable area of 
even an empty page it will simply be placed at the origin point, on top of other images that may 
already exist on the page.

While ImagePrint will automatically find a place to fit each image as it’s opened, it doesn’t opti-
mize the image positioning to save paper.  At any time, however, you can “Shuffle” the layout 
to make better use of the paper or make for more efficient separation of the images when it’s 
time to cut them apart.  

The next page describes using the three Shuffle modes to optimize your layout with the click of 
a button.
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Shuffle - Optimize layouts to save paper or make for easier cutting

The three icons above the layout area are the Shuffle controls.  Each 
one, when clicked, will immediatly “shuffle” all the images on the page, 
repositioning them and rotating them if necessary in order to conserve 
paper or make cutting the images apart easier.

The three shuffle modes are:

Tight Shuffle 

This mode typically saves the most paper (but not always).  
Images are rearranged to fit as high on the page as possible, 
with absolutely no concern for easy cutting.  While this mode 
will save paper, if you have lots of images of different sizes it 
may result in a more dificult to cut “jigsaw” arrangement.

Cut Shuffle

Images will be positioned to fit as high on the page as possi-
ble (conserving paper) while guaranteeing that image separa-
tion can be done with single vertical or horizontal “straight-
across” cuts at every step in the process (no right-angle cuts).  

Easy Cut Shuffle

This shuffle mode maintains clear horizontal cut lines 
between rows of images.  It often saves less paper than the 
other modes but is the easiest to cut as it will only require 
horizontal cuts followed by simple vertical cuts to separate 
all the images. 
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Shuffle Settings

You can tell Shuffle where on the page images shuold be positioned, and how far apart the 
images should be placed from one another, via the Layout Settings section of the dashboard.  

Changing the following parameters in the Layout Settings area and clicking any of the Shuffle 
buttons will re-shuffle your layout with the new parameters in effect.

Gutters: Gutters are the 
distances between adjacent 
images.  You can specify Left-
Right (horizontal) gutter spac-
ing and Top-Bottom (vertical) 
spacing independently.  By 
default, images are spaced 
.25 inches apart, but you can 
change this value to reduce or 
increase their separation.  A 
gutter of 0 will butt images up 
against each other.

Page Origin:  This is the position on the page on which images will start.  By default, the 
origin point is set to the upper-left corner of the printable area. Change this value to have 
your layout begin further into the page if you want to produce a wider left/top margin.

Shuffle: A note on speed vs perfection 
 

ImagePrint’s shuffle feature is powerful and fast, but it’s not perfect. In mere seconds it will 
choose a paper-saving arrangement that’s close to the best possible.  But there’s a LOT of 

combinations to consider -- just 10 unique images on the page can result in hundreds of billions 
of possibilities when rotations are considered.   So, don’t be surprised if, sometimes, you may 

be able to find a slightly better paper-saving layout than ImagePrint does.
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Moving and Resizing Images  

Once you’ve opened an image, you’ll probably want to arrange it on 
the page and/or resize it.

Moving an image

	 •	 The simplest way to move a single image is to simply click with-
in the image’s bounding box and drag it to a new location.

	 •	 For exact spacing you can also type in a horizontal (X) and vertical (Y) position values 
for the selected image in the fields within the Size and Position Palette located at the 
top of the main window by default (if not visible, choose Size Position Controls from 
the View menu).

	 •	 Another way to specify exact 
horizontal and vertical positions 
for the selected image is via the 
Image Properties section of the 
Dashboard.

	 •	 To “nudge” an image a small amount at a time, use the Arrow 
keys on your keyboard.  Each press of the arrow key will move the 
image a pixel in the desired direction.  Hold down the arrow key to 
increase the rate of movement.

For more accurate positioning of images, and to align them to other images or page ele-
ments, see Aligning Images and Using Guides later in this chapter.

Click within an image    
and drag to reposition it

The Basics: Working with images (cont.)
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Resizing an image 

	 • 	 To proportionally resize an image, click on either side of the image (NOT the corner!)  
and drag. The image will be resized with its original aspect ratio intact.

	 • 	 To non-proportionally resize an image, click on the corner of its bounding box and 
drag.  

 	 •	 For exact proportional sizing you 
can also type in width and/or height 
position value for the selected image 
in the fields within the Size and Position Palette located 
at the top of the main window by default (if not visible, choose Size Position Controls 
from the View menu). Note the image will always scale proportionally using the value 
you type in and filling the remaining field with the correct value to maintain the original 
image aspect ratio.

	 •	 Yet another way to specify propor-
tional sizing for the selected image 
is via the Image Properties sec-
tion of the Dashboard. You can 
also use that section to specify the 
percentage scale rather than via 
size values.

To have the image fill the largest area of the page possible 
without distorting the image, click on the Fit Page icon in 
the floating tool palette.

To scale the image to whatever size is needed to obtain spe-
cific margins (auto-cropping the image if necessary), click 
the Fit to Margins icon in the floating tool palette.

To return the image to its original size after performing any 
sizing operation, click on the Original Size icon in the float-
ing tool palette.

But wait... there’s more!

There are even other ways to size and position images as they are 
opened, such as specifying Auto Layout Settings in the Advanced section of the Dashboard, 
or using ImagePrint Templates.  Those advanced topics will be covered later in this manual.

The Fit button is 
the quickest way 
to fit your image 
to the printable 
area of the page

The Basics: Working with images (cont.)
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The Basics: Working with images (cont.)

Deleting Images from the Layout area

The Scissors icons in the Tool Palette are used to remove unwanted 
images from the layout area. If the palette is not visible, choose Tools 
from the View menu at the top of the screen.

 The Black scissors deletes the currently selected image.

  The Red scissors delete every image on the page

Zooming in or out

Sometimes, you may need to 
adjust how much of the layout 
area is visible.

To get a closer look at objects 
within the layout area, click on the 
Zoom In magnifying glass icon 

 found on the ImagePrint Tool 
Palette. 

To view a larger portion of the lay-
out, click on the Zoom Out  mag-
nifying glass icon .  

  

The Tool Palette 
(Vertical Orientation)

Zooming In
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The Basics: Working with images  (cont.)

Other commonly used Layout tools

Rotating an image

To rotate the selected image in 90 degree increments, 
click on either the Rotate CW  or Rotate CCW  icons in the floating tool palette.

Mirroring (flipping) an image

To mirror the selected image right/left or up/down, click on either the Flip Horizontally  
 or Flip Vertically  icons in the floating tool palette.

Centering an image

To center an image on the page, select the image and click the Center Image  icon 
from the floating tool palette.  

Note on centering on sheet paper  
 

For printers that support it, the Center Margins checkbox, found in Dashboard-
>Margin Styles, determines if the image is centered on the printable area of the page, or if 
centering occurs based on the entire physical page (some printers have different top and 
bottom non-printable margins, which means an image centered within the printable area 
may not be centered on the physical page.  The Centered Margins feature corrects for 
that.)  For information on this feature see chapter 5.  To see if your printer supports this 

feature, see Appendix C, Printer specific options.

The Toolbar
(Horizontal Orientation)
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The Basics: Working with images  (cont.)

AutoFlow 

Automatically creating new pages

As pages are filled with images, newly opened will “flow” onto other pages.  The page with the 
next highest page number that has room for it will get the image. But, if no more pages exist, by 
default new ones will be created to accommodate the new images.  

You can turn OFF autoflow by selecting the option in the Advanced->Auto Layout Settings sec-
tion of the Dashboard.  With Autoflow off, new images will simply stack on top of other images if 
there is no room for them on the page.

Splitting images across pages

When you drag an image to the edge of a page’s 
printable area...

...it will automatically split onto the next 
page.  Images will also split if you grow 
them across pages.

You can move either side of the split image, and both sides will move together.  You can adjust 
the split area or remove the split by moving the image within a single page.
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The Basics: Working with images  (cont.)

Aligning images 

ImagePrint has several ways of aligning images:  

Align to other images via the alignment tool - This method lets you pick a “target” image, 
and align other selected images to it.

Align to other images or page elements via smart alignment - When you drag an image, 
“smart” alignment lines will appear when its center or edges are in line with the edges or center 
of other images or the edge or center of the page itself.

Custom guides - You can drag guidelines from the ruler areas of the page menu to create 
your own alignment elements.

Align to other images via the alignment tool

To align multiple images to one target image, first, select the desired 
target by clicking it.

Next, hold the CONTROL key down on your keyboard and click the 
images you wish to align to the target image.

Then, choose the alignment option from the Alignment tool in the 
Tool Palette.

You can choose 
to align the image’s 
edges or center in a 
vertical or horizontal 
direction.

All the CONTROL-Selected images will align to the 
target.

Click the 
target 
image...

...then 
control-
click the 
other 
images 
and 
choose 
your align-
ment 
option.
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Align to other images via Smart Alignment

ImagePrint’s Smart Alignment guides are a 
dynamic, quick way to line your images up 
with other images or to the page edges or 
center.

When you drag in image on the page, 
dashed red lines appear when the 
edges or center of the image lines up with 
the edges or center of another image on the 
page or of the page itself.

These lines are “snap” lines, meaning if you 
release the image while its center or edge is 
close to one of the pop-up alignment lines, 
the image will snap into alignment.

 

You can decide which, if any, elements of the page or other images act as snap lines 
via the ImagePrint Preferences window (you can get to preferences by choosing it 
from the View menu in Windows, or the ImagePrint menu on Macs).

Once in the Preferences window, choose Pages, then select the snap options you 
wish to use.  Any unchecked options won’t show red-dashed snap lines in the inter-
face. 

IMPORTANT:  ImagePrint’s Grid overlay, also available in the Pages section of 
Preferences, can not be used while Smart Alignment tools are active.  

The Basics: Working with images  (continued)

Aligning images (continued) 

Smart Alignment in action

As the central image is 
dragged, the red-lines 

appear to show when its 
close to an alignment option. 

Currently, the center of the 
image is close to both verti-
cal and center alignment to 
the page, and its left edge 
close to alignment to the 

right side of the other image. 
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Align using Custom Guides

Another alignment tool that ImagePrint offers is 
draggable guides.  These vertical or horizontal lines 
allow you to create your own snap-to lines any-
where on the page.

To create a vertical guide, click in the ruler to the left of 
the pages area and drag to the right into the page.

To create a horizontal guide, click in the ruler above the 
pages area and drag down into the page.

The guide will be created where you release the mouse, 
and will extend from one end of your layout to the other, 
spanning multiple pages if applicable.

You can adjust the position of the guide 
by clicking on it and dragging, or for more 
precise positioning, by entering the desired 
value in the Size and Position window (if you 
don’t see the Size and Position window just 
choose it from the View menu).

To remove a guide, select it and drag it back into the ruler area.

The Basics: Working with images  (continuted)

Aligning images (continued) 
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The Basics: Printing

Once you have picked your page size, selected roll or sheet media, confirmed your profile 
settings and laid out your images, you are just about ready to print. But first, let’s check some 
common printer options.

Tray, Auto cut, Inked Area

In the Dashboard, click the triangle next 
to MEDIA FEED. 

You’ve already been in this section to 
specify Roll or Sheet as the type of 
media loaded, but this section also has 
a few settings related to paper handling 
you should double-check.

Tray:  If using Sheet paper and your 
printer supports different paper load-
ing methods, this is where you specify 
where the sheet paper is loaded. 
Common options are ASF if the paper is loaded in the Automatic Sheet Feeder (tray) or 
Manual if loaded manually.

Autocut: Only if using Roll paper, choose Autocut if you want to have the printer auto-
matically cut the paper when done printing

Inked area: Also only for Roll paper, choose Inked Area if you want to have the printer 
stop outputting paper after the last image on the page is printed.  Without Inked Area 
selected, the full page size you selected will be unrolled regardless of the imaged area.

That’s the basics of setting up ImagePrint.  Now it’s time to make a print!
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The Basics: Printing (continued)

Making a print

At the top of the Dashboard, 
click the Print button to send 
the current layout to the 
printer. You can also choose 
Print from ImagePrint’s FILE 
menu.

You’ll get a confirmation 
dialog box allowing you to 
confirm a few things--like the 
page size and paper profile.  
Click OK in that box to send 
the job to the ImagePrint 
spooler, Spoolface.  

Spoolface monitors the job’s progress, report any errors and let you cancel or reprint jobs. 
To learn how to use Spoolface, please see the next section.

After clicking print, you’re free to exit ImagePrint. Printing takes place completely in the 
background.  Or, use the scissors (in the floating toolbar) to delete the current layout and 
create a new one.
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The Basics: Spoolface

Where did the print go?

When you clicked Print in the Dashboard, the job to be printed was sent to the ImagePrint 
Spooler for printing.  A spooler is a piece of software that manages print jobs.  A spooler 
allows you to create a “stack” of jobs to be printed, one after the other.  This list of jobs 
currently lined up for printing is called a “queue” (pronounced “Q”).  Spoolers also let you 
cancel jobs, reprint jobs, and keep track of any errors that may occur during printing.

ImagePrint’s Spooler is 
called SpoolFace.  You 
can launch it by choosing 
the printer icon at the top of 
the Dashboard (to the right 
of the Print button and Job 
Name field) for from the 
File menu at the top of the 
ImagePrint main window.

Note: It’s not necessary to launch SpoolFace when printing--jobs will print in the back-
ground without it running, but many users keep it running so they can keep tabs on their 

print queue.
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The Basics: Spoolface (continued)

SpoolFace has three main windows, plus a menu bar along the top (On PC’s, the menu 
bar is part of the SpoolFace window, but on Mac’s it’s up at the top of the screen so don’t 
miss it!)

PC Version Shown

As jobs finish 
printing, they 
move  
to the lower left 
pane.  This is  
the Done Queue.

The upper left sec-
tion of SpoolFace 
is the Active 
Queue.  This is 
where jobs  
will line up to print.  
The top job is  
either printing, or 
the next one in line  
to print.

The large area on the right is 
the Log Window.  A running log 
of any print jobs you’ve done 
appears here.  (The log will get 
truncated automatically, so no 
need to worry about deleting 
any data here).
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The Basics: Spoolface (continued)

When you want to 
completely delete a 
job from the Done 
Queue, just drag 
it to the Recycling 
bin.

The bottom left corner 
of the Spoolface win-
dow contains the Status 
Bar.

 
This area give you a 
quick status of the cur-
rent print job. 
It will also tell you if 
the Queue is currently 
Active or Paused. 

If you want to Cancel a job, just drag 
it from the top (Active) pane to the 
bottom (Done) one...

...and if you want 
to Reprint a job, 
just drag it from 
the bottom (Done) 
pane to the top 
(Active) one.
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The Basics: Spoolface (continued)

Solving printing problems

If an error occurs when printing (such as an 
ink cartridge becoming empty, a paper mis-
feed, or a connection problem) then the Status 
Bar may display a  numeric error.  Error num-
bers can be checked in the Troubleshooting 
guide--most represent common problems that 
can be quickly fixed.  

If the Status Bar shows the word Paused, that 
means the spooler has stopped sending jobs 
to the printer.  SpoolFace will stay paused until 
you tell it that the problem has been fixed and 
its safe to send new jobs. 

To start jobs going to the printer again, you’ll need to resume the spooler by choosing 
QUEUE from the SpoolFace menu.  The Pause Queue selection will have a check mark 
beside it. Choose Pause Queue to remove the check mark and resume printing.

Be careful!  Re-enabling the Queue will cause it to print all the jobs in the Active (top) sec-
tion of the Spoolface window.  Cancel any unwanted jobs that may have accumulated in 
the active section by highlighting them and dragging them to the bottom (Done) section. 

Hint: Spoolface has other functions such as showing job thumbnails and archiving your 
print jobs.  For more detailed information on Spoolface and printing with ImagePrint see 

the Printing chapter of this manual.
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The Basics: What Next?

If you’ve followed the instructions in this section, you should have a good, basic understand-
ing of the ImagePrint workflow.  You should know how to launch ImagePrint, pick a page size, 
layout images and print them.  You should also have a good understanding of the ImagePrint 
spooler, SpoolFace, and how to control jobs with it.

The rest of this manual is devoted to detailed explanations of the tools and functions you’ve 
learned so far, as well as descriptions of features that were not covered in this basic walk-
through, features like:

• Adding frames and backgrounds

• The Smart Crop Tool

• Boundaries

• Adding Text

• Gallery wrap

• Using Layout Schemes

• The Color Correction Tools

• Color management and using Color Profiles

• Templates (Also known as: Photo Packages)

• AutoPrint Hot Folder utility 
       (Available as a separate download)

• PTA (Print Through Applications)

You may wish to stop reading for now and begin using ImagePrint, coming back to this manual 
as a reference when you want to learn about a particular feature or tool.  Or, you may wish to 
skim through the rest of the manual to familiarize yourself with the full range of tools.

If you need to know more about a tool touched on in this chapter, use the Table of Contents 
or the Index (if available) to jump to that section.  Remember that clicking any Blue text will 
jump you to the pertinent section of the manual for that topic.
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Tools and Features 
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ImagePrint Tools and Features Reference
This section is a reference to most of the menus and interface items within ImagePrint.  It 
is not intended as a tutorial on the use of ImagePrint--for that, see the previous chapter, 

ImagePrint Basics.  To learn the basics of opening images, laying them out and printing it is 
recommended you start there.

You can read through this chapter to get to know the features, or jump to one of the areas 
below to learn about a specific one.   (Some of the information from the previous is reprinted 

here in the interest of completeness)

Overview: The basic ImagePrint Interface

1. The Page Layout Window - This 
window contains the representations 
of all the pages within your layout. 
This is where you will place the 
images you plan to print.

2. The Dashboard - This window 
is your “control center” for most 
ImagePrint functions.

3. The Floating Tool Palette - Icons 
for common tools like Zoom or 
Rotate, can be found in this tool bar.

4. The Image Strip - The Image Strip shows thumbnails of images within a selected folder for 
easy layout.

5. The Main Menu, Size and Position Controls and Shuffle Buttons -  Along the top of the 
ImagePrint window you’ll find the File, Edit, View and Help menus that provide access to some 
ImagePrint functions and advanced tools such as Templates and the Border Browser. Also, 
by default, the Size and Position Controls palette will appear here for easily sizing images. 
Plus you’ll find the three Shuffle buttons which let you instantly rearrange the placement of the 
images on the page to conserve paper or make for easier cutting.

The ImagePrint Main Window (not shown) -  This gray, featureless window is the “mother-
ship” containing all the windows you choose to dock.  All other Windows and Palettes can be 
free floating, or docked within the Main Window.  This allows you to keep some windows in a 
standard docked configuration that can be moved together, while others remain stand-alone 
and undocked.

Note: A context sensitive “mouse menu” containing many of the most frequently used com-
mands, including Rotate, Add Background and Add Text, is also available by right clicking (or 
control clicking) on images or an empty spot in the layout area for convenience.
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Starting ImagePrint

To start ImagePrint, double-click the ImagePrint icon located within the 
ImagePrint folder in the folder in which ImagePrint was installed.  

	 •	 On the PC version, the default location is: c:\program files (x86)\imageprint 
(A shortcut to ImagePrint is also created on your PC’s desktop at installation)

	 •	 On the Mac version, the default location is: /Applications/Imageprint 
(Drag the ImagePrint icon to your Dock for convenience)

The Page Layout Window

The Page Layout window is the largest 
window within the interface, and it is 
where you will create your layouts for 
printing.  It consists of pages--anywhere 
from one to hundreds-depending on 
how many you choose to create.

Each individual page represents a 
physical page (or a  defined segment of 
a roll if using roll paper).  

● The white area within the pink bound-
ary is the printable area.

● The gray, patterned border repre-
sents the part of the page on which the 
printer can not print (The non-printable 
area).  Any portion of an image on this 
area of the page will not print.

● If your printer is capable of borderless 
(full-bleed) printing, and you’ve chosen Borderless mode as the Margins Style, you’ll 
see a red line outside of the page area representing the “overprint” area that falls off 
the paper. By allowing a portion of an image to extend into the area bounded by this 
line, you might avoid “hairlines” along the edge of the paper due to misaligned paper 
when attempting to completely fill the page.
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Image Functions  

File formats	

In order to layout and print your images, they must first be opened into the ImagePrint inter-
face.  ImagePrint can open TIFF files, JPEG files, Acrobat PDF and Photoshop PSD files. 

(Note: PSD, PDF and TIFF files will be opened at their saved size, but JPEG files will be 
sized based on pixel dimensions at an assumed resolution of 300 pixels per inch.)

 
While most files of these formats are fine, sometimes layers in PSD or TIFF files may cause 
problems and require flattening of the image.  It is also recommended that you avoid most 
non-alphanumeric characters other than spaces, dashes and underlines.  (For example, 
apostrophes, ampersands, etc. in the name of the file, or in the name of the folder the file 
is in, can cause a file not to be opened).  For best results, make sure files are flattened, 
uncompressed, and have no additional channels to minimize potential problems.

Opening Images

The ImagePrint Image Strip is the most convenient way 
to open files.  Available from the View menu in the Main 
menu, it is described in detail in the previous chapter, 
ImagePrint Basics.	

Image files can also be opened  
via the standard File -> Open  

method from the ImagePrint  
Main menu.

You can also drag files from any folder right into the 
ImagePrint interface.  (And, though not officially supported, 
for most users, dragging from Adobe Bridge works as well!

Hint: Recently opened images will be listed under the File menu for easy opening
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Image Functions (continued) 

Opening PDF Files - The PDF Browser

When you open a PDF file via the Image 
Strip, File->Open command or by dragging 
from a folder, the ImagePrint PDF Browser 
window will appear.  

This window allows you to see all of the 
pages within a PDF file as thumbnails, 
view individual pages in high resolution, 
and select any number of pages for open-
ing into ImagePrint.  

Using the PDF Browser

Thumbnails of each page in the PDF document are shown 
in the scrollable area within the Browser. To increase or 
decrease the thumbnail size, use the magnifying glass icons 
at the top of the PDF Browser window.

Click on any thumbnail to select it (a check mark will appear 
on the thumbnail).  To select multiple pages, hold the control 
key (Windows) or the Command key (Mac) while clicking. To 
select a range of thumbnails, click the first in the range, then 
click the last in the range while holding the Shift key down.

Double-click or drag any of the select image(s) to open 
them within the Layout area of Imageprint (New pages will 
be generated as they are filled).

Drag a page thumbnail into the High Resolution section of the PDF Browser to see a high reso-
lution preview of that page.  You can then double-click the high resolution preview to open the 
page in ImagePrint.

If the PDF file has bookmarks, a bookmark palette will appear between the thumbnail pane 
and the high resolution pane.  Click any bookmark to jump to that page’s thumbnail. (You can 
enlarge or close the bookmark pane by clicking the vertical line along its edge and dragging).

You can also jump to a specific thumbnail by typing its page number in the Page field at the top 
of the browser and hitting the Return or Enter key.

Click the vertical line between any component section of the PDF Browser and drag left or right 
to resize that component or collapse it entirely.

Close the browser when done opening pages by clicking the X in the upper right of the window 
(Windows) or the close button in the upper left (Macintosh).

High Resolution 
Page Preview Page Thumbnail 

View

Bookmarks
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Image Functions (continued) 

The Page Origin

The location of the first image on a page is 
determined by the X/Y page origin. The origin 
point is shown as a blue colored pair of lines.  
The upper left corner of the first opened 
image will align with this marker. You can 
adjust the origin point by changing it numeri-
cally in the Automatic Layout Settings 
section of the Dashboard.

Filling the page

Subsequent images will be added to available clear space within the printable area, going from 
the highest to lowest, left to right.  If Auto Flow is in effect, an image that can’t fit on the page 
will be added to a new page, as shown in the page layout area. If Auto-Flow is not in effect, 
when an image can’t fit on the page, it will be placed at the origin point on top of previous imag-
es. (Use the scissors icons to delete unwanted images from the page).

Shuffle

Click any of the three Shuffle buttons to re-arrange the images in the layout to conserve 
paper and/or make them easier to cut apart.  Shuffle is described in detail in previous chapter, 
ImagePrint Basics.

Image Information

Move your mouse over an image to see its size and location on the page listed in the bottom 
left corner of the ImagePrint Main window. 
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The Dashboard

The Dashboard is where  
you’ll find all of the fea-
tures essential to making 
a print brought together in 
one place, organized into 
an easily accessible and 
logical menu structure.  The 
menu choices are laid out 
in a top to bottom format 
that takes you naturally 
through all the steps need-
ed to make a print, and the 
currently selected options 
are always visible at a 
glance. 

To access a menu in the Dashboard, click 
the small triangle item beside its name to 
expand that section.

The current setting for each 
Dashboard item is shown in 
blue to the right of the menu 
label.  This allows you to eas-
ily check your settings prior to 
sending a job to print.

The following few pages will describe the menus available within the Dashboard.
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The Dashboard (continued)

Print

The top of the Dashboard is where you’ll find the Print button.  Click this button 
to immediately send your job to the ImagePrint spooler, Spoolface, for printing.  
Printing is described in chapter 8, Printing.

Job Name

Next to the Print button is the Job Name field.  This field contains the name that the 
layout will be given when it appears in Spoolface.  By default, the job name will be 
the name of the first image added to the layout. Edit the field by clicking and typing 
a new name.

Spoolface

The small icon beside the Job Name field is the Spoolface launch button.  Click this 
button to launch Spoolface, the ImagePrint spooler.  This is where you can view the 
status of print jobs as well as cancel, delete or reprint them.  Spoolface is described 
in detail in chapter 8, Printing.

The Image Strip Folder

This section of the Dashboard 
allows you to choose the folder 
you wish the Image Strip to 
use.  Choose a folder using the 
displayed folder tree structure 
to populate the Image Strip with 
the jpeg, tiff, png, pdf or psd 
(Photoshop) files within it.  The 
Image Strip is described more 
fully later in this chapter.
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The Dashboard  (continued)

Printer

The Printer Section of the 
Dashboard is where you 
select the printer you will be 
using from your list of installed 
ImagePrint printers.  

This section is also where you pick the page size that is loaded on the printer as well as 
most media related settings such as roll vs sheet, or borderless/non-borderless printing 
mode.

The Printer menu on the left 
side of the Printer Section of 
the Dashboard shows the cur-
rently selected printer.  If you have 
installed more than one ImagePrint 
printer use this drop-down menu to 
choose the printer all current settings 
will apply to.  

Note that most settings, such as 
Profile Selection and Page Size, are 
remembered for each printer--switch-
ing to a different printer will cause 
the last used settings for that printer to be used. 

To the right of the Printer menu is the 
Page Size menu.  This drop-down menu 
gives access to a list of valid page 
sizes for the currently selected printer.  
Choose the size of the media loaded on 
the printer or choose User Defined to 
create a custom page size.  

Defining a Custom Page Size

For most printers, user defined page sizes are available.  To define a user defined page 
size, choose User Defined from the page size menu in the Printer Setup Area (or, if User 
Defined is not available, choose the currently defined custom page size).  

The Custom Page Size window will appear.
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The Dashboard - The Printer Section (continued)

Defining a Custom Page Size 

To specify a new custom page size:

Type the desired name of the new page 
size in the Name field of the Custom 
Page Size window. 

Define the page width and height in their 
respective fields by typing them in or 
using the up/down arrows. 

Click Save to have new page size added 
to the list of user defined pages on the 
left side of the Custom Page Size win-
dow.

To delete a custom page size, high-
light its name in the Page Size list 
and click the Delete button.  

To make a custom page size your 
active page, highlight its name in 
the Page Size list and click the OK 
button.  The Printer Setup window 
will show the page size, and the 
currently selected custom page size 
will become the active page.

To make a new Custom Page size, 
simply re-select the current custom 
page size from the Page Size menu.  
The Custom Page Size window will 
re-appear.
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The Dashboard - Printer Section (continued)

In addition to the Printer 
Selector and the Page Size 
menu, there are several other 
media related settings within 
the Printer Section of the 
Dashboard

Sheet/Roll  
Select the correct setting for the type of media you are using in the printer (roll or 
sheet).  Choosing an incorrect setting here may result in “Load Roll Paper” or “Load 
Sheet Paper” errors on the printer.

Tray  
If using Sheet paper and your printer supports different paper loading methods, this is 
where you specify where the sheet paper is loaded. Common options are ASF if the 
paper is loaded in the Automatic Sheet Feeder (tray) or Manual if loaded manually.

Autocut 
Only if using Roll paper, choose Autocut if you want to have the printer automatically cut 
the paper when done printing

Inked area 
Also only for Roll paper, choose Inked Area if you want to have the printer stop output-
ting paper after the last image on the page is printed.  Without Inked Area selected, the 
full page size you selected will be unrolled regardless of the imaged area.

Borderless
Edge-to-edge full bleed printing is available for some paper widths on most printers.  
Select borderless to activate this full bleed mode.  Note that the ImagePrint layout area 
will change to reflect the expanded printable area.  Each printer model has a limited 
number of supported borderless widths--consult your Print documentation for details on 
which widths your printer supports.  Also, be aware that many printers do NOT support 
top/bottom borderless on sheet media--those printers will only print edge-to-edge and 
typically have a 1/8th to 5/8th inch border on the top/bottom.

Center margins 
(Sheet media only) Many printers have differ-
ing top and bottom margins when printing on 
sheet paper due to the need for the paper feed 
mechanism to grab the paper--choosing Centered 
Margins will cause ImagePrint to increase the 
smaller margin to match the larger one, reducing 
your total vertical print area but causing images to 
appear centered when printed. 

Centered
Margins

Normal
Margins
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The Dashboard (continued)

Printer Profile  

The Printer Profile section of the Dashboard is where the output profile for your 
paper is selected.  Three methods are available for choosing the printer profile:

Profile Valet  Choose using the paper name 
and automatically downloads profiles that are 
not available

Choose by profile  
Choose using the file-
name of the profile.  
Unavailable profiles 
must be manually down-
loaded using the Profile 
Manager utility.

Favorites  Select your 
profile from a list of previously saved favor-
ites

Selecting profiles is fully described in Chapter 
6 of this manual: Color Management.

Layout Settings

Layout Styles and Auto Layout Settings control the various methods ImagePrint has 
of automatically sizing and positioning images as they are opened.  For detailed 
information please consult Chapter 8 Layout Styles and Automatic Layout 
Settings.
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The Dashboard - Image Properties (continued) 

Image Properties 

The next part of the ImagePrint Dashboard is the 
Image Properties section.  

Here you will find controls relating to the currently 
selected image in one convenient place.  You can 
resize and position the image or step/repeat it, apply 
custom color management settings as well as adjust 
the transparency and shadow point.

The tools and controls in this section are fully 
described in Chapter 10 - Image Properties.
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Advanced Dashboard 
Settings 

The Advanced section of 
the Dashboard contains set-
tings and tools that change 
infrequently, aren’t needed 
for basic everyday print-
ing or are used for specific 
workflows such as those 
requiring crop marks or 
automatic image sizing. 
Following are descriptions 
of the settings found within 
the Advanced section of the 
ImagePrint Dashboard.

Print Setup

Settings that don’t affect the ImagePrint 
layout, but do affect the output, are 
found in this important section.  For 
detailed descriptions of each option, 
consult chapter 15 of the manual: 
Printing and Print Setup

The Dashboard (continued) 



5-15 ImagePrint User’s Guide

The Dashboard: Advanced (cont) 

Crop Marks

The Crop Marks section of the 
Advanced Dashboard gives access 
to the Crop Marks controls.

Here, you can specify settings 
for crop and cut marks which will 
appear on your prints.  

Crop marks will be printed as vertical lines, with Cut marks appearing as hori-
zontal lines at each corner of every image on the page when crop marks is 
on.    

Important note on Crop marks with Templates and Step/Repeated 
images 

 
Crop Marks will appear at the edges of an entire template or group of step/repeated images as 

a whole--not around each individual image.  
 

If you want crop marks to appear for each image in a template you can ungroup the template 
by right (or control) clicking it and choosing “Ungroup” in the menu that appears.  

 
For step and repeated images there is no way to have crop marks appear for each image. If 
you need crop marks for each image, you can copy/paste the image to duplicate it, or open it 

multiple times, instead.

Cut Line
Crop Line
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The Dashboard: Advanced  (continued)

Print Crop Marks  Click 
this checkbox to turn on 
Crop/Cut Mark printing.
 
You can specify crop set-
tings on the left side of the 
window, or just use the 
pre-defined styles avail-
able on the right.  Here’s 
descriptions of the crop 
mark cuts available in the 
Crop Marks preferences 
window:

Thickness  Represents the thickness of the crop and cut lines in the specified measurement 
units.

Length  Specifies the length of the crop and cut marks in the specified units.

Cut  Designates the distance the two lines will be moved in relation to each other.  The verti-
cal crop mark will be moved in a vertical direction, the horizontal cut mark will be moved in 
a horizontal direction.  (Positive values will move the marks inward in relation to the image, 
negative values will move the marks out from the image). 

A 0 value for cut will butt the origin points of the lines.  

A cut value that is equal to half the Length value will result in a cross shape.  

A cut value equal to the Length value will result in the tops of the lines butting (not 
shown).

Distance  Designates the distance the crop marks will be from the corner of the image.  
Click the Symmetrical button to have the crop marks appear an equal distance from each 
corner of the image.  Without Symmetrical selected, you can specify different values for the 
top and bottom and left/right distances.
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Dashboard: Advanced  (continued)

Predefined Crop 
Styles  

You can now 
choose between 
the 3 most common 
crop mark styles by 
clicking one of the 
predefined buttons 
on the right side of 
the crop mark window.

Below are the available predefined crops:

“L” Style			          “Inverted L” Style	         Cross shaped
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Dashboard: Advanced (continued)

Defining your own crop style

If you need custom crop styles not available in the pre-defined styles, you can make your own 
using the controls in the crop window.  Here’s some examples (assuming symmetrical distanc-
es):

Note: Since the distance and cut values affect the position of both the Crop and 
Cut lines equally, some crop types (like a capital T shape) are impossible to 

achieve.

Distance 0.0
Length .25
Cut 0    

Distance 0.0
Length .25
Cut .123   (Half the Length)
The lines moved vertically and 
horizontally inward .123	

Distance 0.0
Length .25
Cut .25    (Equal to Length) 
The lines moved vertically 
and horizontally inward .25

Distance 0.0
Length .25
Cut .3

Distance .3
Length .25

Cut .123
Distance value pushes line 

intersection away from image.

Distance .3
Length .25

Cut .25

Distance 0.0
Length .25

Cut  - .1
Negative cut means lines moved ver-

tically and horizontally outward .1.
For non-intersecting lines, distance 

refers to where lines would meet
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Dashboard: Advanced (continued)

Annotations (also known as Captions)

The Annotation section of the Advanced Dashboard area provides controls for adding text 
annotations (captions) to your images.  The filename (with or without extension), date and 
time can be automatically printed beneath each image.  

Print Annotation  The Print Annotation checkbox turns annotation printing on or off.  Select 
this checkbox to enable the printing of annotations according to the other settings within the 
Annotation settings area.  

You can also toggle annotations via the icon in the Page Control area in the bottom right 
portion of the ImagePrint Main Window.

File Name 	 This setting will cause the File Name to be printed below each image 
when annotations are enabled.  If the filenames have 3 letter extensions 
(for example .tif, .jpg, .eps), then choosing the “and Extension” checkbox 
will cause it to be included in the annotation, otherwise the extension will 
be left off.

Date 	 This setting will cause the current date to be part of the annotation.  If the 
“and Time” checkbox is selected, the current time will be added as well.

Font Size 	 The Font Size drop down menu allows you to choose the size of the 
annotation.  You can choose between Large, Medium and Small.

Note: Normally, annotations will appear beneath each image on the page.  
To have annotations appear beneath a group of images, create an Image 

Boundary around them or place them in a template.  For information on using 
Image Boundaries, see the Boundaries chapter later in this manual.
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Dashboard: Advanced (continued)

The Context Sensitive Mouse Menu 

Many operations can be performed on an 
image or the entire layout quickly via the 
ImagePrint Mouse menu.  

Activating the Mouse Menu depends on your 
Operating System.

    •     Macintosh: To access the Mouse menu 
on a Mac if you don’t have a right mouse 
button, hold the Control Key down while 
clicking on the image.

	

	 • 	 PC: To access the Mouse menu on a PC, 
right-click the image.

Note that the contents of the Mouse Menu depends on what you are clicking--

•	 Clicking an image will show functions that apply to images such as Rotate or 
Add Background.  

•	 Click on a blank area of the layout window and image specific functions won’t 
be available, but non-image specific features like Add Text will be.  

•	 Clicking on a group of images, or a template, and template specific options--
like Ungroup, will be shown.

Below are descriptions of the various Mouse Menu options.

For convenience, most of the tools available in the Mouse Menu can also be found in the 
Main Menu and/or Tool bar. 

Copy/Paste

Copy will copy the clicked on image to the clipboard for later past-
ing.  If you click on an empty area of the layout window instead 
of an image, and have already copied an image to the clipboard, 
Paste will be available in the Mouse Menu for pasting the previ-
ously copied image.
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Rotate

Choosing Rotate will let you choose to rotate the image clockwise, or 
counterclockwise, 90 degrees.

Add Background to the image 

Choose this option to open the Backgrounds and Frames window.  
This window allows you to apply colored backgrounds, image back-
grounds, frames and mattes, and gallery wraps to your image. If you 
have already applied a background or frame to the image, this menu 
item will show “Edit Background”.  For more information on these 
functions, see the Backgrounds, Frames and Gallery Wrap chapter 
later in this manual.

Add Boundary

Choosing Add Boundary will allow you to create an Image Boundary 
around an image or group of images.  Think of boundaries as sub-
pages that can contain images and text.  Each of these sub-pages can 
have its own crop marks and annotations, making for easy genera-
tion of album pages or any output that requires multiple items treated 
as one page.  Boundaries are also a convenient way of grouping 
images for moving them together, and they can even be used as a 
colored background for a set of images.  For more information on this powerful function, see the 
Boundaries chapter later in this document.

Fill Non-proportionally  

The Fill selection will cause the  selected image to expand to fill the cur-
rent page.  Note that this option will not preserve the aspect ratio of the 
selected image, and image distortion will usually occur.

Fit Proportionally

The Fit selection will cause the  selected image to expand to fit as 
large as possible within the current page without distorting the image.  
The aspect ratio of the image is preserved as the image is resized.

The Mouse Menu (continued)  
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The Mouse Menu (continued)  

Mirror

Choosing Mirror will let you flip (mirror) the selected image 
horizontally or vertically.

Center	

This option will center the currently selected image within the print-
able area of the page.

Correct 

Choosing Correct will give access to the various 
Correction tools ImagePrint offers.  Please see the chap-
ter in this manual on Correction tools.
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The Mouse Menu (continued)  

Add Text / Edit Text

By right clicking (PC) or control-clicking (Mac) anywhere on the layout area and choosing Add 
Text, you will be presented with the Add Text window. (Once you have Added text, right clicking 
or Control Clicking the text will give you the option to Edit the text.)

You can also select the  text icon from the Floating Tool Palette then click anywhere in the 
layout area to place text.

Once created, text is treated like an image--you can move it around on the page, group it with 
other images, delete it with the scissors tools.  You can also edit the text by right clicking/control 
clicking it, and choosing Edit Text from the Mouse Menu.

The Add Text Window

With the Add Text window, you can add text using any 
font available on your system.  The font can be colored 
and styled, and you can even add drop shadows.  

Adding the text

Add text by typing it into the text entry section at the top of the Add Text window.  You’ll see the 
text added to the layout window at the location you last clicked with your mouse.

Choosing the Font

Choose the desired font by clicking Font... at the top of the Add Text window.  The Select 
Font window will appear.  There you can choose the font, the style and the size of your text.  
When you click OK in the Select Font window, you’ll see the changes applied to the text within 
the window as well as the text in the Layout window.

Type text here

Cross Platform (Mac/Windows) Font issues

If you are printing from a Mac client computer to a Windows host, or from a Windows host 
to a Mac client, the fonts chosen on the Client computer may not match those printed by 

the host.  To limit font compatibility issues when printing cross platform, use TTF (True Type 
Fonts) whenever possible.
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The Mouse Menu (continued)  
Add Text / Edit Text    (continued)

Advanced Text Options

Click the Advanced button at the top 
of the Add Text window to access 
controls for changing the text color, 
transparency, background color, and 
alignment.  You can also add a drop 
shadow and specify its color and dis-
tance.  

Click the color menu in the Text area 
to access a color chooser for the text.

The Transparency slider allows you 
to adjust the opacity of the text--move 
this slider to the right to make objects 
under the text appear through it. 

The Alignment controls allows you to 
specify how the text should be justi-
fied: Left, Center, Both, or Right.

Click the color menu in the 
Background area to access a color 
chooser for the text background (the 
text background is a rectangular 
area behind the text filled with color).  
Choose Transparent in this menu if 
you want no background to appear.

Click the Drop Shadow checkbox 
to enable a drop shadow on your 
text.  You can pick the color via the 
color menu below the Drop Shadow 
checkbox.  You can also specify the 
angle of the drop shadow, and the 
distance it will appear in that direction 
from your text.

Type text here

Hint:  Copyright © and other symbols

Some symbols not on the keyboard must be 
created with a combination of keys. For exam-

ple, © is Option-G on Mac, and Alt-0169 on 
Windows.  Use system utilities like “Charmap” 

(Windows) or “Keyboard Viewer” (Macintosh) to 
locate the key combinations needed.
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The Mouse Menu (continued)  
Applying your text

Once you are satisfied with the text you have created, click the green check mark in the upper 
right corner of the Text window to apply the text.  To close the Add Text window without making 
changes, click the X button.

Once the text has been added, it can be repositioned by clicking and dragging, just like any 
image on the page.

Editing your text

To edit the contents of the text, or change its size, color or other parameters, right-click or con-
trol-click the text, then choose Edit Text in the Mouse Menu that appears.  The Edit Text win-
dow will appear, allowing you to make changes using the same controls you used when adding 
the text.

Forever

Hint:  Cropped final letter

For some decorative fonts, such as 
cursive script, you may need to add 

a space to the end of the last letter to 
ensure that character is not truncated
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Working with Images - Advanced 

Stepping/Repeating an image

ImagePrint offers a unique and powerful method of interac-
tively adjusting the step (horizontal copies) and repeat (ver-
tical copies) on images within your layout by just dragging 
the image with your mouse. (You can also repeat images 
by using the Step and Repeat fields located in Image 
Properties in the Dashboard.)

Increase/Decrease the number of images:  To change the number of images being 
stepped and repeated, press and hold the SHIFT key on your keyboard, then, with the 
mouse, click the sides or corner of the image.  

• Drag the cursor horizontally to increase/decrease images in the horizontal direction.  

• Drag the cursor vertically to increase/decrease images in the vertical direction.  

• Drag the cursor diagonally to increase/decrease the images in both directions.  

Increase/Decrease the distance between images:  To change the distance 
between the images in a step and repeat pattern, press and hold the SHIFT key on your 
keyboard, then use the mouse to click within the image.

• Click and drag the side along the Y axis to increase /decrease space horizontally

• Click and drag the side along the X axis to increase/decrease space vertically 

• Click and drag a corner to increase/decrease space in both directions 

Don’t forget, you can also step and repeat images numerically for more precise 
control with the Step and Repeat fields.  See Chapter 10, Image Properties, 

for details.

Hold SHIFT while drag-
ging the corner or edge of an 

image to duplicate it
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Working with Images - Advanced (continued)  

Cropping images with Smart Crop

ImagePrint’s Smart Crop feature 
allows much more precise crop-
ping of images than in previous 
versions.  

To activate Smart Crop, double-
click an image that you have 
added to the ImagePrint layout.  

A separate window will appear, 
containing a preview of the 
image.  It is within this window 
that you will adjust the crop-
-any changes made here will 
immediately be reflected in the 
image within the layout window.

The Crop Palette will also 
appear beside the Crop window.  
This palette will let you choose 
from preset crop sizes, or create 
your own.

Cropping with preset sizes

The easiest way to crop an image is to choose a preset photo 
size.

Click the Photo Sizes menu within the Crop Palette to choose 
from a list of common photo sizes.  

Pick a photo size to immediately have the selection marquee 
within the crop menu change to the new dimensions.  The image 
in the layout area will also change to the exact size specified.

Mac Version Shown
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Working with Images - Advanced (continued)  
Cropping images with Smart Crop (cont.) 	

Cropping with custom sizes

You can also type in custom Width and Height values for the 
crop in the Crop Palette.  Hit the return key after typing in each 
value to see your image immediately cropped to your new 
size. To remove the crop settings and return the image to it’s 
uncropped state, click Remove Crop.

Changing the crop aspect ratio

To change the shape of a crop, type the desired values in 
the width height field.

Resize or move the crop by clicking and dragging

You can also click and drag control points of the crop mar-
quee to change the crop size interactively.  Control points 
are the small circles on the corners or mid-line points of the 
dashed line marquee.

Drag a control point to adjust the crop while maintain-
ing the image’s aspect ratio as shown in the width/height 
fields. 

By shrinking the cropped area, you effectively are zoom-
ing in on your image.

Moving the Crop Location

You can adjust the crop location by clicking in the middle 
of the Smart Crop window and dragging the cropped 
area.  

Finishing up

When done cropping the image, close the Crop Palette 
by clicking the X in the upper corner. (Images that have 
been cropped will show a small cropping tool icon in their 
upper right corner).

To adjust an already cropped image, just double-click it 
again to re-access the Crop Palette.
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The Tool Palette

The ImagePrint Floating Tool Palette is a vertical or horizontal, dockable bar of buttons 
that gives easy access to many of the more frequently used commands within the soft-
ware.  Following are descriptions of each of the tools available within the ImagePrint Tool 
Bar:

 
Zoom In  Click the Zoom In icon to zoom in on  the layout 
area. 
 
 

 
Zoom Out  Click the Zoom In icon to zoom out, expanding 
your current view of the layout area.

Rotate CCW  This button will cause the currently selected 
image to rotate ninety-degrees counter-clockwise.  You can also 
rotate the image by right-clicking it and choosing CCW from the 
pop-up menu that appears. 

Rotate CCW  This button will cause the currently selected 
image to rotate ninety-degrees counter-clockwise.  You can also 
rotate the image by right-clicking it and choosing CCW from the 
pop-up menu that appears.

Mirror Vertically  This button will cause the currently selected 
image to be mirrored vertically across the horizontal axis.  

Mirror Horizontally  This button will cause the currently 
selected image to be mirrored horizontally across the vertical 
axis.  
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Fit to Margins The Fit to Margins 
button is a brand new method of siz-
ing images according to the desired 
page margins in the final print. Click 
this button, and a pop-up window will 
appear that allows you to specify the 
horizontal and vertical margins you want to have. Click OK, and 
ImagePrint does the rest--sizing (and cropping if necessary) the 
image to perfectly fit the page without distortion while maintaining 
the specified margins. 

Fit to Page (Also available from Mouse Menu) The Fit Image 
button will cause the  selected image to expand to fit as large as 
possible within the current page without distorting the image.  The 
aspect ratio of the image is preserved as the image is resized.

Center Image Clicking the Center button will center the currently 
selected image within the page.  

Original Size Clicking the Original size button will return the cur-
rently selected image to its original size, discarding any resizing 
operations previously performed.

Delete Selected Image The Delete Selected Image button will 
remove the currently selected image from the ImagePrint layout.

Delete All Images on All Pages  The Delete All Images on All 
Pages button will delete every image on every page in your layout.

Text Click this icon, then click anywhere in the layout area, to add 
decorative text (See Adding Text in the Mouse Menu section ear-
lier in this chapter)

Alignment This special button lets you align any number of imag-
es to one “master” image.  More information on how to use this 
tool is in the previous chapter, ImagePrint Basics.

The Floating Tool Palette (continued)
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The Main Menu

The ImagePrint Main Menu offers access to most features of the program.  

The following pages will step through the available within the ImagePrint Main 
Menu.  

The File Menu

The File Drop-Down Menu contains the commands 
necessary to open image files, send your layout to 
print , and to quit the current session of ImagePrint.  
The four most recently opened images will also be 
listed under this menu for convenience.

Following is a description of each command found in 
the File drop-down menu.

Open  

The Open command allows you to open 
TIFF, PDF, JPEG and PhotoShop PSD 
files.  Clicking on the Open Button brings 
up the standard file selection dialog, from 
which your files can be chosen.  

Remember, you can also open images by dragging them directly 
into the layout window, or by using the Image Strip.
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The Main Menu (continued)

Rebuild  

The Rebuild command allows you to  rebuild a 
previous layout from the ImagePrint Spooler.  

Choosing Rebuild will cause the Rebuild Window 
to appear.

Rebuilding Jobs

The Rebuild window shows 
all the jobs on right side of the 
SpoolFace window for your 
chosen printer.  

Highlight any job by clicking 
on it, and the layout that job 
contained will be “rebuilt” 
into the ImagePrint layout 
window. Each image in the 
original job will be opened, 
with all its sizing, color man-
agement and other settings 
intact.

Note that rebuild a layout 
can take a significant amount 
of time, depending on how 
many images were in the lay-
out and their size.  

Important:  All files that were in the layout being rebuilt MUST be in the 
same location on your computer that they were in when the layout was 

originally made, or they will not appear in the rebuilt layout!
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The Main Menu (continued)

Save Layout Scheme  

This menu item will cause the Layout Scheme 
Save Dialog window to appear, for saving Layout 
Schemes created in the Automatic Layout Settings 
section of the Dashboard->Advanced.  For more 
on using and saving Layout Schemes, see chapter 
8 of this manual.  

Save / Load Color Correction Data  

The Save and Load Color Correction Data selec-
tions allow you to both save and recall settings 
from the Correction Tools.  For information on 
using the Correction tools, see chapter 9, Color 
Correction.

Print  

The Print command is used to the send the cur-
rent layout to the ImagePrint Spooler for print-
ing.  When the Print button is pressed, the Print 
Dialog Box will appear, allowing you to select 
your desired Print settings.  For more detailed 
information on printing, see chapter 15, Printing.
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The Main Menu (continued)

Exit  

Windows version only

The Exit command will exit the ImagePrint appli-
cation on the Windows version. 

Quit  Mac version only

In keeping with the standard Macintosh 
interface guidelines, the Mac version uses 

a Quit command, located under the 
ImagePrint menu.

Mac Version

PC Version
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The Main Menu (continued)

The Edit Menu 

The Edit Drop-Down Menu gives access to 
the Copy/Paste commands, as well as the 
Combined Corrections controls, Template 
creation controls and the Background, Frame 
and Gallery Wrap controls.   Note that many of 
the commands available in this menu are also 
available in the context sensitive Mouse Menu, 
accessible by right- or control- clicking within 
the layout area or image.

Copy  / Paste  

These standard commands allow you to copy the currently selected image to computer 
memory and then Paste the image onto a page.  Copying and Pasting images is the 
quickest way to create stand-alone duplicates of an image.

Corrections  

Choosing Corrections will give access to the various Correction tools ImagePrint offers.  
Please see the chapter in this manual on Correction Tools.

Templates  

This command will cause the Templates design window to appear.   
Using the tools within this window will allow you to create templates 
(or packages) for your images.  For more information on creating and 
using templates, please see chapter 12, Templates.
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The Main Menu (continued)
The Edit Menu (cont.)

Add Background, Frames and Gallery Wrap  

The Add menu entry has two options: 

Add Background, which gives access to 
the Background, Frame, Image and Gallery 
Wrap commands which allow you to put 
decorative borders and mattes around 
your images, or extend them with a gal-
lery wrap for frameless mounting.  If you 

have already applied a background or frame to the image, this menu item will show 
“Edit Background”.  For more information on these functions, see the Backgrounds, 
Frames and Gallery Wrap chapter later in this manual.

Add Boundary, which gives access to the power Add Boundary command. 
Boundaries can be used to designate separate sections of the page--think of 
boundaries as sub-pages that can contain images and text.  Each of these sub-
pages can have its own crop marks and annotations, making for easy generation 
of album pages or any output that requires multiple items treated as one page.  
Boundaries are also a convenient way of grouping images for moving them togeth-
er, and they can even be used as a colored background for a set of images.  For 
more information on this powerful function, see the  Boundaries  chapter later in 
this document. 
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The Main Menu (continued)

The View Menu 

The View Drop-Down Menu allows you to switch 
between normal page layout and spreads, and to deter-
mine which windows are visible within the interface, 
and if they are dockable.  You can also reset the win-
dow positions from the View menu, and, on Windows 
computers, this is where the Preferences window is 
accessed (On Macs, Preferences is found under the 
ImagePrint menu.)

Zoom  

The Zoom selection allows you to choose to zoom in, or 
out, of the layout area just as if you selected the magni-
fying glass icons from the tool palette.

Page Layout  

Choosing Page Layout will let you switch between the default page layout mode, and spread 
mode (also known as Book Mode).  More information on Page Layout Modes can be found in 
Page Layout: Spreads in the ImagePrint Basics Chapter of the Manual.

Tools, Size Position Controls, Pages, Image Strip, Borders Browser, Dashboard  

Each of these windows can be displayed or hidden by choosing the appropriate option here. 
You can also choose to make any of the listed windows dockable (meaning they will snap into 
the Main ImagePrint window when dragged near one of its internal edges.

Reset Window Positions

This useful command will reset all windows to their original, default positions.  Tools, Size 
Position Controls, Pages, the Image Strip and the Dashboard will all dock into the main window.

Preferences  

The Preferences option appears in different locations within the ImagePrint Menu structure for 
Macintosh and Windows users.  The View menu is the location on the Windows version, while on 
the Macintosh version Preferences appears in the ImagePrint menu.

The Preferences Window has controls for various options including default Profiles and Snap-to 
alignment settings. For more on Preferences, see chapter 7: Preferences. 
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The Main Menu (continued)

The Help Menu

The last menu to mention in the 
ImagePrint Main Menu is the 
Help menu.

Check for updates...

Choosing this option will cause 
ImagePrint to check online to 
see if new updates to the software are available. If a new release is found, choose 
“Download and Run Installer” in the Checking for Updates window to download 
the new version and have it automatically installed.  After the update downloads, 
ImagePrint will quit, then the update will automatically install (you may be asked for 
your computer password as part of the process).  

The process will take a few minutes to complete, but afterwards you’ll be running 
the very latest revision of ImagePrint.

Tip: Sometimes updating the software--even if you’re already on the 
current version--can be a quick fix for common problems, especially 

those that arise from an operating system update.

Troubleshooting

The comprehensive Troubleshooting guide can be accessed from the Help menu 
as well--most common problems can be solved by consulting this guide.

Manual

Here you’ll get access to the ImagePrint Users Manual you are reading now.



Profiles and Color 
Management

6
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Profiles and Color Management

ImagePrint is a Color Managed application.  This means that it utilizes ICC (or ICM) color 
profiles throughout its workflow.  These profiles are used to characterize the color space of 
the images being printed, the monitor displaying those images, and the output device print-
ing them. 

This section gives detailed descriptions on ColorByte’s use of profiles as well as touching 
on the topic of Color Management itself.  Although choosing the correct settings is usually 
a simple process--especially with the Profile Valet - becoming familiar with these concepts 
and procedures is the best way to avoid unexpected color problems.  

The first part of this chapter, Choosing Profiles, jumps right to the specifics of specifying the 
Color Management settings within ImagePrint.  If you just want to choose the right profile for 
your printer and images, this first section is all you’ll need to read.

The rest of this chapter is devoted to explaining other Color Management related features 
ImagePrint offers such as Colorized printing, ImagePrint’s special Grayscale output, profile 
naming conventions used by the software, and the Profile Manager utility.  

Choosing Profiles and Color Management settings

Types of Profiles

Soft Proofing

The Profile Valet

ImagePrint’s Grayscale Profiles

Colorized (Mixed color and B/W) Output

The Shadow Point Slider

Turning off ImagePrint’s Color Management

In addition to the information in this chapter you’ll find other color related 
information in Chapter 9, Color Correction Tools. 
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Choosing Profiles

Using the correct profile settings for your paper/printer and images is a vital component 
of any color managed workflow.

With the Profile Valet, profile selection is an intuitive, streamlined process that in most 
cases just requires the selection of a Printer (Paper) profile that’s correct for the media 
you plan to use.  In most cases all other settings can be left at their default. 

The Printer (Paper) Profile

Where to set it?

Printer Profiles are cho-
sen within the ImagePrint 
Dashboard. 

In the Dashboard, click the 
triangle beside PRINTER 
PROFILE to expand that sec-
tion. 

Within the PRINTER 
PROFILE sec-
tion, ImagePrint 10 
offers two methods 
of selecting your 
Printer Profile--the 
Profile Valet, or 
Choose by Profile.
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Method 1: The Profile Valet 

(Recommended)
If you have an internet connection the 
new Profile Valet is the recommend-
ed way to pick the right profile for 
your printer and paper.  (If you don’t 
have an internet connection on your 
ImagePrint computer or are using an 
Epson Stylus 2200, 4000, 7600, 9600 
or older printer, the Profile Valet is 
not available--you’ll need to use the 
Choose by Profile method described 
on the next page).  

Make sure Profile Valet is selected 
at the top of the PRINTER PROFILE 
section of the Dashboard. Then choose the options that apply to the paper you wish to use.  As 
you make your selections the Valet will narrow down its list of available profiles.

Ink: 	 Specifies which Black ink should be used.  Matte papers use Matte Black ink.  
Photo (any paper with a sheen) typically use Photo black ink.  Phatte black is 
a special mode ImagePrint offers for some printers that allows both Photo and 
Matte black to be used on printers that normally on support one black at a time.

Color: 	Specify if you plan to print using a Color printer profile or one of Image Print’s 
special grayscale profiles (for optimal B&W printing) if available for your printer. 
(Note: Some printers, such as the Canon 1000, can not use ImagePrint’s “grey” 
profiles. To print grayscale images for those printers  you will need to convert 
your images to neutral RGB or grayscale, and use a standard (color) profile. The 
“wide gamut” tint picker can be used to tint the output in such cases.)

DCM:	 Dynamic Contrast Matching  profiles have enhanced contrast based on the char-
acteristics of the paper.  All profiles for newer printers contain this technology 
(so the option won’t be selectable) but older printers may have both DCM and 
legacy non-DCM profiles available.

Brand:	Choose the maker of your paper

Paper:	Choose the actual name of the paper you plan to use

Choosing Profiles (cont)
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Quality: The quality mode designates the ink droplet size that will be used.  Each profile 
is made for a specific quality mode.

Display Lighting: ColorByte generates multiple Color profiles optimized for the viewing 
conditions of the print’s display environment (for instance, a DAYLIGHT optimized 
print will look its best near a window or outside).  

Once you have selected all the options, the Profile Valet will choose the profile from its list of 
available profiles on ColorByte’s online profile repository. But...you still need to apply it!

Applying the Profile with the Profile Valet

- If you already have the profile on your 
computer, you’ll see a small house icon 

 beside the profile name.  Click the 
Apply button to apply the profile.

- If the profile is NOT already on your 
computer, the button at the bottom of 
the Profile Valet will read Download 
and Apply.  Click this button to have 
ImagePrint acquire the profile from the 
online library and apply it automatically.

That’s it!  The profile for your paper is in 
place!

Add to Favorites: If the currently chosen profile is one you plan to use often, you can add it to a 
list of favorite profiles with the Add to Favorites button. Profile Favorites are described a bit later 
in this chapter.

Disabling the Profile Valet’s Internet Access 
If you don’t have an internet connection, or simply don’t want the Profile Valet accessing it, you 
can choose to disable its internet checking feature.  Choose Preferences from the ImagePrint 

menu (Mac) or View menu (Windows) and, in the General Section, select “Set Profile Valet 
Offline”

Choosing Profiles (cont)
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Method 2: Choose from already downloaded profiles

If you don’t have an internet connection or are using a printer that isn’t compatible with 
the Profile Valet, you’ll need to pick profiles by the actual profile name rather than the 
paper name.  Because the filename of the profile uses will abbreviations due to character 
limitations, this method is less intuitive. Also, only profiles available on your system will 
be available for choosing.    

In the PRINTER PROFILE 
section of the Dashboard, 
click Choose by Profile.  

Select the profile from the 
drop-down list--you can nar-
row down your selection 
by ink set (Photo, Matte, or 
Phatte) and Color vs Gray 
via the check boxes above 
the drop-down.

Only profiles that are within the ImagePrint Color folder will be shown in the drop-down 
menu.  Profiles you don’t have can be manually downloaded via the Profile Manager util-
ity.  This method is fully described earlier in this chapter.  

Add to Favorites: If the currently chosen profile is one you plan to use often, you can 
add it to a list of favorite profiles with the Add to Favorites button. Profile Favorites are 
described on the following page.

Auto Set: When a profile generated by ColorByte software is selected as the Printer 
Profile, the Ink Set and Quality mode used to create that profile will automatically be 
selected in they’re proper fields, eliminating the need to modify them to match the  

profile. 
 

  Note that this feature is only available for printer profiles generated by ColorByte.  

Choosing Profiles (continued)
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Choosing Profiles (continued)

Method 3: Profile Favorites

You can save commonly used profile selections to a list of favorites, then easily select 
that profile in the future from the Favorites tab of the Dashboard’s Profile section.  

Add a Favorites: 

To add the current profile selection as a 
Profile Favorite, click the Add to Favorites 
button found at the bottom of the Profile 
Valet or Choose by Profile area. 

In the Add Profile to Favorites window 
that appears, specify a “nickname” that will 
be used for your profile in the Favorites list.

You can also specify what Media Type 
(name) should be associated with the pro-
file as well as what Quality to use (and the 
passes/HS mode) as well as the Media 
Feed Adjustment setting.  Media Type, 
Quality and Media feed adjustment are 
more fully described in Chapter 15 Printing 
and Print Setup.

Accessing Favorites: 

To choose a profile from your 
saved list,  expand the Profiles 
section of the dashboard and 
click the Favorites tab.

Choose the profile favorite you 
wish to use and click the Apply 
button.

You can also delete a favorite 
from the list by choosing it and 
selecting the Delete button.
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The Source (Image) Profile

Unlike the Printer profile, source profile settings seldom need to be changed.  This is 
because most users use embedded (sometimes called “tagged”) profiles in their imag-
es--embedding your source profile in your image ensures software programs know, right 
from the start, the correct source profile for your image. Most software programs allow 
embedding the profile within their Save File dialog.  

ImagePrint will automatically apply the embedded profile if found in an image. For most 
workflows, that means nothing else needs to be done--if you know that all of your images 
have embedded profiles (most do) you can move on to the next section--you are done 
selecting profiles!

For images that don’t have embedded profiles, ImagePrint  will use the default source pro-
files specified in its Preferences window.  

For RGB images, the default is Adobe 1998.  
For single-channel grayscale images, the default is Gray Gamma 2.2.  
For CMYK images, the default is US Web Coated Swop.
 

These are the most commonly used color spaces for those types of images.  Only if your 
images don’t have embedded profiles and aren’t using one of the above defaults will you 
need to change the ImagePrint defaults to match your workflow.  You can also change 
the profile settings on a per image basis via the Dashboard’s Image Properties section 
described in chapter 5, Tools and Features.

To change the default profiles 
ImagePrint uses, choose Preferences 
(via the View Menu on Windows or 
the ImagePrint menu if on Mac) then 
click Default Profiles and change the 
defaults accordingly for each color 
space within the Missing Profiles/
Untagged Images area.

Although seldom needed, you can 
also change ImagePrint’s default 
method for handling Embedded pro-
files. Setting the Embedded Profile Action to Prompt instead of Apply will cause it ask 
before applying the detected embedded profile.  Setting it to Ignore will cause any embed-
ded profiles to be ignored (which will cause the default settings (if any) within the Missing 
Profile/Untagged Image section to be used.  You can also change the Embedded Profile 
Action on a per image basis via the Dashboard’s Image Properties section described in 
chapter 10, Image Properties.

Choosing Profiles (cont)
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Color Management Concepts - Types of Profiles

Simply speaking, color management boils down to how colors are converted from one 
color space to another. Since most image creation methods (such as cameras) can pro-
duce a wider range of colors (referred to as their color space) than most output methods 
(such as printers) can utilize, some mechanism needs to exist to convert the colors from 
one device’s space to the other while preserving the appearance of the image as closely 
as possible. Using ICC (also called ICM) profiles to accomplish this is the heart of color 
management.

Note: ICC (International Color Consortium) and ICM (Image Color Management) profiles 
share common formats and are essentially the same.  ICM profiles are typically generat-
ed on Windows computers, while ICC profiles usually come from Macintosh computers.  
ImagePrint handles both formats identically, and with no change of filename required. 

In a color managed workflow, each image, and each device outputting that image, has 
associated profiles that describe how many and what colors can exist for it.  

In a printing workflow, there are typically 3 of these profile types that come into play:  
Monitor Profiles, Source Profiles, and Printer Profiles

Monitor Profiles 

While it’s not necessary to have a calibrated monitor to print with ImagePrint, if you edit 
your images on screen a properly calibrated monitor is vital in order to ensure that what 
you see on the screen accurately reflects what’s in your images.  

When you calibrate your monitor, a Monitor Profile is created by your profiling software 
and is typically installed into your operating system as part of the process.  Like most pro-
grams, ImagePrint uses this monitor profile automatically so there is no need to specify it 
within the software.  

Remember--the monitor profile does not actually change the output to your printer or 
modify the colors within your image.  Instead, it simply provides information about your 
particular monitor’s display so your operating system and programs like Photoshop and 
ImagePrint know how to properly show colors on it.  
 
Of course, if you adjust your images using the on screen preview as a guide, a faulty 
monitor calibration can cause you to make incorrect edits which certainly will reveal them-
selves in the print!
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Source Profiles

Source profiles characterize the color space of images.  (Photoshop calls these image color 
spaces working spaces). These profiles define the full range of colors that can be represented 
within the digital picture. Though it might seem that a bigger space is always better (more 
colors!), that’s not necessarily true--while a color space that is too small may limit the avail-
able colors you have in the image,  a color space that is too broad might lead you to create 
images with colors that are not reproducible on your output device or monitor (which can lead 
to unwelcome surprises at print time). 

Since no color space is a perfect match to all potential output methods, picking the right color 
space depends on your intended workflow. Bigger spaces like Pro Photo RGB will force you 
to be more vigilant (by using Photoshop’s soft proof and gamut warning tools) to ensure that 
colors are converted correctly to the printer’s more limited range of colors.  Smaller gamuts 
like SRGB reduce the likelihood of “surprises” at print time since the printer can often handle 
all the colors in that space (depending on the paper used) but there’s a risk of limiting the 
potential range of colors you could be printing. Adobe 1998 is often the best balance between 
what your printer can print, your monitor can display and your camera can shoot.  

Huge color spaces: There are some 16 bit source spaces (like Pro Photo RGB) that are 
much bigger than the color space of the printer and monitor. These huge spaces require care 
when editing and are generally best for archiving copies of your work and purposes other 
than printing.  Converting  a “print” copy of the image to a smaller space (like SRGB or Adobe 
1998) will help prevent big color shifts at print time.  If you do plan to print images that are in 
a very large color space, using Photoshop’s Proof Setup feature and gamut checker is always 
a good idea to ensure that the colors in the image are within the gamut of the printer/paper. 
Manually bringing colors into the printer/paper gamut before printing eliminates surprises that 
can come about if you just let the conversion to the smaller space happen automatically.

Maintaining consistency: Most images use well known color spaces such as Adobe 1998, 
SRGB, or ColorMatch RGB, and its beyond the scope of this guide to list the pros and cons of 
each. But, whatever the color space you use, one of the most critical aspects of proper color 
management is consistency--if an image is in one color space (such as SRGB) it is important 
that throughout your workflow the color space is either maintained or is properly converted to 
another one. (Photoshop can do profile to profile conversions via its Image -> Mode menu). 
Because it is not apparent just by looking what color space an image was created in, embed-
ding the source profile within the image is the best way to ensure that, throughout your work-
flow, the correct color space is used.

Embedded Profiles:  When a color managed application like Image Print or Photoshop 
opens an image, it needs to know its color space in order to properly map the colors. To make 
this easier, many applications and devices allow you to “embed” the profile within the image.  

Color Management Concepts - Types of Profiles (Cont.)
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Embedding the profile can take the guesswork out of color management--with 
the profile embedded, applications know what the correct color space is auto-
matically at the time of opening it.  If the profile is not embedded, it is critical 
that you specify the correct profile--otherwise, the colors will be mapped into an 
incorrect gamut for the actual color data.  In Photoshop, the Save dialog con-
tains a checkbox to specify that the profile be embedded in the image.

Using a Monitor profile as a source profile: Converting your images into 
the color space of your monitor may seem like a good idea--after all, that will 
ensure that the image contains only colors that are displayable on your screen.  
However, locking your image into the color space of your particular monitor 
is almost always a bad idea.  Your monitor space only applies to your display 
at a particular point in time--it would not match the display of others who may 
need to work with your image, or even other systems that you may have.  Also, 
the monitor profile is rebuilt each time you recalibrate--you may quickly end up 
with a library of images all with different source spaces which can be a consis-
tency nightmare.  And besides, locking your image into the particular strengths 
and weaknesses of one monitor may unnecessarily limit the gamut of your 
images.  Instead you should use one of the standardized spaces (Adobe 1998, 
Colormatch RGB and SRGB are examples of industry standard color spaces) to 
ensure a consistent workflow.

Know the color space of your untagged images! 
 

By default, when an image without an embedded profile is 
opened for the first time in Photoshop, you will be prompted 
to choose how to handle color managing the image.  (Since 

Photoshop can’t detect an embedded profile it needs to be told 
what to use).   

 
If you tell Photoshop to “Use the current working space profile”  
you are telling it to assume the default working space currently 
chosen in the Photoshop Color Settings window is the space 
the image was created in.  If this happens to be different than 

the image’s true color space, the image will be incorrectly color 
managed and will likely not print correctly.  Check your camera 

settings, scanner software, or the person supplying your images 
to ensure you are using the correct source space for these “un-

colormanaged” images.

Color Management Concepts - Types of Profiles (Cont.)
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Output (PRINTER) Profiles

The final profile type are Output profiles.  These profiles characterize the color space of 
output devices.  In the case of profiles for printers, remember that all aspects of the output 
are taken into account when a calibration print is made--the paper, the inks, the print qual-
ity settings, and the software used to drive the printer make a difference in what colors 
can be produced.  Therefore a profile made for one printer driver or RIP would not 
be correct for another driver since each software driver prints differently--don’t use 
ImagePrint profiles with the manufacturer’s printer driver (or vice-a-versa) or bad 
color will result.  

The media and ink you are using can have dramatic effects on the range of colors repro-
ducible by the printer.  Matte papers tend to have significantly less overall gamut then 
photo/glossy papers, and pigment inks tend to have less gamut than dye inks (although 
pigment inks have much better resistance to fading over time).

Important: Each time you change the paper you are using in your printer, 
you will need to choose a profile made for that paper to compensate for its 
unique printing characteristics. Choosing profiles will be discussed later in  

this chapter. 

Printer Profile Creation Printer profiles are created by printing a color chart contain-
ing hundreds or thousands of color swatches.  This chart is then read by a colorimeter or 
spectrophotometer to build a “thumbprint” of all the colors the printer is capable of produc-
ing on that paper and how it prints them.

In the past, different printers of the same model would often not match “out of the box” 
when printing on the same media.  To bring them together, it was often necessary to pro-
file each printer individually, or create linearization tables to force each printer to behave 
in a standard way. Today’s professional inkjet printers maintain excellent consistency from 
device to device so it is usually no longer necessary to create custom profiles for individual 
printers to compensate for device differences.

One of the biggest strengths of ImagePrint is the large number of printer profiles provided 
for free.  ColorByte uses top of the line devices to build these profiles and uses its own 
proprietary software to create them.  Although you can build profiles yourself, by far most  
users find that our profiles give superior results to custom profiles they can make them-
selves.  Information on acquiring profiles form the ColorByte online repository appears later 
in this chapter.

Color Management Concepts - Types of Profiles (Cont.)
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Printer Profile Availability: If you use a paper that doesn’t have a default profile available 
from ColorByte, you may be eligible to have one generated for free.  Email ColorByte software 
at support@colorbytesoftware.com for details on the procedures required. (Typically  you’ll 
need to send some sheets of media to ColorByte to use in generating the profile). Make sure to 
include your dongle number, and the exact name of the paper and printer you are interested in, 
in the email. 

Never try to use a profile made for one printer driver with another.  Printer profiles 
are specific to the software printer driver they were made for.

Color Management - Bringing it all together

We’ve now covered the most basic components of a color managed workflow.  A proper moni-
tor profile to correctly view your images, a proper source profile embedded in the image, and a 
proper output profile for reproducing the image within the color capabilities of the printer for a 
given paper. 

In a standard color managed workflow (using embedded profiles within your images):

•	 	 When an image is opened in ImagePrint, the software checks to see if the image has an 
embedded Source Profile--if it does, then it will use that profile to determine the proper 
color values within the image.  If if doesn’t, it will assume the default profile (as set in 
Preferences) is the correct profile and use it.

•	 	 Next, the currently selected Printer Profile and ImagePrint uses its internal color man-
agement engine to convert from the source color space to the printer color space.

•	 	 The results of that conversion are then passed through the current Monitor Profile to pro-
duce an accurate representation on screen of how the image will look when printed.  

•	 	 When you click print, the results of the source space to printer space conversion are 
sent to the printer via ImagePrint’s printer driver.

There’s a lot more to color management, but understanding the above profile types and general 
concepts is vital to taking hold of your color managed workflow.  The next portions of this chap-
ter describe other color management topics, such as softproofing and rendering intents and how 
they are used by ImagePrint.

Color Management Concepts - Types of Profiles (Cont.)
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Softproofing
A major goal of most workflows is to have what comes out of the printer match what you see 
on the screen.  Using the computer monitor to simulate the printed output is called softproofing, 
and can be one of the most challenging tasks in color management.

Note: More information on soft proofing and proper color management can be found in the 
ImagePrint Troubleshooting guide within the Profiles and Color Management section

Softproofing in ImagePrint

ImagePrint always shows a softproofed display by passing the displayed image through the 
chosen printer profile.  This means that if you have picked the proper printer profile for the 
paper you are using the image on the screen should accurately reflect the print--as long as:

1. Your monitor is properly calibrated for print conditions including brightness
Calibration software typically calibrates the monitor to achieve optimal viewing 
brightness--not to match the relatively darker look of a physical print which has 
no pure whites or blacks.  Therefore--even if the colors look correct-- it is often 
necessary to use the monitor’s controls to darken the display to achieve a match 
in the tonality of your prints, or create a monitor calibration for a lower luminance 
than the default setting of your profiling software. 

2. Your printer is functioning properly
Always do a nozzle check on the printer at the first sign of trouble to ensure that 
there are no clogs--a single slightly clogged nozzle can have dramatic effect on 
color cast.

3. Your color management workflow is correct
•	 Make sure you know the proper source space (i.e., SRGB or Adobe 1998) of your 

images at every step in your workflow--improperly “dumping” an image from one 
space to another without proper conversion is a major source of color issues.  

•	 Familiarize yourself with the ImagePrint color management settings by read-
ing through this chapter. If you have color problems, check out the entries in the 
Profiles and Color Management section of the ImagePrint Troubleshooting guide.  

	 Some common causes of color issues within ImagePrint are:
  -	 Choosing the wrong Paper/Printer profile for the media being used.

  -	 Selecting a Simulation profile in Preferences when you are not trying to match 
another printer.

  -	 Printing images that don’t contain embedded profiles while not having the correct 
default profiles set for non-color managed images in Preferences.	  

Color Management Concepts - Soft Proofing
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Color Management - Softproofing (cont.)
Soft Proofing with color and grayscale profiles in Photoshop

Since by far most color correction work is done via Adobe Photoshop, achieving a workable 
match between Photoshop’s display and the printer’s output is often critical, especially for matte 
papers which can have dramatically smaller gamuts and max densities than glossy media.

By default, Photoshop does nothing to adjust its display to reflect what the printed results will 
be. Thus the image on screen will appear the same no matter if you plan to print it on high 
gloss film, canvas, or rag paper.  Because different papers can have vastly different color repro-
duction capabilities, it is therefore critical that you see the image as it will be printed so you’re 
not “flying blind” when making adjustments.  

To alter its display to reflect the intended printing conditions, Photoshop has a feature called 
Proof Setup.  With Proof Setup, you can choose a printer profile for Photoshop to use when 
displaying images, there by allowing you to make adjustments in an informed environment. 

GRAYSCALE SOFTPROOFING: Note that Photoshop’s Proof Setup feature works with all 
ImagePrint color profiles but only with newer (type “7”) grayscale profiles.  These grayscale 
profiles will have “7” in the name, right after the inkset (mk, pk, dk) designation.  Photoshop 

Proof Setup does not work with older style ImagePrint Gray profiles. There’s more on grayscale 
soft proofing on the following pages.

The first step in soft proofing in Photoshop is to copy the profile(s) you will be using to the 
folder Photoshop uses for soft proof profiles. The ImagePrint Profile Manager can do this for 
you:  1.) Launch the Profile Manager from its location in your ImagePrint folder (You don’t need 
to connect to the profile online site).  2.) Choose the profile from the list of locally installed pro-
files. 3.) Select “Install profile for Photoshop soft proofing” from the Profile Manager FILE menu.  
For more information on the Profile Manager, check out the Profile Manager section later in this 
chapter.

Once in place, this profile can then be selected within Photoshop by choosing View->Proof 
Setup.  When the Proof Setup window  appears, click the CUSTOM button and choose the 
printer profile from the list of profiles that appears.  Once it is chosen, you’ll see Photoshop’s 
display change to reflect the output the profile will produce. 

There are other options within the Proof Setup window that may or may not have an effect 
on matching your output (such as simulate paper color).  The best way to determine which 
features to turn on is to print a sample image from ImagePrint, then compare it to the screen 
display of Photoshop with Proof Setup in effect.  Try the different options in the Proof Setup 
window and use the ones that cause the display to most closely match the print. For more infor-
mation on the Photoshop Proof Setup feature, consult your Photoshop documentation.
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Color Management - Softproofing (cont.)
More on soft proof enabled (“7”) grayscale profiles

If you are using a grayscale profile with ImagePrint and want to use it for soft proofing in 
Photoshop you need to copy the profile into Photoshop’s profile folder so that program can 
access it.  The ImagePrint Profile Manager can do that automatically.  Launch the Profile 
Manager from its location in your ImagePrint folder, then choose the profile from the list of 
locally installed profiles on the LEFT and pick “Install profile for Photoshop soft proofing” from 
its File menu.  For information on the Profile Manager, check out the Profile Manager section 
later in this chapter. 

Once you have the grayscale profile in place, there are some settings you may want to adjust 
in Photoshop to optimize the soft proof for grayscale printing.  While not strictly necessary to 
achieve an adequate soft proof, you may find the following improves your screen to print match. 
 
Optimizing the  source space

Newer grayscale profiles created by Colorbyte now contain the necessary soft proof 
information for using them with Photoshop’s Proof Setup feature, however the soft 
proof shown by Photoshop will assume that your grayscale images are in an optimized 
grayscale source space.  To ensure the most accurate soft proof it is recommended that 
you use the optimized grayscale source space, “GrayL.icm”, as the source space for 
your grayscale images. This space enhances the maximum density gradation of your 
images compared to standard grayscale working spaces such as “gray gamma 2.2”.  
 
The “GrayL.icm” profile is included in your ImagePrint folder and can be copied into 
Photoshop’s profile folder via the Profile Manager (see the Profile Manager section within 
this chapter for information on copying profiles for use with Photoshop).  Once in place it 
can be set as the default grayscale working space within Photoshop’s Color Settings win-
dow. Images currently within a different grayscale space can be converted to this space 
by using the “Convert to Profile” function under Photoshop’s Image -> Mode menu. 

Preserve Color Numbers

It is also recommended, when soft proofing with a ColorByte gray profile in Photoshop, 
that “Preserve Color Numbers” be enabled in the Proof Setup window (do NOT use this 
option when soft proofing with ImagePrint COLOR profiles).
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Color Management - Softproofing (cont.)
Softproofing older grayscale profiles in Photoshop

If you are using an older grayscale profile (made for printers earlier than the Epson 7880) 
Photoshop may not support it’s use in softproofing. 

An alternative method is to use Adjustment Layers to simulate ImagePrint’s output in 
Photoshop.  The following instructions outline how to build an adjustment layer in Photoshop 
(the procedure may vary slightly on different versions of Photoshop) 

•	 	 Choose Image->Curves from the Photoshop menu. 

•	 	 Adjust the curve to match your ImagePrint output.  

•	 	 Once you have a curve that causes the on screen image to match the print, click the 
Save button within the Curves dialog box, and save the Photoshop curve as an adjust-
ment layer (you may wish to give it the name of the media you are matching).  

•	 	 You can create multiple adjustment layers in this way, each characterizing a different 
media output of ImagePrint.  

•	 	 To enable/disable a particular adjustment layer, simply click the layer visibility icon 
(an eye symbol) within the Layers palette of Photoshop.  This will allow you to work 
in a Photoshop environment that simulates how ImagePrint will print for that particular 
media.

•	 	 When saving the image, you should make sure that none of these custom adjustment 
layers are enabled in the layers window (the “eye” icon should not be beside any of 
them).  This will ensure that the information in that layer is not saved with the image, 
which would be undesirable as the adjustment layer is used to adjust the Photoshop 
preview only, and should not be applied to the image data itself.
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ImagePrint ships with a small collection of default profiles for some printer/ink/media com-
binations.  If your particular combination is not available in the default set, or if you would 
prefer to have a custom profile created, there are a number of options to acquiring new pro-
files.

The Profile Valet

Far and away, the easi-
est method of acquiring 
profiles for your papers 
is the new Profile Valet.  

Accessed directly from 
within ImagePrint, the 
Profile Valet is designed 
to seamlessly integrate 
choosing and acquir-
ing profiles.  By keeping 
a constantly updated 
list of all profiles on the 
ColorByte online reposi-
tory, the Valet is able to 
show you what paper profiles are available.  Even better, the profile list is by easy to read 
paper names--not cryptic filenames.  

And...perhaps best of all, choosing from the list of available paper profiles and clicking 
Download and Apply will cause the Valet to download the profile for you automatically.  All 
without leaving ImagePrint or scrolling through lists of hard to understand profile names.

The Profile Valet is described in detail in the Choosing Profiles section that appears earlier 
in this chapter.

The next section describes another method of acquiring profiles--the ImagePrint Profile 
Manager utility.  While users of the Profile Valet will not need to use the Profile Manager 
to download profiles, they still may find other features of the utility useful.  With the Profile 
Manager you can easily copy profiles into the Photoshop soft proof folder.  The Profile 
Manager also offers an easy method of removing unused profiles from the ImagePrint pro-
file folder.  

Acquiring Printer Profiles
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If you are using an older printer such as the Epson Stylus 2200, 4000, 7600 or 9600, 
the Profile Valet will not be available.  Likewise, if your ImagePrint computer does not 
have an internet connection you will not be able to use it.  In that case, you will need to 
use a different method to acquire profiles.  But don’t fret--the Profile Manager is still an 
easy to use tool for finding just the right profile for your paper.

Download Profiles with 
The Profile Manager

Not needed if using the Profile 
Valet to choose your profiles.

ColorByte Software maintains 
a repository of ImagePrint pro-
files on its internet FTP site.  If 
a default profile for your printer/
ink/media is not available on your 
ImagePrint CD, it is possible it has 
been added since you received 
your ImagePrint software. 

An alternative way to down-
load and install profiles is via 
ColorByte’s Profile Manager util-
ity.  This application ships with 
ImagePrint, and is also available 
for download from the ColorByte 
web site.

Using Profile Manager to install 
your profiles is simple and quick. 

Just launch it from the ImagePrint folder on your system.

If on a Windows PC, you may have a Profile Manager icon on your desktop.  
If on a Mac, drag the Profile Manager icon to your Dock to have it easily avail-
able when you need it.

Acquiring Printer Profiles (continued)
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Acquiring Profiles: The Profile Manager (continued)

Each time the Profile Manager is launched, 
it will ask if you want to connect to the 
ColorByte FTP site.  Choose Yes to log 
in  so you can download profiles from 
ColorByte’s extensive profile collection. (You 
must be on a computer connected to the 
internet in order to use the Profile Manager 
to download profiles).

If you answer No, the Profile Manager will run in local mode only.  While 
you won’t be able to download new profiles, you can utilize the Profile 

Manager to easily remove unwanted profiles from your ImagePrint folder, 
install profiles for Photoshop to use for soft proofing, and perform other 

maintenance functions.

Once the Profile Manager has 
connected to the ColorByte 
FTP site, the Profile Manager 
will appear.  

The left side  
of the Profile Manager shows 
the profiles you currently have 
on your computer.

The right side shows 
ColorByte’s online profile 
library.
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Acquiring Profiles: The Profile Manager (continued)

Finding a profile

To find a profile on ColorByte’s profile library, navigate through the folders by double-
clicking them.  You will need to first choose the folder for your printer type, then your 
printer model and ink set.

For example, you may be looking for an Epson 
3800 color profile for Hahnemuhle Fine Art 
Pearl (that paper is typically printed with Photo 
Black (PK) ink in the printer).

In this case, you would first double-click 
the Epson Printers folder.  Then, you would 
find 3800pk in the list.  Next, you would 
choose Color (since you want a color pro-
file, not grayscale).  Next, in the list of Paper 
manufacturers that appears, you would pick 
Hahnemuhle.  Then you can pick your profile 
in the list of Hahnemuhle profiles in that folder.

If unsure of a profile, click on it.  You’ll see 
a description of it listed at the bottom of the 
Profile Manager. 

Another way to get 
information is to 
look for a Profile 
Description file.  These 
files are usually listed 
among the Paper 
Manufacturer folders 
when you get to that 
stage in the folder 
hierarchy.  Double-
click this file to open 
a window containing 
descriptions of all the 
profiles 
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Acquiring Profiles: The Profile Manager (continued)

Downloading Profile(s)

Once you find a profile on the right side of the Profile Manager, installing it for use with 
ImagePrint is simply a matter of dragging it from the right window, to the left.

When done downloading profiles, click the Quit button to exit the utility.

To Download a profile, just drag it from the right window 
to the left.  You can also drag a folder containing pro-

files, or select multiple profiles by clicking and holding the 
Control key (PC) or Command key (Mac). 
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Acquiring Profiles: The Profile Manager (cont.)

Other Profile Manager Features

Filter Controls

Above both the 
Local window, 
and the Remote 
window, there are 
fields which will 
let you filter which 
profile names 
appear in the 
profile lists.  (For 
example, you can 
choose to only show 
profiles that corre-
spond to your installed 
printers).

Remove Unwanted Profiles

Double-click a profile on the left (local) side of the Profile Manager to remove it to a 
backup folder of your choice.  This is a convenient way to de-clutter your ImagePrint 
Color folder when you have profiles you no longer use.

Copy Profiles to Photoshop’s Soft Proof folder

In order to be used by Photoshop for soft proofing, ImagePrint’s profiles need to be 
installed in Photoshop’s profile folder.  The Profile Manager can do this for you automat-
ically--just click on a profile on the left (local) side, then click the File menu and choose 
“Install profile for Photoshop soft proofing”.

Extensive Help

The Profile Manager is updated frequently, and not all features are listed in this manual.  
To see what else it can do, choose Display Help from the Profile Manager’s Main menu 
to access descriptions of all its features.
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Acquiring Profiles (cont.)

Downloading Profiles via your web browser or FTP client

If you do not wish to use the Profile Manager to download profiles, you can download 
profiles directly from the ColorByte FTP profile repository via an FTP client or web 
browser.   The profile repository is accessible via the ColorByte software ftp site: 

 	 ftp.colorbytesoftware.com.  

The username is: profiles

The password is: profiles

Profiles are located in folders based on the printer, ink type, and paper type.   After 
downloading a profile, place it in the color sub-directory of your ImagePrint folder (Mac) 
or the Color folder accessible in the ColorByte Software group within your Windows 
Start Menu (Windows) and restart ImagePrint to make it available within your Color 
Management window.

  

Generating your own profiles

Another method of obtaining profiles is to generate your own.  If you have a color 
spectrophotometer or colorimeter, and profiling software, you can create your own color 
profiles for use with ImagePrint.  This can be an efficient and convenient method for 
keeping your printer calibrated in color critical environments, and there are a number of 
products available that can be used.  Remember that profiles are only as good as the 
software and hardware used to create them so choose carefully when purchasing your 
color reading device and profiling software.  

IMPORTANT: ImagePrint currently only supports Version 2.0 ICC/ICM 
profiles (NOT version 4).  

Note: When outputting a color profiling target with ImagePrint, it is necessary that no 
color management be in effect.  For details on turning off ImagePrint’s color manage-
ment features, see Turning Off Color Management, later in this chapter.
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Color Management (cont.)

Installing downloaded profiles

To be used by ImagePrint, profiles must be in ImagePrint’s Color folder.  If using the 
Profile Valet or the Profile Manager to acquire profiles you can skip this page as both of 
those methods will take care of putting the profiles in the right place as they are down-
loaded.  If however you are downloading profiles via a browser or creating your own 
profiles, read on for information on manually copying them into place. 

The location for the ImagePrint Color folder is within the ImagePrint folder on your com-
puter.  The default path of that folder is:

/Applications/ImagePrint/Color         
(on Macintosh computers)

	
C:\ProgramData\Application Data\ColorByte Software\ImagePrint\Color

(on Windows computers)

Tip: On Windows a shortcut to the color folder can be found in the 
Windows START menu (in the bottom left corner of your screen).  Just 

click START, then choose the ColorByte Software program group in your 
list of programs to find the COLOR FOLDER shortcut.

Each time ImagePrint is launched, it scans the profile directories for available profiles.  
Remember, a profile’s filename may be different than the internal name that ImagePrint 
shows in its menus.

If you rename a profile, make sure not to use any non-alphanumeric characters to avoid 
problems. Keep profile names to less than 30 characters in length, or ImagePrint may 
have problems reading them

Finally, if you are using ImagePrint’s client/host network option, make sure to copy 
any profiles you add both to the Client computer(s) Color folder as well as the Host’s. 
(Otherwise  you may get an error when printing).

Note: Be careful to only put profiles in the Color folder.  Other files, or 
sub-folders, could cause problems when ImagePrint launches.
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Color Management (cont.)

ImagePrint’s Grayscale Printer Profiles

If you are using a printer that utilizes gray ink cartridges in addition to standard black, then you 
may be able to utilize ImagePrint’s powerful Grayscale printing technology to achieve extreme-
ly neutral, metamerism-free grayscale prints.  You will also have access to special features 
like Narrow Gamut toning and the ability to print “Colorized” grayscales. (Grayscale profiles 
are not available for all printers -- if your printer has an enabled “gray” button within the Profile 
Valet your printer supports them.)

Printing grayscale prints is just a matter of choosing a grayscale printer profile in the Printer 
Profiles section of ImagePrint’s Dashboard.  

Although picking a “Gray” profile is the only change necessary to get Grayscale output, be 
aware of the following points regarding grayscale printing:

	 •	 RGB, CMYK, LAB and Grayscale images can be printed using the grayscale profiles.  
The source of the image doesn’t matter, nor does it matter if the original image is col-
ored or contains only neutral values. All that’s necessary is that a “Gray”  printer profile 
be chosen--ImagePrint will take care of the necessary conversions from the image’s 
source color space to the color space of the gray profile.

	 •	 When a grayscale profile is chosen, any color elements of the image will be displayed 
as monochrome in the ImagePrint layout area.  The Narrow Gamut B/W controls 
and the Colorize field of the ImagePrint Preferences window become active when a 
grayscale profile is selected.

	 •	 When printing using ImagePrint’s Grayscale technology, the black and gray inks will be 
used predominately along with small amounts of selected other inks.  (The black and 
gray inks alone are not truly neutral, so other inks must be mixed in to provide neutral-
ity).

	 •	 Choosing a “Gray” profile will also cause the proper ink set to be selected in the Print 
Setup section of the Dashboard.  You do not need to make any changes to the ink set 
yourself.

	 •	 You can choose not to use a GRAY profile and print your grayscale images with a 
standard color profile.  However, those prints will be made using all of the inks and will 
likely show considerable color inconstancy and casting.  For the best results, grayscale 
output should always be printed using a “Gray” profile.

	 •	 The “Gray” profiles are not standard ICC profiles.  They have special characteristics 
that allow ImagePrint to control the printers inks that cannot be provided by standard 
profiles.  Only ColorByte can create these profiles. 
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Colorize B/W

What is it?

ImagePrint’s unique Colorize B/W 
printing allows you to have the 
best of both worlds--vibrant color 
for the color portions of an image 
while maintaining perfectly neutral 
grayscale areas!

To use the Colorize B/W feature, 
first pick a ColorByte Grayscale 
profile for the paper you are using 
within the PROFILE section of the 
ImagePrint Dashboard. Only print-
ers that support grayscale profiles 
can use the Colorize B/W feature.

Next, open the ImagePrint 
Preferences window (Preferences 
is found under the View menu for 
Windows systems and under the ImagePrint menu for Macs).

In Preferences, choose the Default Profiles tab and select a color printer profile in the 
Colorize B/W field for the paper you are using.  

The effects of the colorized image will not appear on screen.  
On screen, the image will appear to be grayscale, however, the 
printed output will show the colorized image. 

With this feature, you can add color highlights to your black and 
white output, without losing the neutrality ImagePrint is famous 
for.  

Important: Colorize B/W only works with 8 bit images--16 
bit images are NOT supported.

ImagePrint auto-
matically switches 

to the specified 
Grayscale printing 
profile for the neu-
tral parts of images 

while using the 
profile listed in the 
Colorize field for 
the colored high-

lights.

Other Color Management Features
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Simulation Setup 
(Press Match)

What is it?

Simulation profiles are 
used to cause the output 
of your printer to match 
another output device.  
You might use this feature 
if you want to see how a 
set of images would look 
when printed on a Web 
Offset Press before actu-
ally sending them off to the press. 

!  Most users should leave the Simulation Setup profile at None.  

Choose the Simulation Setup Profile (also known as a Proofer or Press Match 
Profile) within the ImagePrint Preferences window (Preferences is found under the 
View menu on Windows and the ImagePrint menu on Macs) 

In the Preferences window, click the Default Profiles tab and select a printer simula-
tion profile in the Profile field of the Simulation setup section.  Never pick the same 
printer profile you are using for your inkjet printer!  

REMEMBER: The Simulation Setup feature is used to cause your printer to 
match another printer or press--in other words, it will cause your printer to act 
as a proofer to the other printing system.  You will need to have a profile created 
for the output source you are attempting to match.  The desired rendering intent for 
the conversion to the Press Match profile can also be set in this area.  The intent is 
only used if a Press Match profile is selected--otherwise the intent is ignored regard-
less of its setting.

Other Color Management Features
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Shadow Point Compensation Slider  

What is it?

The Shadow Point Compensation slider allows you to adjust the black point of the 
source profiles. With this control, you can adjust the richness of the blacks in your RGB 
images and control how much detail appears in the shadows.  The default value is 50. 
Lower values will result in more dark shadow areas, but at a possible loss of tonal sepa-
ration and shadow detail.  Higher values reduce the density of the shadow areas.

Very Important Note 
 

The effect of the Shadow Point Compensation Slider is much stronger if the Rendering 
Intent used for the image is Relative Colorimetric rather than Perceptual.  

To adjust the Shadow Point slider, open an image in ImagePrint and choose IMAGE 
PROPERTIES from the ImagePrint Dashboard, then expand the SHADOW POINT sec-
tion.  Adjust the slider to alter the selected image’s shadow point--remember, higher val-
ues will expand (lighten) the shadow, lower values darken it--and the effect will be much 
stronger if RELATIVE COLORIMETRIC is the selected Rendering Intent for the image 
type (RGB, Grayscale or CMYK) currently selected. As you change the slider, the cur-
rent shadow point value will be shown in the field to its right.

Rendering Intents and their usage in ImagePrint are described in the following pages.

Other Color Management Features
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Rendering Intents 

ImagePrint allows you to specify the rendering intent for each of the four supported color 
spaces (RGB, Grayscale, CMYK and LAB) as both a default setting and on a per image 
basis.

Specifying the DEFAULT Rendering 
Intents

Open the ImagePrint Preferences 
window (Preferences is found under 
the View menu for Windows sys-
tems and under the ImagePrint menu 
for Macs), then choose Default 
Rendering Intents along the top.

The rendering intents listed here will 
be used for images of the specified 
colorspace. Set them to the intent you 
use most commonly for each type of 
image. 

Specifying the Rendering 
Intents on a Per Image Basis  

If you want to change the ren-
dering intent used by a par-
ticular image without changing 
your default setting, use the 
Image Properties section of the 
Dashboard. 

Not sure which Rendering Intent to use?  ...or what one is?
Rendering intents are methods used by the color management to handle out of gamut colors 
and other issues that crop up when converting from the source space to the printer space.  
For photographic images, Perceptual or Relative Colorimetric will give best results. Read 
on for a little more information on just what rendering intents are and how they can affect your 
output.

Other Color Management Features
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About rendering intents

What are they?
It’s an inescapable fact that when an image is printed, any color within it that can’t be repro-
duced on the printer/paper must be changed to one that can actually print. You can do this 
yourself--using soft proofing tools like those found in Photoshop--or allow it to take place auto-
matically. 

But... if allowing the change to happen automatically, how should those changes from one 
color to another be made?  Should the closest printable hue be used when an exact match to 
an image’s color isn’t available on the printer?  Or should the hue stay the same but the satu-
ration be adjusted to get to a printable color?  And what about the other colors in the image--
the one’s the printer can print?  Should they be left alone?  Or should they change along with 
the non-printable one’s to keep a consistent look to the image as a whole?

Such questions are where Rendering Intents come in.  Think of them as strategies used to 
compensate for the differences in color gamuts and white points of different output devices 
when converting from one to the other. 

The ICC profile specification allows for four standard intents--they are created when the printer 
profile is created and are embedded within it.  ImagePrint allows you to pick which rendering 
intent to use based on the color type of the image--so you can have different rendering intents 
for RGB, CMYK, Grayscale and LAB images. 

The following is a general guide as to the effect of the different rendering intents and when 
they might be best used.  Although four are available, in practice, for Photographic printing  
only two--Perceptual and Relative Colorimetric--are typically used. 

Perceptual

Along with Relative Colorimetric the most often used for Fine Art and Photography
Used often for continuous tone images such as those from scans, digital cameras 
or bitmapped (non-vector) computer images.

Perceptual rendering compresses the gamut of the source color space into the printer 
space.  Think of wrapping your arms around the entire source space and squeezing it 
until it fits the smaller printer space.  The relationship between the colors is maintained 
in this intent, but everything--even the colors the printer can print--get changed (usually 
just a little bit though). Photographic images with lots of out-of-printer-gamut colors often 
yield best results with this setting, although if it’s vital in-gamut colors print exactly as 
they appear the image Relative Colorimetric may be a better fit.  
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Relative Colorimetric

Along with Perceptual, this is the intent most often for Fine Art and Photography. Use 
this option is you plan to use the ImagePrint Shadow Compensation slider to expand or 
compress shadow detail.  

With Relative Colorimetric, out-of-print-gamut colors are clipped to the nearest repro-
ducible hue.  Instead of squeezing all of the image’s colors to fit the printer’s gamut 
(like Perceptual Rendering does), with Relative Colorimetric only the out of gamut 
colors are altered. This means that all the colors that the printer can print won’t be 
changed at all- but those it can’t print will be “clipped” into the closest printable color. 
If you have a lot of out-of-print-gamut colors this can make the image lose detail or 
appear flat in places as some color separation can be lost. Therefore, this intent is 
often a good choice for images that don’t have many important out-of-printer-gamut 
colors or when it’s critical that in-gamut colors are reproduced exactly.

Absolute Colorimetric 

Only recommended for PRESS applications---not for printing photography or fine art
Absolute Colorimetric is most often used for simulating (proofing) another print-
er while reproducing its paper color.

This rendering intent reproduces in-gamut colors exactly, and clips out-of-gamut colors 
to the nearest reproducible hue--just like Relative Colorimetric. The difference is that 
this rendering intent uses the paper color (as recorded in the printer/paper profile) as 
its white instead of treating white as “no ink”.  Everywhere there is white in your image 
will be output with the paper tint.  This makes this the best rendering intent to use 
when simulating another printer and paper (proofing) but not so much for general print-
ing. 

Saturation 

Not recommended for any color critical work.  Used most often for bright, non-color 
critical graphics such as those in business charts.

Saturation rendering is most concerned with maintaining saturation of colors.  Colors 
are mapped with an emphasis on their saturation rather than hue or lightness.  Primary 
colors of the source color space are mapped to the saturated primary colors in the tar-
get space.  The end result is images which maintain their overall vivid nature without 
necessarily producing a precise reproduction of the originals hues.  Bright business 
graphics and signage often works best with Saturation style rendering.

About rendering intents  (Cont.)
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Turning Off ImagePrint’s Color Management

Now that we’ve described ImagePrint’s Color Management, there’s one last thing to cover:  
How to turn it off.

There are times when you may not wish to use ICC/ICM color profiles.  The most frequent 
case is when outputting a target for the generation of custom profiles for your printer.  (For 
details on outputting a profiling target with ImagePrint, please consult the section of the 
Appendix entitled “Printing Calibration Targets”).

Turning off color management in ImagePrint is easily done by setting the source profile for 
your image type to NONE within the ImagePrint Preferences window. (If the image you plan 
to print has an embedded source profile, you should also specify the Embedded Profile 
action be “Ignore” within the Preferences window.)  Since color management requires a 
source profile and an output profile to function, having no source profile available effectively 
shuts it off.

Following are explicit steps to disable color management for each target image type: 

First, choose PREFERENCES from the ImagePrint menu (if using Mac) or from the View 
menu (if using Windows).  In the Preferences window, click the DEFAULT PROFILES tab to 
access the Source Profile fields and change the appropriate setting in the Missing Profiles/
Untagged Images section:

	 If printing an RGB calibration target - (Recommended)  Choose NONE in 
the RGB field within the Missing Color Profile section.

	 If printing an CMYK calibration target (rare) - Choose NONE in the CMYK 
field within the Missing Color Profile section.

If you are not sure what type of target you are outputting, all of the above fields can be set to 
NONE to absolutely ensure color management is off.  

What about the Printer/Paper profile? 
 

With no Source profile available, the Printer Profile is not actually used for color man-
agement (color management is not possible without a source profile).  

 
But... some information from the currently selected printer profile will still be applied 

to the print -- most importantly: what inkset (matte or photo) to use.  So, normally 
you’ll want a paper profile in place that corresponds to the inkset you are using even 

when printing without color management. 
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Preferences 

ImagePrint’s Preferences 
window allows you to specify 
parameters for many of the 
software’s global features.  The 
Preferences window contains 
Grid settings, Smart Alignment 
guide settings,default color 
profile and rendering intent set-
tings and default parameters 
for certain functions such as 
Sharpening and the Shadow 
Point control as well as 
General settings that affect the 
ImagePrint interface including 
default display resolution.

The Preferences window can be accessed via the View menu on the Windows version 
of ImagePrint, and via the ImagePrint menu on the Macintosh.

The remainder of this chapter will describe in detail each of the available settings acces-
sible from the Preferences window.  
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Preferences 

The Preferences window can be accessed via the View menu on the Windows version of 
ImagePrint, and via the ImagePrint menu on the Macintosh.

General

The General Preferences contains miscellaneous settings 
that affect the operation of the software.

Units

The Units drop down menu allows you to choose which 
measurement units are used throughout the interface.  
You can choose between Centimeters and Inches.

Preview Size  

This menu allows you to adjust the resolution with which ImagePrint will display images.  Lower 
values may speed up opening images but will cause them to be rendered in less detail.  This 
value has no effect on the printed output--just the display.  You’ll need to reopen any images 
already in the layout window after changing this setting in order to see the results of the new 
resolution.

Language  

Choose the language ImagePrint’s menus and tools should be presented in.

Use thumbnails from Images Pane

The ImagePrint Image Strip creates small thumbnail images when building its display.  These 
can be used to add images much more quickly to the layout area.  Choosing “Use File Browser 
Thumbnails” will cause ImagePrint to use these low res thumbnails, causing images to be placed 
more quickly but with a lower quality, pixelated appearance. The printed output will not be affect-
ed by this setting. 
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Use alpha-channel in PSD files  

Some Photoshop files (PSD) contain alpha channels.  Normally, an image file includes 
a channel for each primary color used (for instance, an RGB file will have a channel for 
Red, Green and Blue.)  Certain effects, however, (such as masking and transparency) may 
cause additional channels to be used in an image which can confuse software expecting 
each channel to represent a color.  To check your image, you can choose Windows -> 
Channels in Photoshop.

Global Printer Compensation  

These two fields allow you to specify a horizontal (X) and vertical (Y) distance to shift each 
layout as it is printed.  Positive X values will shift images to the right (relative to the  screen 
display) while negative values will shift to the left.  For the Y field, positive values will shift 
down (relative to the screen display) and negative values will shift up.  Unlike the X/Y origin 
point setting (in the Layout Controls window), this shift will NOT be visible on screen and is 
not reflected in any on screen measurements.  The shift will only occur at print time.

The Global Printer Compensation is used to compensate for printer feed or alignment prob-
lems.  For example, if you find that on borderless printing you are getting a “hairline” visible 
on the edge of the page, putting in small negative value here can shift your entire layout over 
to compensate, allowing you to essentially ‘calibrate’ your printer’s page feed characteristics 
so you can be sure the coordinates you see on screen will translate properly to the printed 
page.

Set Profile Valet Offline  (ImagePrint Black only) 

The Profile Valet checks for new profiles each time you launch ImagePrint Black.  If you 
don’t have an internet connection for your ImagePrint computer or don’t want the valet to 
access it you can set this option.  Remember--with this option in effect, the Profile Valet will 
not keep the available profile list up to date and will not automatically download profiles.

Preferences - General (cont) 
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Preferences - Pages

The Pages Tab of the 
ImagePrint Preferences win-
dow is where you can specify 
the settings for both the Grid 
Settings and the Smart 
Alignment snap guides. 

Note that only one of these lay-
out methods can be active at a 
time. 

The Binding Spread (the mar-
gin between two facing pages 
when Spreads is the chosen 
layout mode) is also located in 
the Pages section.

Smart Alignment Settings   

Important: Smart Alignment settings can not be used when ImagePrint’s Grid 
Overlay is active. Toggling the “Use Smart Alignment Settings” checkbox will auto-
matically turn off the Grid.

ImagePrint’s Smart Alignment feature will cause vertical and horizontal “snap to” 
lines to appear as image’s are dragged across various alignment points on your 
layout--such as the center or edges of the page, or the edge or center point of 
other images.  This can aid tremendously in arranging your images in relation to 
one another or the page.

For detailed information on Smart Alignment guides, please see chapter 4, 
ImagePrint Basics.  That chapter also describes Spread mode and the Binding 
Gap.

Preferences (cont) 
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Preferences   - Pages and Grid (cont)

Grid Settings   

Important: Grid settings can not be used when ImagePrint’s Smart Alignment tools are active. 
Toggling the “Use Grid” checkbox will automatically turn off Smart Alignment features.

The Grid Settings section of the Preferences->Page window allow you to display and modify 
a placement grid within the image layout area. Image’s can be “snapped” to grid intersections, 
allowing you to easily drag and drop images into aligned positions. 

Use Grid This check box toggles the display of the grid.

Grid X/Y Spacing  
The Grid Spacing 
fields allow you to 
specify the amount 
of spacing between 
the lines of the layout 
grid.  The X field will 
control the amount 
of spacing along the horizontal axis, the Y field controls the 
spacing along the vertical axis.  After typing in new numbers, 
click the Apply button (or hit the return key) to have them take 
effect in the currently displayed grid.

Snap images to Grid  When Snap to Grid is toggled On via the 
Snap to Grid icon in the Floating Tool Palette, the Upper Left or 
Upper Right corner of the image will automatically jump to the grid 
intersection you specify in the Snap To section (see below) as you 
drag it.

Upper Left / Upper Right   Use these buttons to select which cor-
ner of the image will snap to the grid.  Choosing Upper Left will cause the upper left corner 
of images to “jump” to the closest upper left intersection of grid lines as you move them, while 
Upper Right will cause the upper right corner of the image to jump to the intersection.
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Preferences (cont.)

Default Profiles

The Default Profiles section 
of the ImagePrint Preferences 
window contains advanced 
and default Color Management 
features. Note that these are 
Default settings--newly opened 
images will use these settings, 
but they can be overridden via 
the Input Profiles controls of the 
Image Properties section of the 
Dashboard.

The settings available in this part of the Preferences window are described in Chapter 6, Color 
Management. 

Default Intents

The Default Intents section of the 
ImagePrint Preferences window 
contains the default rendering 
intents to be used for images of 
each color type (RGB, CMYK, 
GRAYSCALE and LAB).   The 
default intent can be overridden 
via the Input Profiles controls of 
the Image Properties section of 
the Dashboard.

The settings available in this part of the Preferences window are described in Chapter 6, Color 
Management. 
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Preferences (cont.)

Default Parameters

The Default Parameters 
section of the ImagePrint 
Preferences window allows you 
to set default settings for sev-
eral ImagePrint tools.  When 
ImagePrint is launched, the val-
ues you select in this window 
will be applied to each image 
you open automatically.

Use Sharpening

The Sharpening feature is described in chapter 9, Correction Tools Specify the Radius and 
Magnitude sharpening values  you wish to apply to each image upon opening.

Use Shadow Point

The Shadow Point slider is described in chapter 6, Color Management. Normally the Shadow 
Point slider defaults to 50, but here you can specify a different value to apply to your images 
when they are opened.

Use Wide Gamut Tint

The Wide Gamut Tint tool is described in chapter 9, Correction Tools.  This area of the Default 
Parameters  window lets you choose from your saved Wide Gamut Tint settings files. Once cho-
sen, the Wide Gamut settings will be applied to all color images that you open.

Use Narrow Gamut Tint (ImagePrint Black Only)

The Narrow (black & white) Gamut Tint tool is described in chapter 9, Correction Tools.  This area 
of the Default Parameters window lets you choose from your saved Narrow Gamut Tint settings 
files. Once chosen, the Narrow Gamut settings will be applied to all grayscale images opened. 
ImagePrint BLACK only, not available for ImagePrint R.E.D.
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Layout Settings

Normally, when you open an image into the ImagePrint layout area, it comes in at its saved 
width and height, and is positioned as far up and to the left on the page that it can fit.  You can, 
however, define rules that cause images to be automatically sized  and positioned as they are 
opened. These rules are defined in the Layout Settings area of the Dashboard.  You can then 
save these settings to create custom layout “schemes” that can be used to automate different 
workflows.

To access ImagePrint’s Layout Settings, click the triangle icon beside the word Layout in the 
ImagePrint Dashboard.

Layout Styles and Layout Schemes

At the top of the Layout Section are two drop-down menus. The Layout Style menu and the 
Saved Layout Scheme menu.

Layout Styles

The first step in defining Automatic Layout parameters is choosing 
the Layout Style you want to use. Layout styles define the gen-
eral rules of how images will be sized and oriented when brought 
into ImagePrint.  For instance, you may want images to always 
be opened in their original orientation.  Or, you may want images 
to rotate if that lets them fill the page or your custom size param-
eters more efficiently.  You may also want images to fill preset 
ImagePrint Templates to create Photo Packages. 

There are five available layout styles:

As is  
Images will be placed in their original orientation. If a custom width or height is in effect, 
the image will be cropped to fit but will not rotate to “best fit” the custom size.

Rotate to Fit 
Images will rotate to best fit on the page or within any specified width/height settings as 
specified in the Layout Controls area or via a selected Layout Scheme. If a custom width 
or height is in effect, the image will be cropped to fit.  For most users, this should be 
the default setting.

Fit to Size 
Images will scale to fit the current width/height settings specified in the Layout Controls 
area (below)--no automatic cropping will occur, but images will be centered within the 
width/height bounding box.  This mode is good for Index Sheets as images will be 
spaced uniformly on the page.
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Template and Linked Template

The last two Layout styles are special modes for use with ImagePrint Templates. 
When one of the Template based modes is selected as your Layout Style, newly 
opened images will be added to the currently selected template (As shown to the 
right of the Layout Style menu in Saved Layout Scheme menu.) Templates won’t be 
covered much in this chapter, but for information on creating and using templates, 
see chapter 11, Templates

The Layout Scheme Menu

To the right of the Layout Styles menu is the 
Layout Scheme menu.  Here you can pick 
from any saved Layout Schemes you have 
created.  By default, you’ll see “no name” in 
this menu, meaning you currently don’t have a 
saved Layout Scheme selected.  (Don’t worry, 
you don’t need to use a saved Layout Scheme 
in order to take advantage of layout settings-
-it’s just a convenient way to save your layout parameters in order to reuse them later.

More information on saving Layout Schemes will be covered later in this chapter.  

Hint:  Layout Styles are best understood by seeing them in action. Check out the 
Layout Types tutorial from the ColorByte web site’s tutorial page.

Layout Settings (cont)
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Layout Controls 

Below the Layout Style and Layout Schemes menus you’ll find the various Layout Controls for 
customizing how images will be sized, cropped and positioned on the page.

Photo Sizes / Max Width and Height

When images are opened into ImagePrint they 
can be automatically sized to fit within a cus-
tom width/height bounding box that you 
specify.  You can do this through pre-set 
Photo Sizes, or by manually entering a 
Maximum Width and/or Height.

Photo Sizes

The drop down menu at the top of the Layout 
Settings window allows you to choose from 
preset sizes for your images.  Most common 
sizes can be found in this list. Choose a size 
to have all newly opened images sized to the 
selected dimensions.

Max Width / Max Height

You can also specify your own custom width and height by typing in the values within the Max 
Width/Max Height fields. The checkboxes next to each field may need to be clicked to activate 
the field for modifying.  

Any newly opened images will be constrained to the width/height values. If Crop and Zoom 
(below) is enabled the image will be cropped to best fit the dimensions.  If Crop and Zoom is 
NOT enabled, the image will be “best fit” within the specified dimensions while maintaining its 
original aspect ratio. 

Note that you can specify one dimension while leaving the other empty.  This is useful for 
specifying one dimension but not the other. For example, typing 6 inches in the Width field, but 
leaving the Height field empty will cause all images to open at 6 inches wide, with the height 
varying according to the aspect ratio of the original image.

Layout Settings (continued)
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Center Automatically

Clicking the Center Automatically checkbox speci-
fies that each image will be centered on the page 
as it is opened.  Only use this option if planning 
only one image per page as it does not apply 
centering to multiple images on a page.  With 
Auto-flow on, this option allows you to quickly create 
single-image, multi-page layouts.

Crop and Zoom  

This option cause newly added images to grow (or shrink) to fit the specified width and 
height values, with an automatic crop applied to make them fit perfectly.  

Understanding Crop and Zoom  If the aspect ratio of the image is not the same as the 
specified Width / Height dimensions, an automatic crop of the non-fitting dimension will 
occur (you can always adjust this auto-crop by double-clicking the image and using the 
Smart Crop feature).  Without Crop and Zoom in effect, the image will be sized to fit with-
in the width and height specifications, but will be smaller in one dimension if the aspect 
ratio does not match.

An example: The Width and Height values are 4 by 5 (represented by the red rectangle, 
below).  A 2 by 3 image is added to the layout. Since the 2x3 is not the same aspect ratio 
as 4x5, the image will not perfectly fit the specified dimensions.  

With crop and zoom on, the image is grown to completely fill the 4x5 size, with the 
excess in one dimension being trimmed.  Without crop and zoom, the image will be sized 
to fit within the 4x5 boundaries with no cropping (and therefore not a perfect fit--one 
dimension will be smaller.

Layout Settings (cont)

Crop and Zoom ON Crop and Zoom OFF
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Auto Flow   

Auto Flow determines what happens when a page is 
filled.  ImagePrint will either lay new images on 
top of old ones, or automatically generate a new 
page and place newly added images there. Auto 
Flow can be a powerful way of generating multiple 
pages full of images.

Auto-Flow On  Indicates that Auto-Flow is in effect. 
If an image can’t fit on the current page, a new page 
will be generated for it.

Auto-Flow Off  Indicates that Auto-Flow is not in effect. If an image can’t fit on the 
current page, it will be stacked on top of other images on the current page.

Place Holders   

The Placer Holders option will cause rectangular placeholders to appear in the layout area, 
representing where images will be placed based on the current settings within the Layout 
Settings window.  These rectangles are for display purposes only in order to help you see the 
effects of your layout settings.  They will not be printed.  

Note that Place Holders are only available when Crop & Zoom is in effect as that setting 
ensures images will be cropped to perfectly fill your specified width/height values -- with-
out Crop & Zoom, images of different aspect ratios will be “best fit” within the bounding box 
which makes predicting Place Holder sizes and positions impossible.

Fit oversized images   

With Fit oversized images enabled, images that are too big for the printable area of the cur-
rent page (or a subset of the page as defined by the page origin point) will be automatically 
scaled to “best fit” within that area while maintaining the image’s original aspect ratio and 
without cropping.  If there are already images on the current page, a new page will be gen-
erated for the image.

Layout Settings (cont)
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Gutter

The Gutter Layout Settings control how far apart imag-
es should be spaced as they are automatically added to 
the Layout area.  

L-R:  Enter a “Left to right” gutter to specify the amount 
of horizontal space between your images.  

T-B: The “Top to Bottom” field designates the vertical 
spacing between images.

Values can be typed in, or adjusted with the “spinner” controls to the right of each field.

Remember:  Gutters have no effect on how far images will be placed from the edge of the 
paper.  Just how far apart they will be placed from one another. 

Layout Settings (cont)

Gutters
L/R: .25 inch

T/B:  .25
(Default)

Gutters
L/R: .5 inch
T/B: 1.0 inchGutters

L/R: 0 inch
T/B:  0 inch
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Page origin   

The Page Origin allows you to specify where the imag-
es begin on the layout area.  By placing a value in the 
X and Y fields, you can offset your images to the right 
and down on the page, effectively adding margin area 
to your print. 

Understanding Page Origin    
 
The origin point values are relative to the edge of the physical paper itself--not just the 
printable area.   
 
So, a 0,0 value means the upper left corner of the first image will fall flush with the edge of 
the paper.  If not printing full bleed (borderless), this means that some of the image will fall 
off the printable area and not print in this case. Which typically is not desirable.  
 
This is why the default origin point may not show 0,0.  Instead, the default values will 
correspond to the non-printable margins in effect.  The exception is when printing in 
borderless mode.  Since you can print to the edge of the paper when printing borderlessly, 
the default values for the origin point will be 0,0 in that mode meaning the images will start 
at the physical edge.  

Layout Settings (cont)
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Crop to page   

The Crop to page layout feature will cause any image 
that’s too big to fit within the printable area of the current 
page (or a subset of the page as defined by the 
page origin point) to be automatically cropped so 
that it completely fits without scaling the image. 
You can choose to crop only the left or right sides 
of the image, or equally crop both sides.  This set-
ting can be useful for some workflows--such as printing oversized blueprints--where it’s impor-
tant that image is not cropped or resized at all while retaining as much of the image on the 
page as possible.

Layout Setting Examples 

Here’s some examples of various layout settings and how they will effect image placement.

No layout settings in effect. Images open “as is” at their 
saved size, nesting on the page starting as far up and 
to the left as they will fit and placed at a default of .25 
inches apart from one another.

Layout Style “As Is”, max width 5-inches and max 
height 6-inches. Crop & Zoom enabled. Images 

are cropped to entirely fill the 5x6 bounding box.

Layout Style “As Is”, 5x6 max width/height, with 
Crop & Zoom NOT enabled.  Images are scaled 
(not cropped) to fit within the 5x6 boundary 
meaning some images of differing aspect ratios 
may have smaller widths or heights than others.

Layout Style “Fit to Size” with a max. width of 
5-inches and height of 6-inches. Images are 

scaled to fit without rotating within the 5x6 
boundary and centered without cropping.

Layout Style “Rotate to Fit”. 5-inch max width, 6-inch 
max height. Images are rotated if necessary to best 
fit the 5x6 (portrait shaped) boundary without cropping.

Layout Settings (cont)



8-10 ImagePrint R.E.D. User’s Guide

Saving your layout parameters with Layout Schemes

Saving and reusing your automatic layout settings  

All the settings in the Layout Settings window can be saved and reused.  That makes it 
easy to create a list of Layout Schemes to be used for different output needs. For example, 
you may want to create a scheme called “My proofsheet” that scales all your images to fit 
within a 2x2 inch area, spaced 1 inch apart.  Another scheme called “My Portraits” could be 
created for sizing all your images to fill an 8x10 size, centered on the page.

Saving a Layout Scheme  

To save the current Layout Settings, choose “Save Layout Scheme” from the ImagePrint 
File menu.  In the standard File Save dialog box that appears, give your new Layout 
Scheme a descriptive name and click OK.  Layout Schemes will be saved to the Layout 
folder within your ImagePrint folder.

Choosing a Layout Scheme  

To choose a Layout scheme, first make sure the layout type chosen in the Layout Style 
menu of the Dashboard is set to As is, Rotate to Fit, or Fit to Size (Do not choose 
Template--in that mode only saved Templates, not layout schemes, will appear in the 
Schemes menu.)

Layout Schemes will be listed in the Layout Scheme menu to the right of the Layout 
Styles menu in the Dashboard.  Choosing “No Name” will cause no layout scheme to be in 
effect.

Choosing a layout scheme will cause the values saved with that scheme to appear in the 
Auto Layout Settings section of the Dashboard and those settings will be used for any new 
images you open until you pick another scheme. 

Note: The current Layout Style (As is, Rotate to Fit, or Fit to Size) is included in the 
Layout Scheme. The Layout Style that was saved with the selected Layout Scheme will 

be loaded when that scheme is selected.

Layout Settings (cont)
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Correction Tools

Tone, Selective Cast adjustment, 
Histograms, Wide Gamut, Narrow 
Gamut and Sharpening with 
Before and After Probe

ImagePrint offers color and tone 
correction abilities for RGB and 
CMYK and GRAYSCALE (nar-
row gamut) images through its 
set of correction tools including 
16-bit output sharpening.

Each correction window 
contains before  and 
after views of the image, 
allowing you to see how 
the corrections you make 
compare with the original-
-both after the printer pro-
file is applied, and in its 
unconverted (no printer 
profile applied) state as 
well.  

To Access the Correction controls, choose it from 
the Edit drop-down menu within ImagePrint’s 
Main menu, or right click (or Control-Click) 
an image within ImagePrint’s layout area and 
choose Correction via the menu that appears.
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Combined Corrections Tools and 
Features

ImagePrint’s Combined Corrections window 
brings together several new tools and features 
common to all the correction modes.  Before 
we cover the details of using each correction 
tool, let’s go over the common features within 
the Combined Correction window that all of 
them will use.

Before and After views

The most obvious change to the ImagePrint Correction window with version 10 is the addition 
of a before and after side-by-side view of the image you are correcting.  The left display is the 
before representation.  This section shows the image before any corrections you make via the 
Correction tools are applied.  But that’s not all--it can also show the image before the Paper 
Profile is applied as well!

By default, the before view will show the image as it will appear when printed.  This is a “soft 
proof” view, and historically has been ImagePrint’s normal viewing mode.  It shows the image 
after it has been processed through the currently chosen ICC/ICM Paper profile.  Typically, 
this means the image may appear less vibrant and dense as the paper and ink will invariably 
reduce both color range and density to some degree or another.  Note that this effect is typi-
cally much more evident when printing to a Matte Paper.  Photo/Glossy papers often show very 
little reduction in color and contrast--in fact, it can be hard to see a difference with and without 
the profile applied.  But Matte papers, with their reduced range and density, will often look sig-
nificantly lighter and more washed out compared to the original or a photo paper print.

By un-clicking the “Include Paper Profile” checkbox below the before section, you can toggle 
the view to show the image without the paper profile applied.  This is a handy way of seeing 
your image in its original state, and gives you a chance to attempt to correct or at least reduce 
any loss of color or density that the paper and inks cause.  

Again--with a photo paper profile in place, you may not see much difference with this control, 
but a matte paper profile will often show a significant change when the paper profile is applied, 
which is expected.  (As nice as many art and watercolor papers are when it comes to texture  
and overall feel, its a sad fact of printing that the blacks and color vibrancy will not to the level 
of most photo papers when viewed side by side.)

Correction Tools (cont.)
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Positioning and Zooming

Another feature common to all the 
Correction tools is the ability to zoom in 
or out of the previewed image and move 
the image within the preview pane.

When you move your cursor within either 
the before or after view, the cursor will 
change to a hand icon, and allow you to 
move the image within the preview area.  
Note that regardless of which side you 
make adjustments to, both before and 
after views will move together.

You can zoom in or out of the image as 
well.  

Just choose the Zoom In or Zoom Out 
magnifying glass in the upper right of the 
Combined Corrections window.  Note 
again, both the before, and after, pre-
views will zoom together.

Probe

The bottom right side of the Correction window 
contains the Probe Area.  The Probe gives you 
valuable information about the color values of a 
selected area of the image.

Correction Tools (cont.)
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There are three columns in the probe area.  Choosing the Eye Dropper tool, and clicking 
in either the before or after image will cause those values to show the color values for:

1. Raw - Before the Paper Profile and Correction

This shows the values, in appropriate absolute 
pixel values (0 - 255) for  image’s color space 
(RGB, CMYK or Grayscale) of the clicked on 
area before the paper profile is applied and 
before any corrections are applied--in other 
words, the original values in the image as it 
was saved.

2. Before - Profile applied but no correc-
tion

This column shows the pixel values for the 
same clicked on area AFTER the paper 
profile is applied but before Corrections.  

3. After - Profile and corrections applied

The final column in the Probe section shows 
the percent values of the selected area both 
after the paper profile has been applied, and 
after any corrections you have made with the 
Correction controls.

Correction Tools (cont.)
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Tone  Adjustment

The Tone Adjustment win-
dow gives access to con-
trols for adjusting the tonal 
curve of your image.  Its 
primary purpose is to adjust 
neutral tones and to adjust 
overall tone compression 
and contrast.  

It is not used for general 
hue correction (changing 
one color range into 
another one)--this is best 
achieved through the 
Selective Color Cast win-
dow described later in this 
chapter.

To access the Tone Adjustment controls, choose Tone from the drop-down menu at the 
top of the Combine Correction window.

Contrast and Range Correction via the Tone curves

To display the overall gradation curve, choose Gradation from the drop down menu at the 
top of the Tone curve.  The black curve defines the tonal compression of the image.  By 
adjusting this curve, the contrast throughout the tonal range can be modified.  

The horizontal axis of the gradation curve shows the input density while the vertical axis 
displays the output density.  Adjustable points (called “anchor points”) are located, from 
left to right, at the highlights, quarter tones, mid-tones, three-quarter tones, and shadows. 
By selecting an anchor point and dragging it up or down, you can alter the gradation value 
for that point.

As you move the gradation curve, the underlying color cast curves will move along with 
the black curve, reflecting the changes made to each color channel by the overall grada-
tion change.

Correction Tools (cont.)
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Adjustments in the gradation curve change the 
input-to-output tonal compression. For exam-
ple, moving the three-quarter tone point down 
expands the shadow area of the image by start-
ing the three-quarter tone range at a lower den-
sity.  This will result in more detail in the darker 
areas of the image, at a possible cost of detail in 
the mid-tones or highlights of the image. 

To adjust a specific color channel, choose the 
desired channel from the drop down menu at 
the top of the Tone and Gradation window.  The 
curve for the selected channel will be displayed 
in the channel’s color (red, green or blue), and 
can be adjusted by clicking and dragging.  As 
with the gradation curve, control is along five 
points of the tonal range: highlights, quarter 
tones, mid-tones, three-quarter tones, and shad-
ows. 

Selective Color Cast Controls

ImagePrint’s 
Selective Color 
Cast controls are 
accessed by choos-
ing Cast from the 
Correction Menu of 
the ImagePrint Menu 
Bar.  

The Selective Color 
Controls are used for 
changing a hue or 
range of hues within 
your image. 

Correction Tools (cont.)
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Note that the Selective Color Cast Controls are not “masking” tools that allow you 
to specify specific areas within your image.  Rather, adjustments will be made to 
all instances of a given hue within your image.   

Understanding the Color Circle

The Color Circle allows you to 
toggle between saturated (high 
chroma) and pastel (low chro-
ma) areas of the image.  

When you click any portion of 
the image shown in the com-
bined correction window, the 
predominant hue of your selec-
tion will be shown as the select-
ed color in the list of colors sur-
rounding the color wheel within 
the Color window.  

Also, ImagePrint automatically 
detects if the selected color is 
a pastel or saturated color, and 
the color wheel will be updated 
in its appearance to reflect this. 

Important:  To toggle between 
adjusting either high or low 
chroma colors, click on the 
color wheel. This toggle feature 
allows you to make changes in 
the darker or lighter colors only.  

Correction Tools (cont.)
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Adjusting Hue

The sliders in the Color Correction sec-
tion is where you perform the actual 
color correction. 

1.		  Select the color (hue) you 
wish to change by click-
ing on it within the image shown 
within the Combined Correction 
Window.  You can click in either 
the “before” or “after” preview.

2. 		 Adjust the sliders to add or 
remove color(s) in a channel. 
Note that as you move the slid-
ers, the slider bar colors will 
update to show  the selected 
hue’s changes.  You can quick-
ly alter the selected hue to the 
desired color by moving the slid-
ers toward the area of the slider 
that displays the color you wish to 
achieve. 

Adjusting Saturation

The overall saturation of the cur-
rent image can be adjusted with the 
Saturation slider at the bottom of the 
Selective Color window.  Moving the slider to the left will desaturate the image, moving 
it to the right will increase the saturation.

Correction Tools (cont.)
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Adjusting the Range using 
Histograms

Manipulating an image’s histograms is 
a quick and powerful method of setting 
its tonal range.  

To access the Histogram Window, choose 
Histograms from the Correction menu in the 
ImagePrint toolbar.

The Histogram window displays the input den-
sity histogram for each color channel and for 
the composite (all colors). 

To adjust the range limits, slide the white slider 
(highlight) and/or black slider (shadow) to the 
desired position.  

The center slider (gray) is used to adjust the 
midpoint of the gradation.  This control can 
be used to cause the gradation to ramp more 
quickly to the shadow or highlight area. 

Correction Tools (cont.)
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Correction Tools (cont.)

Narrow Gamut Toning vs Wide Gamut Toning

In addition to the Tone, Cast and 
Histogram controls, which let you cor-
rect your images, ImagePrint also 
offers to ways of applying toning 
effects to your images--Narrow Gamut 
Toning and Wide Gamut Toning.  Note 
that only one or the other of these 
effects will be available--depending on 
the Paper Profile you have currently in 
effect.

Narrow Gamut toning, which 
applies only to grayscale print-
ing, allows you to add tints to 
your black and white prints, such as sepia or selenium tones. You can also use it to slightly 
warm or cool specified tonal areas of your prints. 

Narrow Gamut controls will only be available when a gray paper profile is in effect (the color 
space of the image doesn’t matter--just the paper profile you have selected for printing).  
Using an ImagePrint gray paper profile causes (almost) only the black and gray printer inks to 
be used, resulting in cleaner grayscale prints that do not change under different lighting condi-
tions.  The available narrow gamut tones are specifically formulated to not reduce these ben-
efits.  If you need a stronger tint, you may need to use a Color paper profile instead and utilize 
ImagePrint’s Wide Gamut toning feature (below). 

Another Grayscale printing only feature--our DCM controls, are also available in this section of 
the Correction window as a convenience.  DCM controls will be described in this section of the 
manual a bit later.

Wide Gamut toning, which applies to color 
printing, allows you to tone to your color 
prints with a specific hue.  Sometimes known 
as brown toning, this feature will colorize 
your image with a strong tint and is similar in 
appearance to a duo tone. 

Wide Gamut toning will only be available 
when a Color paper profile is in effect.
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Correction Tools (cont.)

Using Narrow Gamut (grayscale) toning

To use Narrow Gamut toning, a grayscale paper profile MUST be in effect.  In the ImagePrint 
Dashboard, expand the Profile section and either using the Profile Valet or the “Choose by 
Profile” method, pick a gray profile for the paper you plan to use.  For information on selecting 
profiles, see chapter 6 of this manual: Color Management. 

Narrow Gamut will be available as an option under the Tools menu in the upper right of the 
Combined Corrections window.  

Split Ranges

The Narrow Gamut Correction window 
contains 1 to 4 “Tint Pickers” that allow 
you to adjust the tint (tone) of the select-
ed image.  The number of Tint Pickers 
is determined by the Split Ranges you 
select.

  

Zero splits means just 1 tint will be used for the entire tonal range of the image.  One split will 
divide the toned regions into 2--one for highlights, one for shadows.  Two splits will give you 3 
ranges to tone, and three splits will give you 4.

Control of the tint is accomplished by moving the control point located within the square. Click 
within the square to “jump” the point to that position. 

Each tint picker square shows the range of toning available.   

Moving the control point to the upper right of a circle will warm the corresponding tonal area 
image, giving it a sepia tone.  Moving it to the lower left will cause it to be cooler, giving a sele-
nium tone.  The bottom right will result in a blue/red tonality, the upper left will move the image 
toward moss/green. 
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Correction Tools (cont.)

Mapping the tint
If you have a single tint picker (zero splits) that tint picker affects the entire range of the 
image, likewise, if you have two tint pickers, the left tint picker begins at the highlights 
while the right tint picker always starts in the shadows. 

When you have two or more split ranges active, you will be able to use the slider con-
trols that appear along the bottom of the Narrow Gamut Correction window to specify 
where in the tonal map of the selected image those middle tint picker(s) affect.  This 
allows you to fine tune the way in which your tints ramp into the shadow and highlight 
areas. 

As you move the control points, the 
numeric fields at the corners of the 
Tint Picker will change, allowing you 
to record the settings for future use.  
Returning these fields to their origi-
nal state of “50, 50” will return the 
image back to neutral.

There are controls for reset-
ting, saving and loading your 
tint settings above the Tint 
controls.

Reset
Clicking the Reset button will reset all tint pickers to their original 50,50 (neutral) state.

Save...
Clicking the Save... button will allow you to save the Narrow Gamut B/W toning settings 
to a file for later reloading.

Load...
Clicking the Load... button will bring up a file selection window allowing you to load a 
previously saved Narrow Gamut B/W settings file. You can also set a Narrow Gamut 
B/W Settings file as the default, causing it to be applied to every image opened when a 
gray profile is in use (see below).

Setting a default Tint  - To set a Narrow Gamut B/W settings file as a default to be 
applied to all images as they are opened when a grayscale printer profile is in use, 
access the ImagePrint Preferences window and choose your saved Tint settings with-
in the Default Parameters section.
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Correction Tools (cont.)

Narrow Gamut in Action

With zero split ranges in effect, the image is 
completely toned using the tint selected in 
the single tint picker.  Note how the bar along 
the right side has updated to reflect the toned 
image gradation.

With one split range dividing the image into 
highlight and shadow areas, the tone select-
ed in the left (highlight) tint picker tones the 
highlights while the neutral (50,50) value in 
the right (shadow) tint picker keeps the shad-
ows neutral.

Now there are two split ranges, resulting 
in three tint pickers.  By putting both the 
Shadow (right) and mid-tone tint pickers at 
the same value and adjusting the now-active 
slider to specify the mid-tone tint picker’s 
effective tonal area, we’re able to adjust 
way in which the tints blend from highlight to 
shadow with more control.

Three split ranges give us four toning zones.  
Here a narrow highlight is toned olive while 
the mid-tones are purplish, transition to a 
neutral shadow.  Again, the gradation bar on 
the right shows us what’s happening along 
the image’s tonal range.



9-15 ImagePrint Black User’s Guide

Correction Tools (cont.)

DCM - Dynamic Contrast Matching

Within the Narrow Gamut section of the 
Combine Correction window are the 
Grayscale DCM controls. This slider allows 
you to turn on/off DCM for your grayscale 
printing as well as adjust the DCM contrast 
applied.

DCM Defined

DCM stands for Dynamic Contrast Matching.  This tech-
nology builds a contrast curve optimized for the paper 
profile you have selected automatically.  The result is 
more dynamic, vivid prints that seem to leap off the page.
Because the contrast curve is optimized to fit your paper’s 
tonality, Matte papers will show the most dramatic effect 
with this feature, especially grayscale printing on matte.  
Prints that used to appear washed out and flat will appear 
much more intense when DCM is applied.

DCM with grayscale printing 

Clicking the DCM checkbox will enable DCM.  You should see an immediate contrast boost 
in your image.  

You can also “dial down” the contrast effect for your grayscale printing via the Contrast Cut/
Boost slider within the Black/White Controls window.  

Moving the slider to the left will darken the image, producing a more low key print.  Pushing 
the control to the right will reduce the overall contrast, producing a higher key print.
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Using Wide Gamut (color) toning

To use Wide Gamut toning, a Color 
Printer profile must be in effect.

In the ImagePrint Dashboard, expand the 
Profile section and either using the Profile 
Valet or the “Choose by Profile” method, 
pick a color profile for the paper you plan 
to use.  For information on selecting pro-
files, see chapter 6 of this manual: Color 
Management.

When a Color Printer profile is in place Wide 
Gamut will be available as an option under 
the menu at the top of the Combined Corrections window.  Choose it to access the Wide Gamut 
Toning controls.

To enable Wide Gamut toning, click the Global tint checkbox.  You can then choose whether to 
split the tone (toning highlight and shadow areas differently) or tone all the tonal areas equally.

Quick Grayscale Conversion

Need a quick way to convert your color 
image to grayscale before printing without 
having to save a separate copy? 
Just enable the Wide Gamut controls and 
leave them at their default setting (with 
the color control at the bottom of the color 
palette).  Any color in your image will be 
rendered as tones of gray.

Splitting the Tone

You can tone the entire image as a 
whole, or “split tone” the image and assign 
a different tone to two distinct tonal areas of 
the image (highlight and shadow).  To enable 
Split toning, click the Split tones checkbox.  With the Split Tones checkbox selected, there will be 
two colored “Tint Picker” areas available.  Without Split Tones in effect, only one Tint Picker will 
be shown.

Correction Tools (cont.)

No Split in effect

Split tones enabled
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Applying a tone

To tone the selected image simply click a 
color within the colored Tint Picker area.  
The image will immediately show the new 
tone.

If Split Tones are in effect, clicking within 
the Left tint picker will affect the highlight 
areas of the image.  The Right tint picker 
will affect the Shadows.

The fields below the 
tint picker show the 
current values of the 
selected color.  You 
can also manually 
enter the H,S,V (hue, 
saturation, value) or 
Red, Green, Blue val-
ues in those fields to 
select a tone.

The density slider 
along the left of the 
tint picker(s) lets you 
pick a more or less 
saturated color.

Determining the Split 

If Split Tones is in effect, the slider along the side of the Wide Gamut Tone controls allows you to 
specify where along the image’s tonal gradation the split between highlight and shadow should 
be considered to occur.  Using this slider, you can fine tune where the toning for each Tint Picker 
occurs.

Correction Tools (cont.)
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Sharpening

ImagePrint’s 16-bit output sharp-
ening allows you to compensate 
for print processing and viewing 
conditions that affect the perceived 
detail of your prints.  Resizing of the 
image on the page, the paper you 
print on, and the anticipated view-
ing distance are examples of factors 
that might cause the need for sharp-
ening beyond that which is done as 
part of your normal workflow.

To enable output sharpening, click the Apply Sharpening 
checkbox.  Then, use the slider controls to adjust both 
the Magnitude and Radius while observing your chang-
es in the right pane of the correction window.

Radius  The Radius slider determines the width of the contrast applied to 			 
“edges” in the image (areas of sharp transition from one hue or tone to another) 

The radius setting has less of an apparent effect than Magnitude (below).  Generally, 
the more fine detail in an image, the smaller the radius should be to avoid “haloing”.  For 
most images, a setting of 3 to 5 works best.

Magnitude  The Magnitude slider controls the degree of contrast that is applied to the 
edge areas.

With too high a magnitude setting you may see harsh, blown-out edges or artifacts 
appear in your image.  For most output it isn’t recommended to go above about .5, but 
make sure to zoom in to various parts of your image within the correction window to 
determine what works best.

Setting default Sharpening  - To set a default sharpening value to be applied to all imag-
es as they are opened, access the ImagePrint Preferences window and enable Default 
Sharpening in the Default Parameters section.

Correction Tools (cont.)
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Saving, Recalling and Resetting Tone, Cast, Histogram Changes

During your color correction work, you may decide to save the changes you have made in order 
to apply them to other images. ImagePrint gives you the option of saving, recalling default or 
previously saved settings for the Tone, Cast and Histogram controls.  Note that the Wide/Narrow 
Gamut controls have separate methods of saving and recalling their settings as outlined in the 
sections describing those controls.

The controls for saving and recalling settings are located within the File Menu within the 
ImagePrint Main Menu.  The following commands are available:

Save Color Correction Data  Choosing this option allows you to 
save your current correction settings. All the settings within the 
gradation, tone & cast, and histogram windows will be saved. 

A dialog box will give you the opportunity to name the settings file 
and choose where it will be stored. These settings can now be 
recalled any time using the Load Color Correction Data menu 
selections (see below).

Load Color Correction Data  This option allows you to recall a 
previously saved correction settings file.  A dialog box will give 
you the opportunity to pick the settings file you previously saved. 
Once loaded, the settings will go into effect for the currently 
selected image only.  (If you wish to apply settings to all images 
as you open them, see Load Default Color Correction Data, 
below.)

Load Default Color Correction Data for this ImagePrint session  This option is only avail-
able when you first launch ImagePrint with no images yet laid out.  Choosing Load Default Color 
Correction Data will allow you to load a previously saved correction settings file and have its set-
tings applied to all images you open for the remainder of your ImagePrint session. 

After choosing this option, a dialog box will give you the opportunity to pick the correction settings 
file. Once loaded, the settings will go into effect for any images opened into ImagePrint until you 
quit ImagePrint.  The next time you launch ImagePrint, your original, default settings will be back 
in effect.  You must choose this option again to reload your correction settings if you wish to con-
tinue using them. 

Correction Tools (cont.)
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Image Properties

For settings that apply to 
individual images, the Image 
Properties window is used.  

Currently, Scale and Position 
controls, Input (source) 
Profiles settings, Step and 
Repeat,Transparency and 
Shadow Point settings are 
found here. 

Image Properties is available 
in the ImagePrint Dashboard.  
If the Dashboard is not visible, 
choose it from the View menu.

Important:  Image Properties settings apply to the currently selected image.  
If no image is selected, the controls will not be functional.
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Size and Position Settings 

ImagePrint provides scaling and 
positioning of your images via click-
ing and dragging with your mouse, 
or, for more precise scaling, via the 
Position,  Scale and Width/Height 
fields in Image Properties. 

All measurements are in the Units currently in effect in the General Section of the 
Preferences window.  

Below are descriptions of the available options.  Make sure to hit the Return key after 
entering new values (not TAB) to ensure they are accepted.

X POS / Y POS  These fields show the X and Y coordinates of the upper-left hand corner 
of your image.  Type in a new number to have your image shift to the specified position.

Width / Height  The Width and Height fields show the current size of the image.  Typing 
in new values and hitting the Enter key will cause the image to immediately grow or shrink 
along the specified X or Y axis.

H Scale/V Scale  The H Scale and V Scale fields are used to specify a scaling percent-
age for the current image in the horizontal (H) and vertical (V) directions.  If Constrain 
Proportions is checked (see below) typing a number in one field will cause the same num-
ber to appear in the other.

Constrain Proportions  Selecting the Constrain Proportions checkbox will force the 
aspect ratio of the current image to remain constant (non-distorted) as you change the 
scale preferences.

Image Properties (continued) 
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Input Profiles

The Input Profiles area of the Image 
Properties section allows you to 
specify image specific color manage-
ment settings for the selected image.  
These settings will override the 
default color management settings 
set in the Preferences window.

The use of these controls are Color Management functions described in Chapter 6 of this 
manual.

Image Properties (continued) 
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Step and Repeat

The Step  and Repeat window 
allows you to specify step (horizon-
tal) and repeat (vertical) preferences 
for the currently selected image.  
(Remember, images can also be 
stepped and repeated with the mouse 
via clicking and dragging with the 
shift-key depressed.)  

Access the Step and Repeat window by choosing Image Properties from the ImagePrint 
Dashboard.

The following controls describe the Step and Repeat settings fields. Make sure to hit the 
Return key after entering new values (not TAB) to ensure they are accepted.

Note: When you step and repeat an image, the entire collection of repeated images 
becomes one region, and all controls used affect the region as a whole. For example, if 

you used the Scale controls to affect the magnification, the entire region is magnified, not 
just the initial image.  Also, crop marks will appear on the corners of the entire group, not 

individual images.

Step  The Step field displays the number of times the image is 
repeated along the X axis (horizontal) of the Layout Area. 

Space  This field, to the right of the Step field, shows the hori-
zontal distance between stepped images.  A value of zero will 
cause the images to have no horizontal offset.

Repeat  The Repeat field displays the number of times the image is 
repeated along the Y axis (vertical) of the Layout Area.  

Space  This field, to the right of the Repeat field, shows the vertical dis-
tance between repeated images.  A value of zero will cause the images to 
have no vertical offset.

Image Properties (continued)
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Settings - Step and Repeat (continued)

Tile, Half-drop and Slide 

The three Mode Functions allow you to change the way in which the images are shift-
ed as they are duplicated via Step and Repeat.

Tile - This mode will cause the images to be stepped 
along the horizontal axis and repeated along the vertical 
axis with no shifting.

Half Drop - This mode will cause images to be shifted 
vertically one half of their height when being stepped

Slide - This mode will cause images to be shifted hori-
zontally one half of their width when being repeated

Image Properties (continued)
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Transparency 

The Transparency section of the 
Image Properties window allows 
you to set the transparency of an 
image.

Access the Transparency window by choosing Image Properties from the 
Dashboard.

By default, images are fully opaque, meaning they have no transparency.  Slide 
the Transparency slider to the left to increase transparency, allowing elements 
beneath the selected image to become visible. 

To put images above/below each other, right- or control- click the 
image and choose Bring to Top or Push to Bottom. 

Shadow Point 

The Shadow Point Slider con-
trol within the Image Properties 
section of the dashboard gives 
access to a slider which lets you 
adjust the Shadow Point setting 
for the currently selected image.  

The Shadow Point is a Color 
Management function described in Chapter 6 of this manual.

Image Properties (continued)
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What are Borders?
With ImagePrint’s Borders feature, you 
can add any type of border to your 
images.   

Any Photoshop format (psd) file with 
a transparency layer can be used as 
a border—simply place the border 
image in the Borders folder to install it. 
On Macs, the Borders folder is found 
within the ImagePrint folder in your 
Applications folder. On Windows, it’s in 
the ImagePrint Data folder -- you can get there by choosing “ImagePrint Data folder” from 
the ColorByte Software group in your Windows Start menu.

You can create your own borders, or purchase them.  Its easy to find vendors who specialize 
in borders such as artistic edges, greeting cards and sports cards. As long as the border is a 
flattened Photoshop file with a transparency layer, it can be used.

Borders are chosen via the Border Browser.

The Border Browser

Choose Border Browser from the View menu to launch the 
ImagePrint Border Browser.  
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Borders (Cont.)

Applying Borders

Simply drag any of the displayed bor-
ders in the Border Browser on top of 
any image in the layout area to apply it 
to an image.  

Border Sizes

When you apply a border to an 
image, the image will be resized 
to fit the size of the border.  For 
example, dragging a 4x5 border 
to a 8x10 image will resize the 
bordered image to 4x5 in the lay-
out window. 

Once a border is applied to an image, you can alter the size of the bordered image via 
the Scale settings, or dragging its edge, just like any other image.  (Using the side of the 
border, not the image, is necessary to prevent distortion of the border when applied to an 
image with a different aspect ratio than the border’s.)
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Borders (Cont.)

Cropping and Zooming borders

ImagePrint’s Smart Crop feature will let you zoom and crop the 
image for a best fit.  The normal Smart Crop tools apply, with the 
addition of a Zoom mode that lets you grow or shrink the image 
into the border.  

As always, double-click the image 
to activate Smart Crop. The Smart 
Crop window will appear.

Drag the image in the Smart Crop 
window to adjust its position.

To grow the image within the 
border, hold the COMMAND key 

(Macintosh) or the CONTROL Key 
(PC) down while dragging it.

By moving and zooming the image within the border, 
it’s easy to perfectly size and position the image.
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Borders (Cont.)

Borders and Templates

When you drag a border to a template, 
it will be applied to all images with the 
frames group that match the aspect 
ratio of the border.  

Important: Borders can only be 
applied to frames that match the 
border’s aspect ratio. This is neces-
sary because template frames have 
fixed aspect ratios--it would be 
impossible to force a border into a 
different aspect ratio without distort-
ing it.



Templates
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What are Templates?

Templates is an optional add-on with ImagePrint R.E.D. 

Please contact ColorByte if you wish to purchase the 
Templates feature.

ImagePrint’s templates are packages of images, sized 
and arranged according to your specifications.  Using 
Templates, you can create professional packages that 
mix wallet sized images, 4x5s, 8x10s, or any custom 
size you specify.  

When an image is assigned to a template, it is 
automatically sized to fit each frame within, and 
rotated to best fit each frame’s aspect ratio.  You 
can create templates that fill the page, or print 
multiple templates on one page.

Images within templates can be easily cropped, 
and borders can be applied via the Border 
Browser.

► Linked Templates:   

Linked Templates are groups of standard 
ImagePrint templates that can be added to your 
pages at once, allowing you to mix and match 
your templates into packages to be printed across 
one or more pages. 

For instance, you might have a template composed of a single 8x10, another tem-
plate composed of 20 wallet-sized images, and another with only 4x5s.  With Linked 
Templates, you can create a template group called  “8x10 and wallets” that includes 
both the 8x10 and wallet templates, and another called “8x10, wallets and 4x5s” that 
contain all three.  Based on customer orders, choose the linked template and drop imag-
es on it to fill all the templates within the group for easy mixed package creation.     

Hint: Templates may be one of those features that is easiest to understand when seen 
in action.  You may therefore want to view the online training movie that demonstrates 

Templates in use before reading through this chapter.  
 

ImagePrint training movies are available on the ImagePrint web site: 
  www.colorbytesoftware.com.

www.colorbytesoftware.com
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Templates  (Cont.)

Templates are created with the controls in the Template Editor window and then 
applied to images by choosing Templates from the Layout Styles menu, and picking 
the template you want to use.

We’ll start by describing the controls available in the Template Editor window for 
viewing, creating and editing templates. Then we’ll describe choosing the active 
template, and applying your images to it.

To access the Template Control window, choose Edit from the ImagePrint main 
menu, then choose Templates...  

The Templates Editor window will appear.

Here, you can choose among pre-saved templates in the Templates menu along the 
top of the window, or create your own custom template.

A template is composed of frames of various colors within a single rectangle which 
represents the template’s bounding box.  In the Template editor window, the tem-
plate is shown as a gray patterned area.
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Viewing Templates

ImagePrint comes with a list of 
predefined templates to get you 
started.  These templates can 
be seen on the left side of the 
Template window.  

Any templates listed in this area 
will be available to use with your 
images.  

Below this list of saved 
Templates, you’ll see a section 
with two clickable tabs--one for 
Templates, and one for Frames.  
Click the Templates tab. You’ll 
see that the currently chosen template’s name will appear in the Template Name field 
here, and its width and height will be shown in the Width and Height fields.  Notice 
that as you choose each template, the frames and blue template bounding box that 
compose the selected template are displayed in the template design area on the left 
side of the window.

Creating New Templates

The template window also gives you the ability to create custom template designs.  
These templates can be saved into the template list, allowing you to create a set of 
unique packages.

To create a new template design, click the New Template but-
ton under the Template Tab.  The template design area  within 
the ImagePrint layout window will change to reveal only an 

empty template at the default size (the default template size is always the printable 
area of the current page.
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The first thing to do when creating a new template is to give 
it a name.  By default, new templates start out with the name 
“User Defined”, which can be seen in the Template Name 
field at the top of the Template window.  To give your new 
template a name, just type it into this field in place of the 
default name.

The next step is to specify 
the bounding box size of 
the new template.  At first, 
this size will be that of the 
current page, as shown by 
the gray area within the Template design area to the 
left.  Specify a new size by entering the numbers in 
the Template Width and Template Height fields of the 
Template window.

Adding a template background or artistic 
frame

You can also choose to add a background 
image, solid background, or frame with 
matte, to a template. The image will fill the 
template boundary area, with your image 
frames displayed within. 

Click the Add Background button and 
you will be presented with the normal Add 
Background window as described in the 
Backgrounds, Frames and Gallery Wrap 
chapter of this manual.  To remove a back-
ground from a template, click the Remove 
Background button.
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Frames

Adding a Frame
Now that we’ve named and defined the size of 
the template, it’s time to add frames.  To access 
the Frames controls, click the Frames tab.  

Remember, frames are the rectangles that rep-
resent where individual images will reside on the 
template. To add a frame, you must first specify 
its width and height. Specifying a frame’s width 
and height can be done in two ways.  

•	 Common frame sizes can be chosen 
by clicking on the Size drop down 
menu and choosing one of the listed 
sizes.  

•	 You can also create custom frame 
sizes by typing in values within the 
Width and Height fields below the 
Frame Size drop down menu. 

Once you have specified the width and height of the frame, click the Add button to 
have the frame immediately added within the Template design area of the ImagePrint 
layout window.

Each time you click add, a new frame will be added, using the current width and 
height settings.  Each new frame will be automatically positioned into the first avail-
able free spot within the template.  The distance the frame will be from the previous 
frame is determined the Gutter settings. We’ll talk a little more about gutters below.
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Adding Frames (cont.)

Adding a frame background or artistic border

Just like with the template as a whole, individual frames within the 
template can have their own backgrounds or artistic frames (how-
ever, in the case of frames, Image backgrounds are not allowed).  
Just click the Add Background... button to access the normal Add 

Background window.  For more information on the Add Background window, 
see the Backgrounds, Frames and Gallery Wrap chapter later in this manual.  
Choose Remove Background... to remove a frame’s background or artistic 
frame.

Gutters  The X and Y Gutters specify how much 
space to put between frames when automatically 
adding.  For instance, an X gutter of 2 inches will 
cause frames to be positioned 2 inches apart hori-
zontally.

Positioning Frames

You can manually adjust the frame positioning after 
adding it by clicking the frame within the Template 
design area and moving it.  You can also use the X / Y 
position fields to specify numeric position values rela-
tive to the edge of the template.  

  

Deleting Frames 

To delete a frame, click on it and choose the Remove Frame button.
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Grouping Frames

A powerful feature of templates is the ability 
to group frames. By default, every frame in a 
template will contain one image, but you can 
set up groups to cause the same image to be 
copied to several frames at once. 

Grouped frames will automatically be filled 
with the same image when you drag the 
image to any frame in the group.  Also, any 
cropping, or borders applied, will be applied to 
all frames within the group.  

The Group section of the Template Control 
window has the controls necessary to specify 
how your frames will be grouped.

Creating and Assigning Frame Groups

Frame groups are assigned via the Group menu within the Group section of the 
Template Control window. 

Use this drop-down menu to choose what group 
the next added frame will be a part of.  At first, 
there will be only two default groups, Group 0 and 
Group 1.  You can click the Add Group button to 
add to this list of groups as needed. Click Add 
Group once to create a Group 2, click it again to 
create a Group 3, etc. 

You can pick any created groups in the Group drop down above the Add Group but-
ton.  Once you select a group, all frames you add will be a part of that group until you 
specify a different group.

If you want to later assign a frame to a different group, just click the frame in 
Template Design area and pick a group from the drop down menu.
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Assigning Frame Groups (Cont.)

As you assign groups, each one will have a unique color assigned to it.  This 
group color is shown to the right of the Group drop down menu.  As new frames 
are created, they will be displayed with this color in the Template Design area. 
You can override the default color for the current group by clicking the Group 
color button.

Global Group Settings

The Group menu has two other choices besides its 
list of groups.  These two choices override the stan-
dard group assignments, and are used when you 
don’t want to manually choose your frame group-
ings:

Same image for all Frames  This option will cause every frame to be part 
of the same group within the template.  Any image applied to this template 
will be applied to all the frames within it.

Unique images for all frames  This option will cause every frame added 
to be in a unique group of its own.  Images applied to this template will only 
use a single frame.

Saving Templates

Once you have added and positioned the frames 
for you template just the way you want, you need to 
save it.  Choose the Template Tab at the top of the 
Templates window, then click the Save button.  

Your new template will be saved, and its name 
added to the template list on the left side of the 
Template window.  



12-10 ImagePrint User’s Guide

Templates  (Cont.)

Deleting Templates

To delete a template, choose the Delete button on 
the right side of the template Window.

Editing a Template

Sometimes you may wish to edit an existing template rather than create a new 
one.  To do this, simply choose the template from the template list on the left side 
of the Template Editor window, then add new frames, and/or move, resize and 
delete existing frames as needed, using the tools within the Template Control win-
dow.  

Once done, click Save to save over the old template, or type in a new name for 
the template within the Template Name field and click Save to have it saved as a 
new template.
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Linked Templates

The Linked Template feature provides the ability to 
organize your already created templates into groups 
that can utilize the same images.  This allows you to 
create custom sets of packages that can span mul-
tiple pages.

To create a Linked Template, make sure you’ve 
already created two or more templates using the 
methods previously outline, then click the Links tab 
in the Edit Templates window.

Choose a template from the list of templates shown 
at the top of the window and drag it to the gray 
area to include them in your linked template.  You 
can drag any number of templates, and re-drag the 
same template to include them multiple times in 
your linked set.  To remove a template, simply drag 
it out of the window.  

Once done specifying which templates to include 
(and their order) type in a name for the linked set of 
templates, and click SAVE.  You’ll see your linked 
set added to the list at the bottom of the window. 

Once created, you can use your linked template 
much like you do individual templates, via the 
Layout Mode menu described in the next few pages. 
Choosing a linked template will cause all the tem-
plates within the set to appear on your layout, with 
ImagePrint automatically creating new pages to fit them if needed.  Dragging images into 
any of the frames within any of the linked templates will fill frames with the same group 
across all templates.
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Assigning Templates to images

Now that you are familiar with the mechanics of creating templates, it’s time to apply imag-
es to them.

To use templates, the current 
Layout Style must be set to 
Template.  You change the Layout 
Style in the Advanced section of 
the ImagePrint Dashboard. 

If the dashboard isn’t visible, 
choose it from the View menu.

Close the Template Editor window 
if you are done creating your tem-
plates, and choose Template as 
the Layout style in the Dashboard.

With Template as the 
Layout Type, the Layout 
Schemes menu (to the 
right of the Layout Type 
menu) will display all of 
your saved Templates.

Now choose one of the templates to see it displayed 
in the Pages window.

If you pick a linked template, all the templates that are 
part of that group will be displayed.

As is

Rotate to Fit

Fit to Size

Template

Package1

Wallets and 
4x5x

8x10 Set

Kids pack

Wedding1

Wedding2

Wedding3
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Assigning Templates to images (cont.)

Once you have chosen a template, you’re 
ready to assign images to it.

Open an image (or group of images) in the 
normal way via the Image Strip, the File-
Open command, or by dragging the image 
from a folder into the ImagePrint interface. 
The image will fill frames within the tem-
plate.  If your template is grouped, then all 
the frames of a group will be filled with the 
image.

If you drag your image from the 
Image Strip (instead of using  
File->Open, or double-clicking it 
in the image strip) you can spec-
ify which frame the image will be 
assigned to. 

Notice how, as you drag the image 
over a frame, the frame (and any 
other frames in its group) change 
color to indicate they will receive the 
image.

If you’ve picked a Linked Template, 
then dragging an image to any 
frame will cause that image to fill the 
frames in all the templates within 
that linked set that correspond to 
the same frame group.
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Assigning Templates to images 
(continued)

Once a template is filled with 
images, a new template will be 
added to the page if there is 
room.

Note: If AutoFlow is in effect, 
and there’s no room on the 
page for a new template to be 
created, a new page will be 
added with a blank template 
on it, ready for more images. 
This can be a powerful method 
of creating multiple template pages by dragging multiple images into the layout window-
-page after page of templates will be automatically created.

Scaling and Positioning Templates

When the Layout Type setting is Template, you will not be 
able to adjust the position of your template on the page or 
resize it.  However, if you switch the Layout Style in the 
Dashboard->Advanced to one of the non-Template modes 
(As is, Best Fit, or Fit to Size) then the templates will be 
treated like any other image.  You can scale, move and 
rotate the template as if it were one single image.

As is

Rotate to Fit

Fit to Size

Template
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Cropping Templates

Frames within a Template can be 
cropped like any other image.  Simply 
double-click the image to have it appear 
in the Smart Crop menu.

Any crop you apply to the image will 
be applied to any other frames within 
that template that are part of the current 
frame’s group and which have the same 
aspect ratio as the current frame. 

When cropping template frames, you can zoom the image 
in or out, allowing you to adjust the size of the image that 
appears in the frame.

To zoom in or out:

On the Mac, hold down the Command key while dragging 
the mouse within the Smart Crop window.

On the PC, hold down the Control key while dragging the 
mouse within the Smart crop window. 

Note that when cropping a template frame, your crop area will always be constrained 
to the aspect ratio of the frame.  You can zoom the crop, or position it, but you can’t 

change its shape.
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Borders and Templates

When you drag a border from the border browser to a template, it will be applied to all 
images with the frame’s group that match the aspect ratio of the border.  

Important: Borders can only be applied to frames that match the border’s aspect ratio. 
This is necessary because template frames have fixed aspect ratios--it would be impos-
sible to force a border into a different aspect ratio without distorting it.

Once applied to a frame, the 
border can be adjusted via 
Smart Crop by double-
clicking the frame, and 
adjusting the crop.

Don’t forget, you can 
Zoom the image in or out 
of the border within the 
Smart Crop window: 

On the PC, hold down 
the Control key while 
dragging the image in 
the smart crop window 
to Zoom it.

On the Mac, hold down 
the Command key 
and drag to zoom the 
image.

For more information on using Borders, see chapter 10, Borders.
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Backgrounds, Frames and Gallery Wrap

With ImagePrint, it’s easy to customize your layouts with colored background or 
frames.  And the new gallery wrap feature lets you automatically mirror and flip 
the edges of images for easy frameless mounting of canvas prints.

The Add Background window

All the controls to create backgrounds, frames and gallery wraps are in the Add 
Background window.  This window is accessed via the Mouse Menu or the Edit 
Menu at the top of the ImagePrint main window.  

On PCs, you can right click an image or group of images to see the Mouse 
Menu. (Left click with control pressed to select multiple images).

On Macs, if you don’t have a right mouse button, access the Mouse menu 
by holding the Control key and clicking on an image or group of images (to 
select multiple images, hold the Command key down and click each image 
to be added to the group). 

In either the Mouse menu, or the Edit menu, choose “Add Background” to see 
the available options (Frame, Solid, Image and Gallery Wrap).  Choosing any of 
these will open the Add Background window, with the chosen option selected.

The Add Background window 

Here, you can choose to add a Frame and 
Matte, a Solid Background, a Background 
Image, or a Gallery Wrap to the selected 
image.  

Each of these options has its own set of con-
trols that will be available when that option 
is chosen. (Remember--the Background and 
Frames window is also available when creat-
ing or editing a template, allowing you custom-
ize your templates with background graphics 
and frames.)  
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Adding a frame to an image

A frame is a rectangular border of a speci-
fied thickness and color which can be set at a 
specified distance from the edge of the area 
being framed.  The area between the frame, 
and the image, is the matte.  The matte can 
be colored as well, for “double-frame” effects. 

To create a frame for your image, click 
the Frame button at the top of the Add 
Background window.  The following controls 
will be available:

Distance from Image Edge

This is the distance the frame will extend from 
the edge of the image(s) being framed.  It can 
be symmetrical; meaning equal distance from 
each edge of the framed area, or you can 
choose different distances for the top, bottom, 
right and left edges. 

Color

Here you can choose the color of the frame by clicking the color button and choosing via the 
Color Chooser that will appear.  An eyedropper has also been provided--select this icon, then 
click anywhere on the screen to choose a color.  The eyedropper is a great way to pick a 
frame color using a color from within the image itself.

Frame Thickness 

The frame thickness is specified via the Thickness field. Note that this value does not include 
the thickness of the matte (see matte, below).  The difference between the Frame Thickness 
and the Distance from Image Edge will be filled by the Matte color.

Matte Color 

To alter the Matte color, click the Matte Color button in the Frame area, or use the eye drop-
per beside it to choose a color from any image in your layout.  (Hint: Try choosing Transparent 
as the Matte color--this allows for very interesting effects when you place the image on top of 
another one.)
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Transparency 

The transparency slider allows you to change the transparency of the frame, allowing you to 
see the current matte color through the frame.  In most instances this is not desirable, but...
if the Matte color is set to transparent, then instead of the matte color being revealed, you 
will see underlying objects through the frame, which can lead to some great effects.

Creating an artistic frame:  An example 

For the below image, Frame was selected in the Add 
Background window, then a .600 Distance from Image 

Edge value was chosen.  

Next, for the Frame itself black 
was chosen, but for the Matte 
color, the Matte Color eyedrop-
per was used to select a bit of 
color from the image.  Finally, 
a Frame thickness of .3 was 
chosen--this means that the 
Matte color will fill the .3 differ-
ence between the .6 Distance 
from the image edge, and the 
.3 thickness of the black frame.

Frame

Matte
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Adding a Solid Background

A solid background is an area of single solid color sur-
rounding an image or group of images.  It is similar to 
a frame, but has no control for specifying thickness or 
matte, since it always fills the area between its edge 
and the image(s).

To specify a solid background for your image(s), click 
the Solid button at the top of the Add Background win-
dow.  The following controls will be available:

Distance from Image Edge

This is the distance the background will extend from 
the edge of the image(s) being affected.  It can be sym-
metrical; meaning equal distance from each edge of the 
framed area, or you can choose different distances for 
the top, bottom, right and left edges. 

Color

Here you can choose the color of the background by clicking the color button and choosing via 
the Color Chooser that will appear.  An eyedropper has also been provided--select this icon, 
then click anywhere on the screen to choose a color.  The eyedropper is a great way to pick a 
background color using a color from within the image itself.

Transparency 

The transparency slider allows you to change the transparency of the background, allowing you 
to see underlying items through the background.

This image has a solid black 
background with non-symmet-
rical distances of Top, Left and 

Bottom .3, and Right 4.0.

(The text was later added via 
the Add Text menu).
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Adding an Image Background

You can choose to have an image appear as 
a background to an image or group of imag-
es.  This background image can be automati-
cally cropped to fit the area, or left in its original 
aspect ratio.  Click Image at the top of the Add 
Background window to access the following con-
trols:

Distance from Image Edge

This is the distance the background will extend from 
the edge of the image(s) being affected.  It can be 
symmetrical; meaning equal distance from each edge of the framed area, or you can choose 
different distances for the top, bottom, right and left edges. 

Choosing an Image

You can choose any tiff, JPEG, or psd file as the background by clicking the Image button in 
the lower section of the Add Background window, then locating it via the standard file dialog 
that appears.

Crop

The crop controls how the image will “fit” in the area you defined via the Distance from Image 
Edge fields.

- Selecting “Crop and Zoom” from the Crop menu will cause the chosen image to auto-
matically crop to the exact size specified in the Distance fields.  You may not see the 
entire image if the aspect ratio differs from the Distance values you specified. 

- Choosing “Accommodate without Crop” will cause the image to grow as large as pos-
sible within the Extent boundaries without cropping or distorting the image.  This option 
may result in the background image not fully covering the specified area, but all of the 
background image will be placed.    

Transparency 

The transparency slider allows you to change the transparency of the background image, 
allowing you to see underlying items through it. This can make for some nice watermark 
effects.

An example of an image with a 
background image applied with 

slight transparency.

The text was later added via the 
Add Text menu.
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Creating a Gallery Wrap
A gallery wrap is a method of extending the edges of a print for frameless mounting in such a way 
as to present no harsh transitions while preserving the entire image without cropping.

With ImagePrint’s gallery wrap feature, a portion of the 
edges of the image will be duplicated and mirrored, allow-
ing each edge to seamlessly wrap around the sides of the 
mounting bar.  Note that gallery wrap can only be applied to 
a single image--not to a group of images.

To create a Gallery Wrap, choose Gallery Wrap at the top of the Add Background window.  You 
will have access to the following control:

Distance from Image Edge

This is the only control available for Gallery Wrap. Choose the distance from the edge of the 
image that should be duplicated and mirrored.  This distance should reflect the thickness of the 
mounting bar you plan to use for mounting the print.

If the original image was close to the edge of the page, you may need to move it to ensure the 
newly added edges are within the printable area of the page

A rather exaggerated example of a 
Gallery Wrap. The original image is 
extended and mirrored at the edges, 

allowing for a smooth edge when wrap 
mounting without a frame.
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Removing image background settings

To remove any Frame, Background, or Gallery Wrap, Control-Click or Right-Click the 
image(s) and choose Remove Background from the menu that appears.

Editing background settings 

To change the Frame, Background, or Gallery Wrap settings, Control-Click (Mac) or 
Right-click (PC) the image(s) and choose “Edit Background”.  

The Add Background window will appear, allowing you to make changes to its cur-
rent parameters using the controls discussed throughout this chapter. 
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What are Boundary Areas?

A Boundary is an area of the page treated as a sub-page.  Images within a boundary will act 
as if grouped--moving the boundary will cause all the images and text elements in it to move 
as well, while each element, if clicked on, can be moved separately.

But boundaries are more than just a grouping mechanism.  Crop marks will be applied to the 
boundary, not the images within it, allowing you to easily segment your pages into sub-pages 
for cutting.  Annotations for each image will also automatically appear beneath boundary, mak-
ing it easy to keep track of what images are included within each sub-page without having 
them actually print.

In addition to their use in defining sub-pages, boundaries have another usage: an artistic one.  
Boundaries are essentially an extra background because, while you can choose to have the 
boundary transparent, you can also fill it with color.  When used with Image Backgrounds and 
Frames, boundaries can provide yet another layer of graphical possibilities in your layouts.

Boundaries can be defined based on images that have been already laid out--you will then be 
able to specify a boundary that “fits” the selected image--it’s much easier to create a bound-
ary with a centered image within it this way.  You can also create a boundary without selecting 
images for it to encompass and later drag images on to it.  Boundary Areas are created via the 
Add Boundary Area window. 

The Add Boundary Area window

The Add Boundary Area window is accessed via the Mouse Menu, or the Edit Menu at the top 
of the ImagePrint main menu.  

- On PCs, you can right click an on an empty area of the layout window, or on an image 
or group of images to see the Mouse Menu. (Left click with control pressed to select 
multiple images).

- On Macs, if you don’t have a right mouse button, access the Mouse Menu by holding 
the Control key and clicking on an image or group of images or an empty area of the lay-
out area. (To select multiple images, hold the Command key down and click each image 
to be added to the group). 

In the Mouse Menu or the Edit Menu, choose “Add Boundary Area” to access the Add 
Boundary Area window.
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The Add Boundary Area window

This window provides controls for specify-
ing the size and fill of the boundary area.  
The available selections are:

Transparent / Solid

If you want to use the boundary as a 
means of grouping, or as a means of 
defining a croppable “sub-page”, without 
it being part of the graphical elements on 
the page, click Transparent at the top of 
the screen.  A transparent boundary will 
be shown on screen with cross hatched 
lines, but will not print.

Choose Solid if you want to specify a 
color for the boundary.

Boundary Dimensions

This is where you specify how big the boundary will be.  You can do it two ways--either as an 
absolute width/height value, or base the size on the images it is bounding.

- Click “Define by Size” to specify an absolute boundary size, then put the values in the 
Width Height fields. This option is usually desired if you are creating a “sub-page”, like 
an album page, that needs to be cut at a specific size regardless of the image(s) within 
it. 

- Click “Define from Image Edge” if you want the boundary to be defined by the 
image(s) it encompasses.  (This option is only available if you accessed the Add 
Boundary Area window by clicking on an image or group of images, not an empty area).  
This can be useful if you are using the boundary as a colored background or frame and 
are more concerned about the size of the margin than the size of the boundary itself.

Solid Fill Parameters

If you chose “Solid’ instead of transparent for your boundary, this is where you can choose 
its color.  Click the Color Button and choose via the Color Chooser window that will appear.  
An eyedropper has also been provided--select that icon, then click anywhere on the screen 
to choose a color.  (The eyedropper is a great way to pick a boundary color using color from 
within one of the images on the page).
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Using Boundaries

Here’s some important points to keep in mind when using boundary areas:

	 •	 Adding images to boundaries is like grouping them--clicking the boundary and mov-
ing it will cause all images in it to move together with it, preserving their relative 
locations.

	 •	 Clicking an individual image within a boundary will cause just that image to move.

	 •	 Moving an image partially out of the boundary will remove it from the boundary 
group.

	 •	 Images within boundary areas will not have individual crop marks and their annota-
tions will appear at the bottom of the boundary.

This image has crop marks 
and an annotation (caption).

When dragged onto 
a boundary area, 

the crop marks are 
removed, and the 

annotation is added 
to the bottom of the 

boundary. 



Printing and Print 
Setup

15



15-2 ImagePrint Black User’s Guide

Printing the layout

Choosing Print from the 
top of the ImagePrint 
Dashboard or from the 
File menu will cause the current 
layout to be sent to the printer 
immediately.  Unlike previous 
versions of the software, there is 
no print dialog.  Once Print is selected the print is sent-- you are then free to close ImagePrint 
or begin a new layout--printing takes place in the background.  To check the Print Status, the 
ImagePrint Spooler utility, Spoolface, is used.  Spoolface is described in the next chapter. 

Specifying the print job name

You can specify the job name which will be shown in spoolface in the Job Name field at the top 
of the Dashboard.  By default the job name will be the first image opened in the layout.  With 
ImagePrint 9 the Print dialog has been replaced by the Print Setup area of the Dashboard.  
This is where most options previously found in the Print dialog can be set.

Print Setup

To check or adjust settings printer 
options such as quality, speed, number 
of copies and ink limiting, expand the 
PRINT SETUP section of the ImagePrint 
Dashboards ADVANCED area.

Most settings can be left at their 
default state.  In fact, for most 
users, only the Paper Tray, AutoCut 
and Inked Area selections are ever 
changed.

The following pages give descriptions of the PRINT SETUP options.



15-3 ImagePrint Black User’s Guide

Print Pages (range):

If your layout area currently has multiple pages, the 
Print Pages section allows you to choose to print all 
of the pages, or just certain ones.  

   • 	If  you wish to print all the pages in your layout, choose All.

   • 	To specify individual pages, separate the entries with commas (1, 3 would cause 
page 1 and 3 to print, but not page 2).

   • 	To specify a range of pages, separate the entries with a dash (1-3 would cause 
page 1 through 3 to print).

Quality/Speed:

The quality (speed for some printers) field is where the quality settings can be specified.  
Quality can consist of 3 elements: The Droplet Size, the High Speed mode, and the Passes.

Droplet Size (1440, Photo, etc.)

The droplet size refers to the size of the ink droplets that will compose the output.  Most 
printers have multiple droplet sizes available. Unlike the other Quality options, droplet 
size can affect the color reproduction of the print--that is why each Printer/Paper 
profile is created for a specific droplet size (1440, 2880, photo, etc.).  Only valid drop-
let-sizes for the currently selected profile will be shown in Quality menu.

Droplet-size designation: Different printers designate the droplet sizes different ways-
-many use the droplets-per-square inch value (typically 720, 1440 or 2880).  Most 
newer printers, however, use the terms Fine (for 720), Photo (for 1440) and Best (for 
2880).

Most ImagePrint profiles are done for 1440 (Photo) droplet sizes so often only 1440 
Quality settings will be listed.  This is because this mode typically has the advantage of 
variable size--the size of the ink droplets can vary throughout the print.  While smaller 
in size, the 2880 (Best) mode is a fixed droplet size which reduces some of the advan-
tage a variable droplet can add in producing a smooth screen (dither) pattern.  For 
most papers (excluding very high gloss papers) most users find no benefit in using the 
finer, fixed droplet sizes and prefer the significantly faster 1440 variable droplets. This is 
especially true on papers with a high dot spread such as rag and other matte papers.

Print Setup (continued)
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HS - High Speed 

Some printers offer an HS mode for some of their available quality settings.  HS 
stands for High Speed, and refers to a printers ability to print image data in both 
directions of print head movement (bi-directional).  HS modes, as the name implies, 
are faster due to this bi-directional printing and are typically fine to use. In the end, 
the droplets end up in the exact same place on the print and the same amount of ink 
is used.

However if you notice banding or mottled areas on your print when using HS mode, it 
may be due to the ink not having enough time to “soak in” to the coating of the paper.  
In that case, try printing in standard (non-HS) mode to see if it eliminates the problem.

Passes 

Modern inkjet printers pass the print head over the same area of the paper multiple 
times as they print, firing different nozzles with each pass. By “interlacing” the  print-
ing in this way ink droplets are less prone to coalesce on the surface of the media 
resulting in less chance of ink spotting or ink related banding.  

The default number of passes is 4, but many printers can also use an 8-pass mode. 
(Compared to 4-pass mode, the print head takes twice as many passes to fill in the 
same amount of the print while spraying half the ink droplets with each pass.   

Printing in 8-pass mode is seldom necessary.  It does not improve detail or save ink-
-the final ink droplet placement and ink usage will be the same as in 4 pass mode (it 
will just take twice as long to get there).  

However for some papers (or problematic printers), the longer print time and 
increased droplet distance can solve issues related to ink not soaking into the paper 
quickly enough, causing them to combine with other nearby droplets to form mottling 
or banding.

 

Print Setup (Continued)
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Copies

This field allows you to specify how many copies of each page in your layout will be output.

Ink Limit

The ink limit control lets you adjust the percentage of ink placed on the page.  The default 
value is 100 percent, and you can not go above this value.  However, lower values can 
be set which will result in a reduction of the total ink laid down.  While typically this control 
should be left at its default 100 percent value, in rare cases a paper may show over inking 
effects (such as warping) and reducing the inks may help.  Be cautious, as reducing the 
inks will often result in the image appearing washed out.   

Dithering DPI

This menu displays the current dots per inch resolution setting that ImagePrint will use 
when rendering its layouts. 

Note that this is NOT the ink droplet size setting of the printer--that setting is deter-
mined by the Quality field (see below). 

In most cases, this setting should be left at its default setting, although if printing extremely 
large images (banners) you may find that lowering the Dithering DPI can speed up process-
ing of your jobs.

Ink Set

The Ink field shows the currently selected ink set.  If using a Printer Profile made by 
ColorByte Software, the correct ink set will be chosen automatically when you select your 
printer profile in the PROFILES area of the Dashboard and cannot be changed.

If using a non-ColorByte generated profile, you will be able to change the inkset.  For a list 
of inkset names and what they mean, check the Printer Specific section of the Appendix at 
the back of this manual for your particular printer model.

Print Setup (continued)

Quality (cont)
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Print to File

Choosing Print to File will cause 
ImagePrint to create a color man-
aged TIFF file of the layout, rather 
than sending the job to print.  

This job will pass through spoolface as normal, but instead of going to the 
printer, will be written as a file in the folder specified in the OUTPUT FOLDER 
field.  The file will use the name of the current job, which by default is the 
name of the first image added to the layout, but can be changed in the Print 
Dialog.  

To specify the folder where the image should be created, click the Browse but-
ton and choose a folder via the standard file selection dialog box that appears.

Note that the TIFF file will be created in the color space of the currently select-
ed Printer/Paper profile.  

It is usually recommended to choose a valid source profile, like Adobe 1998, in 
that field prior to using this option.  

Print Setup (continued)
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The Options Dialog

Click the Options button within the Print Setup section of the Dashboard to access the 
Options window for your printer.  

The Options window allows you to pick Printer Specific options related to Media prior to print-
ing. After selecting your options, choose OK to put them in effect.  They will be remembered 
for the currently selected printer until changed.

Media Type

If using the Profile Valet and a ColorByte gen-
erated Printer profile, the Media Type will be 
automatically selected based on the paper 
characteristics.  So, if using the Profile Valet, 
unless you experience media related issues 
(such as paper jams or feed-related banding) it 
is not recommended you change this setting. If 
you change it, the next time you pick a profile 
in the Profile Valet, it will change back to the 
default setting (see TIP below).

Tip: However--if you want to permanently override 
the Media Type setting chosen by the Profile Valet 
for a profile, just create a Profile Favorite via the 
Add  Favorite button in the Valet.  The Favorite 
you create will use the Media Type you specify.

The Printer Options window allows you to specify the Media Type of the currently loaded 
paper. This setting gives access to preset Paper Thickness configurations for certain print-
ers.  These settings come from the printer itself, and control certain features related to paper 
feeding. The Media Type setting does NOT set the printer for Roll or Sheet.  You must 
still select the proper setting via the Media Feed section of the Dashboard.

Note, since this list will only include papers manufactured by the maker of your printer, you 
may not see your paper listed.  In that case, just pick one that is close in thickness to the 
type of paper you are using.

Important: Some Media Type settings may restrict certain printer features if the paper 
selected is not supported for that feature by the printer.  For example, choosing a paper with 
Sheet in the title may cause the printer’s paper cutter to be disabled.  Or, if a paper that is 

not supported for the paper tray is selected, the printer may show an error if the paper tray is 
used.

Print Setup (cont)
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Printing (cont.)

Media Feed Adjustment

Many printers also allow for custom adjust-
ments to the paper feed controls in addition 
to the Media Type selection.  This is an 
advanced feature, and should only be used 
for those willing to experiment to achieve 
the best results, or who are trying to solve a 
specific problem with banding or paper feed 
issues.  In most cases, it is unnecessary 
to adjust this control.

To use the custom setting feature, simply 
adjust the Media Feed Adjustment slider.  
Note that this setting is take directly from 
the printer, and not created by ColorByte. ColorByte software does not receive information on 
specific Media Feed settings--those come from the printer manufacturer.

Cut Method

Some printers allow different cutting methods 
when Roll paper is used with the Auto Cut 
option in effect.

Choices in this menu may vary, but common options are:

Normal   This option will be used when in non-borderless mode.  A single cut is made 
between prints, with a slight (typically 1/8 inch) border on each print.

1-Cut      This option is only allowed during Borderless printing.  A single cut will be made 
between prints with no border remaining and no waste between prints.  The cut will 
not be made until the trailing edge of the print reaches the cutter, which means a 
print may wait until a 2nd print has started before being cut.  If a 2nd print does not 
come after a short duration (typically one or two minutes) the printer may proceed 
with the cutting in 2-cut mode (see below), with a resultant waste of a few inches 
of paper.

2-Cut      This option is only allowed during Borderless printing.  Two cuts are made between 
prints, with no border remaining.  A waste strip of paper (typically 3 or 4 inches) will 
result in this mode between every print.



The ImagePrint 
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SpoolFace - The ImagePrint Spooler
The ImagePrint Spooler is one of the most powerful features of ImagePrint software.  
With its graphical interface, print jobs can be rearranged and prioritized, sent to dif-
ferent printers or moved from one computer to another.  It is also possible to directly 
edit the parameters of a print job, allowing you to change elements such as the num-
ber of copies, DPI, ink set or drum speed--without having to rebuild the layout. With 
SpoolFace, you can view thumbnails of your jobs, and save previously printed jobs 
(including all images and profiles used) into archive files for future printing.

To launch the spooler, click the Spooler button at the top of the Dashboard.  (Note: you 
may also launch the spooler directly from the Spool folder within the ImagePrint folder 
on your hard drive). 

The ImagePrint Spooler interface utility, SpoolFace, will appear.  

The SpoolFace window 
allows you to view and 
control your print jobs.

Run into a Problem?

The ImagePrint trouble shooting guide is located in 
your ImagePrint folder and can be accessed from 

the Help menu in ImagePrint or Spoolface.
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The ImagePrint Spooler  (Continued)

Using SpoolFace

SpoolFace consists of 4 areas:

The Menu Bar - Located along the top of the Spoolface window if on a PC, or along 
the top of the screen if on a Mac, this area gives access to controls for viewing different 
printer queues and queues on remote machines, as well as Pausing and Resuming the 
queue.

The Active Queue - This area is located on the top left side of the spooler interface.  It 
shows the currently printing, and lined up to print, jobs.

The Inactive (Saved) Queue - This area, on the lower left side of the SpoolFace win-
dow, lists jobs that are currently not set to print.  Once a job is done printing, it is auto-
matically moved from the Active Queue to this Inactive Queue.

The Status Area - Located at the right side of SpoolFace, this area shows the current-
ly printing job, as well as a running list of messages from the spooler during printing.  

The Preview Area - Located at the bottom right side of SpoolFace, this area shows 
thumbnails of the currently selected print job.  Note: You must have enabled “Generate 
previews for SpoolFace” in the ImagePrint Preferences window prior to printing.  

Active Queue

Inactive Queue

Status Area

(Check here for errors!)

Preview Area



16-4 ImagePrint User’s Guide

The ImagePrint Spooler  (Continued)

As jobs are submitted to the queue, they are displayed in the left side of the 
SpoolFace window.  From there, they can be cancelled or deleted by highlight-
ing them and dragging them to the desired location. 

Drag and Drop job control

To cancel a job, highlight it in 
the Active (top) pane and drag 
it to the Inactive (lower) pane.

To re-submit a job, highlight it in 
the Finished (lower) pane and 
drag it to the Active (top) pane.

To permanently delete a job, 
drag it from the Inactive (bot-

tom) pane to the Recycling bin 
icon. 

 Currently printing jobs appear on 
the upper left pane of the spooler

Finished or cancelled jobs appear 
on the lower left pane of the 

spooler

Delete jobs from the inactive pane 
by dragging them to the Recycling 

bin

Note on DEMO printing

If you don’t have an encryption for ImagePrint but want to print in DEMO mode (with the 
word DEMO watermarked on your prints), make sure “Print if Demo” is selected within the 

QUEUE menu’s DEMO options. 
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Using the ImagePrint Spooler (Cont.)

Previewing jobs - Highlight a job in the Active or Inactive queue to see a thumbnail of it’s 
contents in the Preview area in the bottom right corner of the SpoolFace window.

Status

The current status will appear here, in the very bottom left corner of the SpoolFace window. 

This is the quickest place to see if SpoolFace is paused, ready to print (idle) or finished the 
last print with an error.

Tip: If you have a lot of jobs to search through, the Use Filter checkbox will pop-up a search 
menu for quickly finding the one you’re looking for.  That feature is described later in this 

chapter.
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Using the ImagePrint Spooler (Continued) 

Archiving jobs    (THIS FEATURE IS NOT SUPPORTED FOR IMAGEPRINT R.E.D.)

Job(s) in the Inactive (lower) Queue can be preserved for safe keeping--all images, pro-
files, and settings are included in the archive.  The archive can then be backed up or 
moved to a new computer running ImagePrint.  

To create a job archive:

Right click or Control-click one or more selected 
jobs in the “Inactive” lower pane of the SpoolFace 
window, and choose Archive Jobs in the menu that 
appears.  (To select multiple jobs, hold the Control 
key (PC) or Command key (Mac) while clicking 
them).

The Archive Jobs dialog will appear.

Click Choose Folder to specify the location in which 
you want to save the archive.

Select the “Include Images” checkbox to have all images included in the job file 
archive that were part of the original print.  (Including images will make the archive sig-
nificantly bigger, but is usually necessary for future printing to occur if the images are 
to be deleted or moved from their current location).  If “Include Images” is not selected, 
and the images from the print job(s) are moved or deleted, the archived job(s) will not 
print successfully.

Select “Include Profiles” to include the ICM/ICC color profiles used in the original job 
within the archive.  In most cases this is recommended to ensure the archive contains 
all of the original color information for future printing. If a necessary profile is not avail-
able in the ImagePrint Color folder when the archived job is reprinted, the print will fail if 
the profile was not included within the archive. 

Click OK to create the Job Archive.

Restoring archived jobs - To retrieve jobs from a previously created job archive, Right 
click (PC) or Control-click (Mac) within the Inactive (lower) pane of SpoolFace and 
choose “Restore Job(s) from Archive” in the menu that appears.

You will be presented with a File dialog allowing you to locate the saved archive.  Once 
you select the archive it will be restored into the Inactive queue.  Jobs can then be 
dragged to the Active Queue for printing. 
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The ImagePrint Spooler  (Continued)

Following is a complete list of the operations which can be performed via the Spooler inter-
face window:

Choosing a Different Queue
To display a Print Queue from another workstation in the current spooler interface win-
dow, choose the desired workstation’s name from the Computer drop down menu.

Choosing a Different Printer
To display another printer’s queue in the current spooler interface window, choose the 
desired printer from the Printer drop down menu.

Changing DEMO mode behavior
Choose “Demo Mode Behavior” under the QUEUE menu to specify what should hap-
pen when ImagePrint does not have a valid license (or in the case of Macs, if no don-
gle is attached).  Normally, nothing will print in that case, but you can instead choose to 
have the word “DEMO” watermarked on your prints.  You can also use this menu to run 
ImagePrint in “emulation mode”, allowing nothing at all to go to the printer (Emulation 
mode can be useful for testing spooler/printing problems without wasting paper).

Changing Job Priority
If you need to re-order jobs in the active queue, move them to the inactive (lower pane) 
then drag them back to the active (upper) pane in the order you wish to print them.

Canceling Jobs from the Active Queue
To cancel a job from the active queue, highlight the desired job (hold down the Control 
key to select multiple jobs) and drag it to the Saved (lower pane) Queue. 

Force Quitting a job
If canceling a job using the normal method of dragging it to the Saved Queue fails, 
you can choose “Force Quit” from the Queue menu at the top of the Spoolface screen.  
Make sure to reset your printer and unpause SpoolFace (Queue->Pause) after force 
quitting a job. 

Resending jobs from the Inactive (Saved) Queue
To resubmit an inactive job to the Active Print Queue, highlight the job (hold down the 
control key to select multiple jobs) and drag it up to the Active Queue pane.
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The ImagePrint Spooler  (Continued)

Deleting Jobs from the Inactive (SAVED) Queue
To permanently delete a job from the Inactive Queue, highlight the job and drag it to 
the Recycling Bin icon at the bottom of the SpoolFace window. 

Pausing the Print Queue
Choose Pause Queue from the Queue drop down menu located at the top of the 
screen to cause the currently displayed queue to be paused. (You’ll see a check mark 
beside the Pause Queue menu entry after selecting it). Paused will appear in the status 
area at the bottom left corner of the spooler interface window.  

Resuming the Current Queue
Choose Pause Queue from the Queue drop down menu to cause the currently dis-
played queue to be resumed.  (The check mark beside the Pause Queue menu entry 
will disappear when the Queue is resumed). Active will appear in the status area at the 
bottom of the spooler interface window.

Viewing Job Parameters
To view the parameters of a print job, including DPI, ink set, file names and color pro-
files being used, move the job to the Inactive (Saved) Queue (lower pane) and double-
click it.

Editing Job Parameters
To edit a jobs parameters (such as DPI or ink set), first View the job in the Inactive 
(Saved) Queue as described above, then edit the values in the view window.  When 
you close the viewing window, you will be asked if you wish to save the job changes.  
Choose yes, and the new parameters will be saved.  Note: Incorrect job parameters 
can result in jobs that do not print or print incorrectly.

Archive/Restore jobs  (ImagePrint Black only)

Right click (PC) or Control click (Mac) job(s) in the Inactive (Saved) Queue and choose 
the appropriate function in the menu that appears. (Archiving jobs is described earlier 
in this chapter).
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The ImagePrint Spooler  (Continued)

Use Filter
The Use Filter checkbox -- located in the bottom left of 
the Spoolface window -- will cause a search window to 
be displayed that provides tools for searching through 
jobs in the Saved (bottom) area of Spoolface.  This can 
be useful if you have a large number of saved jobs that 
you regularly reprint.

To use the Search window, first pick from among the 
available job columns in the Filter Column menu.  You can choose to search based on 
the Job number, the computer (Host) it came from, the User that sent the job, the Date 
it was sent, or the job’s Name.  

Next, pick the search method you wish to use in the Filter Syntax menu (or just leave it 
at its default setting (Regular Expression) which works fine for most simple searches)).    
In addition to Regular Expression searching - which uses standard regular expression 
syntax beyond the scope of this manual -- you can choose Wildcard searches (using 
standard wildcard characters like “*”) or Fixed (Exact) String matching which uses no 
wildcards or regular expression syntax and will return results based on the exact text you 
specify.  

Next, type the text you wish to search for in the Filter Pattern field at the top of the win-
dow and hit the return key. The jobs listed within the Saved (bottom) section of spoolface 
will change to show only the jobs that match your search criterea. 

Note that you can choose to make your searches case senstive via the Case sensitive 
filter checkbox, and have your results sorted case sensitively via the Case sensitive 
sorting checkbox.

To close the Filter search window and return to the normal (complete) job list, just un-
check the Use Filter checkbox.
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Cut-it-out!
The automatic cutter control option

Cut-it-out! is a new option for ImagePrint R.E.D. and 
Black that supports Graphtec Roll and Flatbed cutters.  

In the past, automatic cutting has mostly been limited to 
vinyl or heavier media, but with Cut-it-out! ImagePrint 
brings inexpensive automated cutting to standard ink-
jet printing.  From school packages to portraiture, from 
business cards to fine art -- if you can print it, you can 
cut it with Cut-it-out! and a supported cutter.

To use Cut-it-out you must have a supported cutter attached to your computer (and pur-
chased a Cut-it-out! license to enable the feature).  ImagePrint will use the cutter automati-
cally--no additional installation needed.

Two types of Cutting 

Cut-it-out! supports two methods of cutting, Basic and Contour.

With Basic cutting, rectangular or oval-shaped cuts (with or with-
out borders) will be applied to every image on the page according 
to the image’s boundaries. For many users this is the only type of 
cutting needed. If you need to easily print and then cut out photo-
graphs with virtually no extra steps, this is the option for you.

Contour cutting conforms to image shapes, not just the rectangu-
lar image boundaries.  Images with decorative borders... artistic 
lettering... cartoon characters... pretty much any shape you can imag-

ine, ImagePrint’s contouring tools will make it easy to create 
the paths needed to precisely cut them.  And...contour cutting 
also works with paths in images saved from Adobe Illustrator or 
Photoshop.

What’s next?

The next few pages will show you how to enable Cut-it-out! and set up cutting 
parameters for doing Basic (rectangular and oval) cuts.  Contour cutting is covered next 
(you can skip that part if you don’t plan to do that kind of cutting) followed by instructions 
on how to send the job to the cutter after it’s printed.  

Finally, to help get you started we’ll devote a few pages to the essentials of setting up and 
using your Graphtec cutter with Cut-it-out!.
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Enabling Cut-it-out!

You can find Cut-it-out! within the CUTTER SETTINGS section of the ImagePrint 
Dashboard, under ADVANCED. To enable it, select the check box at the top of the Cutter 
Settings section.  

What happened to the page size?

Notice that as soon as you enable Cut-it-out! the printable 
area in the ImagePrint layout window becomes smaller by 
about an inch on all sides.

This larger margin space is needed for the registration marks 
that the cutter uses to set the coordinate system for each page 
in order to ensure pinpoint accuracy in the cutting process.  
ImagePrint will automatically add the six registration marks at 
print time in this margin area.

Setting up the Basic Cut parameters

The Cutter Settings section of the Dashboard is where 
you specify how the images on the printed page will be 
cut. 

On the next page you’ll find the available options 
and descriptions of their functions.  

Cut-it-out! (Continued)



17-4 ImagePrint Black User’s Guide

Setting up the Basic Cut parameters (continued)

Type  

The Type menu lets you choose the 
shape of the cut.  There are three 
choices:

Rectangle
 Cuts will be rectangular with 90 degree corners.

Rounded Rectangle

Cuts will be rectangles with rounded corners.  The round-
ness of the corners is determined by the Radius setting 
(described below).

           	 Ellipse

  Cuts will be elliptical (oval).  The shape 
and size will be determined by the image’s shape and 

size.

 

Cut-it-out! (Continued) - Basic Cutting
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Setting Cutting Parameters (continued)

After specifying the Type of cut to be made, the next two settings let you control the shape and 
size of the cuts.

Radius

The Radius setting is only used when the Type 
(see above) is set to Rounded Rectangle.  The 
radius determines how rounded the corners will 
be. The default of .175 results in a slightly round-
ed corner.  To increase the roundedness, make 
this value larger.  To make the corners sharper, 
decrease this value.

Spread  
This setting controls the distance from the edge of the 
image that the cut will be made.  The default is 
0.00, meaning the cut will be made right at the 
edge of the image.  

Increase the spread if you want a border 
around your image. 

Leave the spread at 0 if you want no border.

Decrease the spread value below 0 if you want to cut into the edges of your image. This 
can be useful if you are working with images or documents that are oversized and you 
want them cut to the proper dimensions.  

Note that as you place images on the page, you’ll see any non-
zero spread represented as a rectangle around each image.  

As it lays images out, 
ImagePrint will auto-
matically space them  
so that the spread 
areas don’t overlap.

Cut-it-out! (Continued) - Basic Cutting

Radius 
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Radius 
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Setting Cutting Parameters (continued)

The next two cutting parameters allow you to specify the hanger size and spacing.

What’s a hanger?

 
 

Hangers are tiny pieces of uncut paper spaced along the cut line that keep the cut image 
from completely separating from the page.  Without leaving some hangers the integrity of the 

paper would decrease during the cutting process and eventually a paper jam would occur.    

 
In the example above, a sheet of cut images is being held together by several hangers on 

each side. It’s easy to separate them with just a small amount of force.   

Hanger Space
This is the distance that the hangers will be placed from one another.  The default of 
.750 inches should be sufficient for most cutting jobs.  If a specific type of layout is 
causing paper jams, or cuts that separate from the page prematurely, then decrease the 
spacing. That will add more hangers, increasing the integrity of the page.   If you are 
just cutting a few images on the page you may be able to decrease this value to use 
fewer hangers.

Hanger Size
This setting lets you specify the size of the hangers. The default value is .3 mm which 
should be fine for most cutting.  If the hangers are too small they will fail to hold the cut 
images in place during the cutting procedure.  Too big, and you may have trouble sepa-
rating the cut image from the page afterwards.  It is not recommended that you change 
this value without guidance from our support team.

Cut-it-out! (Continued) - Basic Cutting
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Setting Cutting Parameters (continued)

The final three settings are global options that apply to both Basic and Contour cutting.

Image Protection
As the cutting assembly moves back and forth over the paper, 
it’s possible that it may mar the surface of the print as it quickly 
moves to the next location. Image Protection mode will cause 
the cutter to determine a path that doesn’t pass over printed 
areas of the paper, greatly reducing the chances of a marred 
print due to a cutter head strike.  

Blind Cutting (skip printing)
Enable this mode when you don’t want to actually print the images you’ve laid out on the 
page. Instead, a job will be created (when the print button is clicked) that only contains 
the cutting data -- not the images they apply to.  You can then pass the job to the cutter 
to cut out blank shapes.

Cut Both Boundaries and Contours
With this setting enabled, both Basic cuts (for all images on the page) and Contour cuts 
(for images that have contour cutting paths) will be performed when the page is sent to 
the cutter.  This is the default mode. 

Turn this option off it you only want the contours cut -- no basic (rectangular/oval) cutting 
of the image.  

Cutter Selection

Click the Gear icon to access the Cutter selection window.  This window allows you 
to select the cutter model you are using, as well as the connection (USB or net-
work).  If  network, the window will also let you specify the IP Address of the cutter. 

That takes us to the end of the Basic Cutting parameters. 

Contour cutting will be covered next, but first let’s go over a couple of best practices to use 
when laying out images to ensure you get the best cuts. 

Cut-it-out! (Continued) - Basic Cutting
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Recommendations for spacing images

For the most part, images can be placed on the 
page just as you normally would. 

Images can be placed next to each other with no 
space (gutters) between them (recommended) or 
separated from one another by .25 inch or more.  

In order to maintain the integrity of the page as 
it is cut, it is strongly recommended that images 
either be placed beside one another with no 
space between them, or separated by .25 inch (or 
more).  

When images are separated by less than .25 inch, cutting them will result in a sliver of 
paper between them which can negatively affect the overall structure of the paper.

So--

 -- Images next to each other with no space between them:   
    Recommended (and the most efficient)

 -- Images .25 of an inch apart:  
    Recommended

 -- Images not next to each other but closer than .25 of an inch:  
    Not Recommended

Special Case: Templates

The same recommendations hold true when designing and using templates, but with 
templates -- unlike with standalone images -- the template boundary itself will also be 
cut.  So, when designing a template try to keep image frames up against the template 
boundary, or, if that is not possible leave at least .25 inches between the frames and the 
template boundary.

And, just as with stand-alone images, when placing multiple templates side-by-side be 
sure to put the templates are beside each other with no space between them OR leave 
at least .25 inches of space between them.  Do not leave less than .25 inches between 
them or you may have issues with the resulting cuts.

Cut-it-out! (Continued) - Basic Cutting
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Contour Cutting
Contour cutting refers to cuts that follow a path other than that of the image’s boundar-
ies. This path can take on virtually any shape--logos, people, cartoon characters. Note: If 
you just want to make rectangular or oval cuts that include the entire image, you may not 
need to delve into the more advanced subject of contour cutting at all--in that case, skip 
to the Making the Cut section later in this chapter. 

In order to make a contour cut, Cut-it-out! needs to be able to determine which shape(s) 
within the image to cut.  To do this, you can use ImagePrint’s Contour Cut window to 
define the areas to cut, or you can create the contour as a path in Adobe Photoshop or 
Illustrator.  If Cut-it-out! is enabled, ImagePrint will treat any path it sees in the file as a 
contour cut outline.

Sample Files
ImagePrint provides several sample files that you can use as 
is or as a source of inspiration for your own cut-ready cre-
ations. With their clean lines they also make great practice 
subjects for learning to use the contour tools.  These files are 
located in the Cutting Images folder within the Test Images 
folder in your ImagePrint folder.

Defining the contour in ImagePrint
To access the Contouring controls in ImagePrint, open your 
image into the ImagePrint layout area as normal.  Make 
sure that Cut-it-out! is enabled in the dashboard using the 
instructions on the previous pages.   Then right-click the 
image (or control-click it if you don’t have a right mouse but-
ton) and choose Contouring from the menu that appears. 

The Contouring Window will appear.  

On the right side of the Contouring Window you’ll see the 
controls that will be used to define the area to be con-
toured.  

On the left, the image and the current contour outline will be shown.  As you make 
changes in the controls area, you’ll see the current path--represented as a purple outline-
-change to reflect the new contour parameters.

In the next few pages you’ll find descriptions of the tools to be found in the Contouring 
Windows along with some examples of defining a contour in typical images.

Cut-it-out! (Continued) - Contouring
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The Contouring Window

Zooming Controls

At the top of the Contouring Window are magnifying glasses 
that you can click on to zoom in/out of the displayed image in 
order to see the effect of the contour more accurately.  You 
can also set a specific zoom via the Set Zoom menu.  When 
zoomed in, click within the image area to access a Hand tool 
that allows you to adjust what part of the image you see.

Type 

The Type menu lets you choose between standard and Wrap 
Contour modes. 

Standard Contours
This type of contour closely follows the outline 
of a defined area of the image. 

Wrap Contours 
Wrap contours are more generalized outlines that 

are exactly big enough to “wrap” around the image 
but don’t conform to its exact shape.  

Cut-it-out! (Continued) - Contouring
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Offset 

The Offset setting lets you specify a distance that the con-
tour will be drawn from the image edge.  This allows you 
to include a border outline within the cut.

This image has an offset of 1.0.  Notice how the 
purple contour outline is offset from the edge of 

the image.

Notch 

There may be cases 
where you don’t want 
every narrow indenta-
tion along the edge of the image cut.  

The Notch setting can be used to adjust how closely the 
contour will follow such areas.

  

A high notch value will cause the cutting outline to follow 
the shape more loosely around 
narrow convex areas. 

A lower value (zero is the default) 
will cause the contour outline to 

exactly match the shape.  

Cut-it-out! (Continued) - Contouring
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Min Diameter 

To avoid small sub-sections of the image being assigned cut 
outlines, you can set a Minimum Diameter.  Any area of the 
image that has a diameter smaller than this value will not get a 
contour outline. 

Cut-it-out! (Continued) - Contouring

Min. Diameter .2

With a diameter of .2, 
some smaller sections 
get contoured as well.

Min. Diameter 1.0

Only the large blue out-
side section gets con-

toured.

Min. Diameter .05

Even the smallest 
areas are now con-

toured.
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Threshold 

The Threshold slider is the main control used to define which 
parts of the image get outlined.  

The threshold control works by letting you choose an aver-
age RGB percent value from 0 to 100.  As you drag the slider, 
the contour outline will be drawn between those areas of the 
image that have a higher average value, and those that have 
a lower value.  

Images with a solid background separating the areas you wish 
to have cut are much easier to create contour outlines for than 
images with gradient backgrounds, and if the background is 
much lighter (or darker) than the part of the image you want 
cut, defining the contour is typically a simple process.

For images that have less distinct edges, you’ll typically need to fine tune the value to 
ensure the parts of the image you want to be contoured.  Remember, if some smaller 
sections -- like the inside of a letter “O” -- are not included in the contoured area that 
you want cut-out, you may need to adjust the Min Diameter setting to a lower value to 
let those parts get a contour too.

TIP: If you can’t get the contour to include the area you want cut without also getting 
some unwanted contours, don’t worry --  the Contour Remove tool (described later) can 
be used to delete unwanted contours. 

As an example, let’s use the Threshold 
slider to contour this robot image.

The default contour value of 100 represents 
white.  This means that the contour line will 
be drawn between all the white pixels and 
any pixels brighter than white.  But... since 
white is the brightest value possible, there’s 
no contour to be drawn.  We need to adjust 
the threshold a bit.

Cut-it-out! (Continued) - Contouring
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We don’t have to go far.  A threshold value of 99% 
manages to contour the main robot shape nicely.  
The purple contour outline is drawn between any 
RGB average values 100 (white) and 99 (every 
other color) so we get an outline between the 
white areas of the image and the black edge of the 
robot.

But wait--the small white areas between the arms 
and the robot’s body do not have outlines -- even 
though they are white.  If we want those areas to 
be cut-outs, we need contours there too.  So what 
went wrong?

The “Min. Diameter” setting from earlier in this 
manual controls how small the contoured areas will 
be.  This is useful for avoiding drawing contours 
around every little shape in the image, but in this 
case we want to contour those thin areas beside 
the arms.  So, let’s bring down the Min Diameter 
value a bit until we see the contour get those areas 
as well.

A minimum diameter setting of .200 seems to have 
done the trick.  We now have included those areas 
by the arms -- if this robot was printed and sent to 
the cutter, you’d get the robot cut out and a cutout 
beside each arm.

But--there’s another problem.  When we adjusted 
the minimum diameter, the small round lights on 
the robot’s chest panel got contoured too!  We 
definitely don’t want those to be cut out.

No problem.  ImagePrint provides tools to eas-
ily delete unwanted contours.  We’ll get to those 
tools after the next page and finish the job with our 
robot. Stay tuned!

Cut-it-out! (Continued) - Contouring
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Exclude Interiors 

With this option set to OFF only the outer contour will be 
outlines--no interiors area (within the contour’s boundaries) will 
be created.  Turn this option ON to include contours within the 
main contoured outline.

Details 

The contour can be drawn at three different details. Normal, 
High and Extreme.

Higher levels will cause the contour to follow the shape more 
accurately but if your image has lots of fine detail may result 
in longer cutting times.  That should not be an issue with just 
a few images to cut, but if cutting lots of images, you may 
want to use the lowest detail setting that produces acceptable 
results.

Cut-it-out! (Continued) - Contouring
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Contour Correction Tools 

These tools allow you to fine tune what parts of the image via 
a colored fill or line.  It’s important to understand that any fills 
or lines you draw with these tools will NOT be included in the 
print - they are just used to block off or connect areas of the 
image to control the contouring. 

Click the color drop-down menu to choose a color for the 
line/fill tool to use (Black or White are often the most useful 
as they represent the extreme ends of the threshold range) 
then click the pencil or fill tool and draw within the contour 
windows display area.  The  contour outline will follow the 
new area based on its brightness compared to adjacent 
areas. 

To delete any elements you have added, click the Reset button.

Here’s an example of using the Correction Tools to adjust the contouring outline. 

The exclamation mark in this image 
has a contour around both parts, 
meaning it will be cut into two separate 
shapes.  

Joining:  To join the two pieces, a black line could be drawn between 
them.  Notice how -- when the contour is redrawn -- that the shapes 
are now “bridged”.  Remember--the black line won’t print.  It’s just 
there to adjust the contour.

Breaking: In another part of this 
image, the “H” and the “i” are joined, 
meaning they’ll be cut together as 
one shape.  A white line or box 
drawn between them at the base 
will effectively break the continuity, 
causing the contour to treat them as 
separate shapes.

Cut-it-out! (Continued) - Contouring
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Contour Selection Tools 

The contour selection tools provide the ability to select con-
tours and delete them.  This makes it easy to clean up any 
unwanted contours that appear after adjusting the threshold 
and other values to outline the parts of the image you want to 
have cut.

Click the pointer to tool to enable contour selection. Then, 
simply click contours to highlight them (they will turn red when 
selected).  Hold shift down to add to the group of select con-
tours--or, drag the pointer tool to multiply select contours within 
a marquee.

Once you have the contours you want selected, click the X 
icon to delete them.  You can also use the “d” key on your key-
board.

If you make a mistake and want to un-delete a contour, click the check button (or press 
the “r” key on your keyboard.  Clicking check or the “r” key multiple times will result in 
restoring multiple contours that have been deleted.  

As an example, let’s return to our robot example 
from a few pages ago.

When last we saw him, a proper contour line 
had been created using the Threshold and Min. 
Diameter tools, but we had a couple of areas 
within the robot body that we didn’t want to have 
cut.  The two white circles within the robot’s con-
trol console.

To remove them, click the Pointer tool within the 
Contour Selection Tools, and click one of the 
circles.  Hold shift down and click the other. (You 
could also have dragged the point to select both 
circles within a selection marquee).

Now click the X icon (or press the “d” key on your keyboard) and the contours will be 
deleted. (You’ll see them outlined in blue when deleted.)

Now the robot is done and ready for cutting!

Cut-it-out! (Continued) - Contouring
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Contour Cut Controls
Normally the Basic hanger size and hanger spac-
ing settings in the Cut-it-out! section of the dash-
board are used for contour cuts as well, but the 
Contour Cut Controls section at the bottom of the Contour Window allow you to specify dif-
ferent hanger size and space settings to be used for contour cuts.  Here,  you can also over-
ride the force setting that is currently in effect on the cutter.   

This can be very useful for special “combination” cut styles, such as rectangular cards (cut 
with the Basic cut-it-out hanger settings and the on board cutter force setting) that contain 
peel away stickers (cut using zero-hanger kiss cuts from the Contour Window Cut Controls). 

Applying the Contour 
After using the tools within the Contour Window to contour your image, simply close the 
Contour Window to apply them.  You’ll see your contour outline in the image displayed in the 
layout window, and if you print and send the job to your cutter, the contour outline will be cut.

If you want to edit your contour line, simply right click the image and choose Contouring 
again in the menu that appears. 

Other methods of contouring

In addition to creating your contour outline using ImagePrint’s Contour tools, contours can 
also be created in Adobe Illustrator and Photoshop as paths.  When an image is opened in 
ImagePrint that contains a path--and Cut-it-out! is enabled--the path will be treated as a con-
tour.  

If you name the path using specific terms as defined in the next section, ImagePrint can use 
custom cut settings, including “kiss cuts” (cuts that do not go completely through media, usu-
ally used for cutting through adhesive media without penetrating the backing).

Another way to apply contours is via an SVG contour file. SVG (Scalable Vector Graphics) 
is a common file format (available in programs like Adobe Illustrator or Corel Draw) that can 
be used by ImagePrint as sources of contour outlines.  When dropped on an image, the vec-
tor data in the SVG file will be applied as contour paths.  ImagePrint provides some sample 
SVG contour borders that you can access.  You can also make your own in Adobe Illustrator 
or Corel Draw.

SVG files with paths (but no image data) can also be opened directly in ImagePrint as “Blank 
Contours”.  

The next few pages describe these two alternate methods of contouring.

Cut-it-out! (Continued) - Contouring
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Defining the contour as a path in Adobe Photoshop or Illustrator

Adobe Photoshop can also be used to make paths that ImagePrint will use as con-
touring outlines.  

Just create a path in either program and save it with the image as a Photoshop PSD 
file.  When opened in ImagePrint, the contouring data will automatically be found and 
used as the contour cutting path when the resultant print job is sent to the cutter.

Making a path in Photoshop - a very quick example

While complete Photoshop or Illustrator path-making instructions aren’t within the 
scope of this manual, here’s one way to create a path in Photoshop using the Magic 
Wand tool. There are many other ways to accomplish the same task.

Open an image in Photoshop.  For best results, the image should have a flat back-
ground composed of one color (white is recommended) and the part of the image to 
be cut should have clean, distinct edges.

Select the Magic Wand tool in Photoshop’s tool palette and click the background 
of your image.  The entire background should show a “marching ants” selection.  If 
some portions were missed, adjust the “tolerance” value for the wand at the top of 
the Photoshop screen to a higher value and click the background again.  

Once you have the whole background selected without any of the image you want to 
cut from it--choose “Invert” from the Selection menu.  The selection will be reversed. 
You’ll now have just the image data that you want to have cut selected and none of 
the background.

To convert this selection into a path, make sure the Paths palette is visible (you can 
choose it from Photoshop’s Windows menu).  In the Paths palette, click the menu 
in the upper right corner and select: Make working path.  Your selection area will 
change to a path.

Save the image as a Photoshop PSD file and open it in ImagePrint.  If Cut-it-out! is 
enabled, you should see the path data represented as a contour path.

Cut-it-out! (Continued) - Contouring
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Advanced - Using the path name to designate cutting options

By naming an Adobe Photoshop using specific conventions (as outlined below), you can 
have the path cut using custom cut parameters.  

Named paths are currently the only supported method of specifying a “kiss” cut.  Kiss cuts 
are cuts that go through the top portion of adhesive media without penetrating the backing in order to 
ensure easy peel off.

Naming Syntax

There are 4 sections that need to be included in the name of a path in order for ImagePrint 
to recognize it as a source of cut parameters.  Each section must be separated by a colon 
(:).  The naming format is:

CUT NAME : FORCE : HANGER SPACING : HANGER SIZE

Cut name 
The first part of the path name must be of the form:  ipcut-#  where ”#” is a unique 
number. It’s recommended that the number simply be the sequential order of the path in 
the image –  ipcut-1 for the first path, ipcut-2 for the 2nd path, etc.  

Force       Valid values: 1 - 38
For normal (perforation) cuts, use the Force value necessary to completely cut through 
the media.  For “kiss” (partial) cuts, use a smaller value--typically about half of the cut-
through value though you may need to experiment.  

 A Force value of “-1” will use the current Force setting on the Cutter.

Hanger Spacing  
This value determines the distance between hangers in 10ths of a millimeter. (192 is 
equivalent to 1/4 inch).  Note: If doing a “kiss” (partial) cut, even though there are no 
hangers, a value must always be present (even though it won’t be used).  

 A Hanger Spacing value of “-1” will use the Hanger Spacing setting from 
ImagePrint’s Cut-It-Out! Settings

Hanger Size    Valid Values: 0 - 10 
This value determines the size of the hanger. Values are in10ths of a millimeter. . For a 
kiss cut, this setting should be 0 (no hangers). Non-kiss cutting values can be anywhere 
from 1 to 10.   

 A Hanger Size value of “-1” will use the Hanger Size setting from ImagePrint’s Cut-It-
Out! Settings.
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Keywords

In addition to the above parameters, there are two special keywords that can be used: 

Punchout    (example:  ipcut-1:Punchout)

Using this keyword will result in a cut that uses small hangers and wider spacing 
to allow for easier separation than normal. 

Tearoff  	       (example:  ipcut-1:Tearoff)

Using this keyword will result in a cut that uses larger hangers and smaller spac-
ing for a more rigid, harder to separate cut. Good for tickets that need to be torn 
in half when validated. 

Tenths of a millimeter? 
 

The Hanger spacing and size values are in 10ths of a millimeter.  To quickly convert from inch-
es to tenths of a millimeter, use a tool (Google will do it) to convert from inches to millimeters, 

then multiple the result by 10 (rounding to the nearest whole number).

Path naming examples:

A “kiss” cut, using a force of 15, and using a “dummy” value of 10 for the hanger distance 
(since that setting isn’t used for kiss cuts):

 Ipcut-1:15:10:0   

The below examples show two path names for a ticket that will have two types of prefora-
tion cuts--the first to allow easy separation of the entire ticket from the printed page and 
a second “open path” line down the middle to allow for the ticket to be torn by the ticket-
taker:

ipcut-1:-1:192:2       (For the easy to separate ticket boundary: the current force value 
from  the cutter will be used, with hangers spaced at 192 tenths of a millimeter (1/4th 
inch) and 2/10th of a millmeter hanger size)        
ipcut-2:Tearoff 	     (For the more rigid tear-line down the middle of the ticket)  
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Applying a pre-defined contour border

ImagePrint comes with several contour borders that can be applied to images via sim-
ple drag and drop.  It’s possible to add your own contour borders as well.

To access the pre-defined contours, choose “Visible” beside the “Contours Browser” 
entry in the VIEW at the top of the ImagePrint screen.

You’ll see a window appear with thumbnails of the available contour borders. 

Drag one to an image in your layout and you’ll see the contour applied.

Making your own pre-defined contours

To use your own pre-defined contours, create a file in Adobe Illustrator or Corel Draw 
that contains the path you wish to use using the normal methods for that program 
(ColorByte Software is not able to offer support or instructions on those methods-
-check your program documentation for information on the proper procedures).  

Then save the file as an “SVG” file and put it in the Shapes folder within your 
ImagePrint folder (On Macs, that folder is: /Applications/ImagePrint/Shapes.  On 
Windows, it’s: c: \programdata\ColorByte Software\ImagePrint\shapes).

Restart ImagePrint and your new contour should be available in the Contours Browser 
window.

“Blank” contours

You can also use an SVG file with a path as a “blank” cutting contour. A blank contour 
is a cut line with no image data.  These can be used when you simply want to cut 
shapes without any associated pictures. 

To use a blank contour, simply open an SVG file that contains a path (but no image 
data) in ImagePrint via the File->Open command.  

You’ll see the contour in the layout window as an outline.  

When you click “Print” with only SVG contours on the page, no job will be sent to the 
printer but the job file that appears in spoolface can be dragged to the Scissors icon 
to have the cutter cut the designated shape(s) according to the instructions in the next 
section (Making the Cut).

Since no registration needs to be made with image data when blank contours are cut, 
you don’t need registration marks present on the media. 
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Making the Cut
Now for the fun part - cutting the page!

Of course, before you can cut the page, you must first print it.  But don’t worry--printing a 
job with cut data is exactly the same as printing a job without cut data.  Just make sure to 
include the cut data in the job by clicking the checkbox within the Cutter Settings section of 
the ImagePrint dashboard.  

Now print the job just like normal by choosing Print from the ImagePrint File menu, or by 
clicking the PRINT button at the top of the ImagePrint Dashboard.  

After sending the job to print, open Spoolface (the ImagePrint Spooler) by clicking the 
Printer icon at the top of the Dashboard or by choosing Spoolface from the File menu.

As usual, the print job will stay in the top (Active) side of Spoolface as it prints.  When print-
ing is done, it will move to the SAVED (bottom) side.  (Because it’s a cut enabled job, it will 
appear red in the job listing.)  

TIP: The job name and job number will appear on the print, just below the bar code. This 
makes it easy to match the right print to the right job.

Now, load the completed print into the automatic cutter using the normal procedures for 
your cutter model.  For instructions on loading the cutter, see the section that immedi-
ately follows this one.

Once the paper is loaded, return to your computer and simply drag the completed job to 
the Scissors icon at the bottom of the Spoolface window.  (You can also highlight the job 
and click the scissors instead to send the job). The cut data contained within the job will be 
sent to the cutter, and your print will be cut!

Cut-it-out! (Continued) - Making the Cut

After loading the automatic 
cutter with the completed 
print, drag the job to the 
scissors icon to cut it!
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Cut-it-out! (Continued) - Cutter Setup

Using your Graphtec cutter with Cut-it-out!

While the following guidelines are not intended to substitute for the manual that came with your 
Graphtec cutter, the below tips should help to get you quickly cutting your Cut-it-out! prints. 

First, we’ll give a brief description of best practices when loading paper.  Following those 
instructions, we’ll provide basic instructions on the steps you need to take when switching to a 
new media. Namely, setting the blade length, cutting force and cutting speed.

Loading the cutter with your printed media

Follow the below steps when inserting your ImagePrint Cut-it-out! prints into your 
Graphtec cutter to get a perfect cut every time.

- Lever down

Push down the lever at the back of the cutter before loading 
your paper.

- Bar Code orientation

On every Cut-it-out! enabled 
print, a barcode is generated 
(along with the job name and the job number that appears 
for the job in Spoolface).  For the Graphtec CE-6000 and 
FC-8600 the bar code should be loaded first into the cut-
ter.  For the Lite CE-50, load the end of the paper opposite 
of the barcode first--the barcode goes last for that cutter.

- Paper over the rollers

The gray-colored “grit” rollers on the cutter are responsible for moving the paper as it cuts.  It’s 
vital that the left and right edges of the print are positioned on top of these rollers.   To accom-
plish this, place the right edge of the paper somewhere on the extra wide right-most roller, then 
move the paper left or right until its left edge exactly covers another grit roller. 
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Loading the cutter with your printed media (continued)

- Insert it all the way

When inserting the paper, push the paper into the 
cutter until the trailing edge reaches the horizontal 
guideline in front.

- Keep it straight

While the cutter can compensate for 
some amount of paper skew, it’s still a 
good idea to keep the paper as straight 
as possible when loading. The guide-
lines at the front of the cutter can help 
to do this visually, but we’ve found it’s 
often easier and faster to put a ruler in 
the groove just above those guidelines 
and butt the edge of the paper against 
it.

- Lever up

Once the paper is in place, lift the lever in the 
back of the cutter up to lock the media into 
place.  You won’t be able to move the rollers in 
the next step until you perform this step.

Cut-it-out! (Continued) - Cutter Setup
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Loading the cutter with your printed media (continued)

- Place the pinch (top) rollers

The two top “pinch” rollers are responsible for holding the paper down as it moves through 
the cutter. They also help the cutter’s sensors to find the registration marks. So it’s very 
important to place them correctly.

In placing the rollers, use the wheel brackets as a guide. (Each pinch roller wheel is held 
by a U-shaped black plastic bracket.)  

Align the left edge of the left roller bracket to the 
left edge of the paper.  This placement should cor-
respond to the blue grit-roller marks above the 
page load area since the edge of the page will fall 
on top of a grit marker.

Align the right edge of the right roller bracket to the 
right edge of the paper.

That’s it -- your media is loaded and ready to cut!

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media

Navigating the cutter’s front panel menu can be confusing, but most options can remain 
at their default setting.  However you will need to adjust the blade length and cut force 
are when switching to a new media. It’s also a good idea to set the cut speed to ensure 
the cuts are made as accurately as possible.

Note on Conditions: Graphtec cutters allow you to save a number of “Conditions”. 
These are groups of settings that can be saved and easily recalled.  The following 
setup procedures assume you are using the Condition one, but at any step you can 
choose a different Condition number to create settings for it instead. 

First, load your media 

You’ll need to have your media loaded on the printer before making the following 
adjustments.  You can use the instructions in the previous section as a guide.  Note 
that, since you won’t be cutting an actual job, there’s no need for the loaded paper to 
have registration marks, and the placement of the grip rollers doesn’t have to be accu-
rate. The cutter just needs the media to be in place for setting the proper blade height 
and making small test cuts.

Step 1 - Adjusting the cutter length (Coarse adjustment)

Adjusting the blade length is an interactive process of making manual adjustments 
while being guided by the cutter as it checks the media.  You’ll need to do this when-
ever you change to a media of a differing thickness.

A. Retract the blade

Remove the blade assembly from the cutter. Then, using the 
rotating knob at the top of the cutter assembly, adjust the cutter 
extension just enough so that the tip of the blade is not protrud-
ing at all and is hidden within the opening.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

   B. Set the baseline (zero) point

Put the blade assembly back in the cutter

On the cutter’s control 
panel, press the COND/
TEST button.  

Then press the DOWN 
arrow once to move to 

change to the 2nd menu 
screen. 

Choose option 3 - Blade Adjust. You’ll be prompted to retract the blade--
but since we’ve already done that in step one, just press the 
ENTER button.

The cutter will now set its “0” point -- the point at which the 
blade assembly just touches the media. 

   C. Set the blade extension

When it’s done, you’ll need a small piece (3 inches by 3 inches should be fine) of the 
media you plan to cut.  Place that piece between the blade and the loaded media.  Then 
choose option 2 - Check.

Now the cutter will measure how thick your piece of media is. Once it’s done, you’ll see 
the thickness listed at the top of the panel.  This will be the length you’ll be setting the 
blade to match.

There’s several ways to set the blade length. We’ll be using the Target Length method.

Remove the scrap of paper. Then, click option 1 - Blade Length Target, and use the 
arrow keys to adjust the target value to match the paper thickness you measured in the 
previous step. Click the ENTER button to return to the previous screen.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

Now click Option 2 - Check to have the cutter check the current length of the 
blade. 

Each time you chose this option, the cutter will measure that 
length and provide instructions on how far and which way to 
turn the blade’s adjustment knob to reach the Blade Length 
Target you set.  (Note that you don’t have to remove the blade 
assembly to turn the knob).  

Turn the top adjustment knob in the direction and degree that the panel instructions 
specify, then choose Option 2 - Check again to assess the current blade length.

Keep choosing Option 2 - Check and adjusting the blade length as directed until the 
Blade Length Target is reached (as shown at the top of the panel).   Once that value is 
reached, click Option 3 - END.  

You now have adjusted the blade to equal the thickness of your media!  

Now you need to adjust the force that the cutter will use as it presses into the media.

Step 2. Setting the force value (Fine adjustment)

To set the force value, you’ll do a series of one or more test cuts to determine the proper 
amount of force for your particular media.  

Determining a starting point 
 

To get a good “ballpark” force value for your media, the following formula can be used:  
 

Force = (28  x  [Paper thickness (mils)] )   /  11 
 

That is, multiply the thickness in mils of the paper times 28, then divide the result by 11 
(Round down the answer to the nearest whole number).   So, for 12 mil paper, the starting 

force should be: 
 

(28 x 12)  / 11  = 30.5 
 

Rounding down, we now have a force value of 30 to start with.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

On the cutter’s front panel, click the Cond/Test button (you may need to 
click it twice) then choose Option 4 - Force.

Now use the UP/DOWN Arrow buttons on the panel to enter in your starting force and 
press the ENTER button.

You’ll now need to do a test cut.  Press the RIGHT 
Arrow button on the front panel to be taken to a screen 
that lets you use the Arrow buttons to move the cutter 
blade to a position on the paper you’d like to cut.  

When you have it over a clear area of media, press the 
ENTER key to perform the cut.

The cutter will execute a small triangular cut.  Check that the triangle separates easily 
and cleanly from the paper. 

- If it doesn’t separate cleanly, press the ENTER button, then Option 4 - Force, and 
repeat the above steps with a higher force value.  

- If you notice tearing of the paper after the cut was made, your force is probably too 
high.  Again, press the ENTER button, then Option 4 - Force, and try again with a 
lower force value. 

Once you get a perfect cut, press ENTER one more time and move on to the last set up 
step: Setting the Cut Speed.

Cut-it-out! (Continued) - Cutter Setup
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  Step 3. Set the Cut Speed value	

The speed setting can affect the accuracy of your cuts. Generally, for most cut jobs a 
speed setting of around 40 works best, but we recommend that you set the cutter speed 
to AUTO to let the cutter change its speed based on the cut being made.

To set the speed to AUTO, first press the Cont/Test button, then press the 
DOWN arrow twice to get to the menu that has Option 1 - Acceleration.  

Choose that option and a screen will appear that lets you specify the acceleration 
mode.  Press the UP arrow key to change that value to * (It will be one click above “2”).  
That’s the Auto Speed mode.  

Hit the ENTER button and it will be saved. Now the cut speed will automatically adjust 
based on the cutting conditions.  

Cut-it-out! (Continued) - Cutter Setup
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Printing Through Applications (PTA)
Printing from other programs into ImagePrint’s Spooler

While most users prefer to use ImagePrint’s powerful layout tools, there are some 
cases where it may be convenient to print directly from applications without hav-
ing to save images first and reopen them in ImagePrint.  You may also work with 
an application that doesn’t save in one of the formats (TIFF, JPEG or PSD) that 
ImagePrint can use.  For example, packages like InDesign, and Illustrator typically 
only output to PDF or PostScript, which can not be directly opened in ImagePrint.  

For those cases, PTA (Print through Applications) may be the answer.

With PTA, you can print directly from virtually any application, including Photoshop 
and InDesign, straight to the ImagePrint spooler.  If the application can utilize the 
Windows Spooler or Macintosh Print Center, then it can print to the ImagePrint 
spooler with PTA.  

The PTA option is now free with ImagePrint Black, but it is not installed by default so 
there’s a few steps needed to enable it, depending on your computing platform. The 
following pages detail installing PTA for Macintosh and Windows.

Printing directly from applications is a convenient way to send jobs to the printer, but 
there are some key differences between printing with PTA and printing directly from 
ImagePrint:  

	 -	 When printing directly from applications, you lose the ability to utilize 
ImagePrint’s powerful layout features.  (Although using ImagePrint is still 
always available.) Jobs will be sent to the printer exactly as they appear in 
the layout area of the application.  Features like step-and-repeat, or tem-
plates, will not be available.

 	 -	 Since a program may have its own unique way of handling page sizing and 
color management, care must be taken that the selected settings work prop-
erly when printed through ImagePrint’s spooler.  

	 -	 Some printer control settings available when printing through ImagePrint may 
not be available when printing from applications. 

	 -	 Some layout features of your application, such as multi-page spreads, may 
not work with PTA.  Also, printing more than 1 page at a time may not be 
successful.

Note, in the past, printing directly from applications required the PostScript option, 
but with PTA, PostScript is no longer necessary to use this feature.
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PTA (Continued)

Installing PTA

PTA is installed differently on Windows and Mac computers. The following pages will guide 
you on installation on your platform.  If you run into any problems Installing, or using PTA, 
please check the PTA section at the end of this section.

Installing PTA on Windows

Follow the below steps to install PTA on Windows 8, 7, XP or Vista.

Add the ImagePrint PTA printer

Launch IP Setup from its location in your 
ImagePrint folder 

(The default is: c: \ program files (x86) \ 
ImagePrint)

Click to highlight the printer in your list of 
installed printers you wish to use with PTA.

Click ADD PTA.

You are now done installing PTA for Windows!

The PTA driver will appear as a standard Windows printer driver in your list of Windows 
printers, with the same name as the printer you installed in ImagePrint.  

If you add any new Imageprint printers, remember to click ADD PTA in IP Setup to 
install the PTA driver for that printer.
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Installing PTA - Macintosh (continued) 

Installing PTA on OSX

To install the necessary files for PTA, you must first run a utility located in your ImagePrint folder.

Open the folder called ImagePrint within your Mac’s Applications folder, then open the pta_cups 
folder:

    / Applications  / ImagePrint / pta_cups

Now, look for the file called “setup_ippta_files.command”.  Double-click that file.  A text (terminal) 
window will appear prompting you for your Macintosh password.  Type it in and click Return.  
NOTE: You will not see characters as you type in your password--this normal.  Just type the 
password, then return.  You should not see an error message--if you do, you may have mistyped 
the password.  When the text window reports “DONE” you can close the window.

Now, you will need to add the ImagePrint PTA printer driver for your installed printers into your 
Macintosh Print Center:

.	 Choose “System Preferences” from the Apple Menu, then choose the Print & Fax 
Control Panel. 

.	 Click on the plus (+) sign below the printer list.  A window with a list of all your printer 
drivers will appear--this may take up to a minute to completely build, so give it some 
time.  

.	 You should now see your installed ImagePrint printer(s) listed.  Click on the printer’s 
name and choose “Print Using”. In the search box, choose the most appropriate 
driver that has “Colorbyte Software ImagePrint” in the name (e.g. “Colorbyte Software 
ImagePrint epson7900, 1.1” would be the one to pick for an Epson 7900).  Next click 
the “Add” button.

Your PTA driver is now installed and ready to use.  As always, when printing from applications 
make sure to choose the proper settings within the PTA Print dialog boxes. There are two such 
boxes that should appear in the Print Dialog after choosing “Print” -- “IPPTA Profiles” and “IPPTA 
Paper”.  For more information see the PTA chapter within the ImagePrint User’s Manual, located 
in your ImagePrint folder. See Accessing Macintosh PTA Settings, later in this chapter for more 
information on how to setup PTA.

Your ImagePrint printer will now appear as a Printer choice in all of your Macintosh 
applications.
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PTA (Continued)

PTA Settings

Just like when printing through ImagePrint, printing with the PTA option requires you to select 
options such as Color Profiles, Sheet vs. Roll, etc.   Although the settings are the same on 
Windows and Macintosh, accessing these settings is different on the two platforms.  The fol-
lowing sections will describe how to access the PTA settings for your particular platform.

Remember: Printing through Applications is independent of your current ImagePrint settings-
-any choices you have selected in ImagePrint will have no bearing on the prints you make 
with PTA.  

Accessing Windows PTA Settings

Applications vary in the layout of their print dialog 
boxes, but the following applies in most cases.

	 -	 Choose PRINT in your application, and 
make sure that the ImagePrint printer PTA 
driver is the selected printer (It will be 
named after the printer you installed with 
ImagePrint

	 -	 Choose the Settings... button.  If that but-
ton is not available, look for a Properties 
button.

	 -	 Choose the Options (some applications 
will show Advanced instead of Options). 

	 -	 In the window that appears, you will be 
able to specify the profiles to be used, and 
other printer settings.

Adding Custom Page Sizes: Common page 
sizes on your system will be listed in the Page 
Size menu within this Advanced window.  To add Custom Page Sizes:  Go to your Windows 
Control Panels, choose Devices and Printers, click on your PTA printer and click the option 
“Printer Server Properties” which will appear in the window’s title bar.  

Once in the Server Properties window, by choosing the FORMS tab you will be able to cre-
ate and save custom pages sizes that will appear in the Page Size dialog box.  Make sure 
to specify the exact width of the physical paper (the height can vary if using roll paper, but 
should be the exact size if using sheet).  Leave the margins at their default 0 value.
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PTA (Continued)

Accessing Macintosh PTA Settings

Applications vary in the structure of their print dialog boxes, but the following applies in most 
cases:

Choose PRINT in your application, and make sure that the ImagePrint printer PTA driver is the 
selected printer (it will be named after the printer you installed with ImagePrint.

In the drop-down menu below the Printer 
choice area, PTA specific settings can be 
found in: 

IPPTA Profile,

IPPTA Paper 

and IPPTA Spool Options.

IMPORTANT: Since applications may locate 
these two settings windows in different 
places within the Print Dialog you may have 
to look around a bit to find them.  Typically, 
clicking the PRINTER button within the 
Print dialog will give access to a window 
containing a drop down menu containing 
the Profile and Paper settings  choices. If 
you don’t see entries for the Bitmap and 
Printer profile, you are not in the right 
place.
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PTA (Continued)
Using PTA

When printing via the PTA option, printing will be done using ImagePrint’s color management 
and print screening, but you will be using the layout and image handling features of the appli-
cation you are printing from, not those of ImagePrint. While its impossible to provide settings 
for all applications, there are some rules to keep in mind that always apply:

Color Management Settings

Application Print Dialog

Within the print dialog of the application, if given the choice, choose to let the Application 
handle Color Management, then pick Adobe 1998 as the “printer” profile in the applica-
tion’s print dialog. (The exception to this rule is Adobe Lightroom, where SRGB should be 
chosen.)  

PTA Profile Dialog

From the Application’s print dialog, navigate to the PTA PROFILE SETTINGS window 
(see Accessing PTA Settings in the previous section) and make sure the following set-
tings are in place:  

	 - 	 PRINTER: ALWAYS choose a PRINTER profile that characterizes the printer and paper 
you will be using. (Note: Choosing the printer profile will automatically select the right 
Quality and Inkset if using a profile generated by Colorbyte).

	 - 	 INPUT (Mac) Bitmap (PC): Choose a profile here that characterizes the source space 
of the data being sent from the application (typically, Adobe 1998, though in Lightroom it 
should be SRGB on Macs, Pro Photo RGB on PCs).  

Important  For the INPUT/BITMAP profile, PTA works with RGB data generated 
from the application’s color conversion--regardless of the source space of the 
images you are printing.  That means you should always set the Bitmap field to 
an RGB profile (typically, Adobe 1998) and make sure that the application uses 
the same space in its print dialog--even if the image you are printing is CMYK 
or Grayscale.

For example, in Photoshop, you should choose “Let Photoshop Determine 
Colors” in its print dialog box, and choose Adobe 1998 in the list it provides.  
Then, make sure the Input setting in our ImagePrint/IPPTA Profile Settings 
window is the same RGB profile (for example, Adobe 1998).

	 -	 PROOFER: The PROOFER setting should usually stay at NONE.  It is only used if you 
are trying to match another printer or press.  

Continued on next page
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PTA (Continued)

Using PTA (continued)

Quality and Inkset

	 - 	 Both QUALITY and INKSET are set automatically when you pick your PRINTER PROFILE 
(see above).  Do not change these unless you are using a custom Printer profile that 
does not automatically pick the correct values.

Driver resolution (DPI)

	 -	 For Epson printers this should be 360 (not 180)

Save Job as Image
	 -	 Choose this option to have PTAP create a TIFF file rather than send the job to print. You 

can also specify the folder in which the TIFF will be saved. 

Open job in ImagePrint
	 -	 This new feature causes the PTA job to be opened in ImagePrint instead of printed.  This 

can be very useful as a convenient means of placing image data from your application 
right into ImagePrint--allowing you to take advantages of ImagePrint’s extensive layout 
features.  Once opened in ImagePrint, the PTAP job can be printed from ImagePrint just 
like any ImagePrint job.

		  Before using this option, make sure to launch ImagePrint--without ImagePrint 			 
already running, no job can be sent to it.

		  Also, be aware that the image will NOT have an embedded source profile. Therefore, in  
order for proper color reproduction you must have a proper “default” RGB profile chosen 
in the PROFILE section of the ImagePrint Preferences window in the Missing Profile/
Un-colormanaged image section.  In most cases, Adobe 1998 (the default) is correct but if 
you have specified a different space in the application’s print dialog (typically in the Color 
Handling field of it’s print dialog) you must make sure to specify that same profile as your 
default.  Lightroom is a special case. When printing to ImagePrint from Lightroom set the 
default RGB profile to SRGB (Mac) or Pro Photo RGB (PC).

Continued on next page
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PTA (Continued)
Using PTA (continued)

Page Size Settings

Placing the image with exactitude on the page with PTA can be challenging, since various 
applications handle their page settings in different ways.  

When setting up your pages with PTA, remember that there are two things to consider--the 
physical paper size, which is what the PRINT SETTINGS should reflect, and the printable 
area of the page, which is what the application’s layout area should be constrained to.

For the Print Settings, always choose a page size that represents the physical size of the 
paper being printed. Choosing this can vary among platforms and applications.

	 - 	 On Windows, make sure the PAPER SIZE field in the PTA settings window repre-
sents the paper size.  (Remember, you can create custom paper sizes via the SERVER 
PROPERTIES window as explained in the “Accessing Windows PTA Settings” page ear-
lier in this chapter).

	 -	 On Macintosh, typically the Paper Size is chosen in the Page Setup window, accessed 
from the File menu of the application, although some applications place their page set-
tings in different locations.  Normally, a “Manage Custom Page Sizes” window is avail-
able from the Page Setup window that allows you to create custom sizes. (On OSX 10.5 
(Leopard) make sure to pick the page size that corresponds to roll, sheet, or borderless 
setting you are using to ensure the image is properly positioned on the page).

Within the Application you are printing from remember that the image area you are work-
ing with represents the printable area of the page, not the full paper size.  In applica-
tions that allow you to define a document size, you should specify this printable area of the 
paper--not the actual paper size--to prevent unexpected shifting or cropping of the image 
when printed.

For example, using InDesign, when printing to an Epson 4800 on letter size sheet paper, 
you should work within a layout area that reflects the printable area on sheet for that print-
er.  Most Epson printers when using sheet paper have a 1/8th inch border on the left, right 
and top, and 5/8ths inch on the bottom, so the actual printable area is 8.27 inches by 11.03 
inches.  Creating a document area that size will ensure that the image, when printed, does 
not have its edges cropped and is positioned correctly on the page.
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PTA (Continued)

TroubleShooting PTA - Windows

Jobs sent via PTA never make it to SpoolFace

	 - 	 This typically indicates a settings issue.  Check your PTA settings (in the 
ADVANCED window of the Print Dialog) to ensure that a valid PRINTER profile was 
chosen.  Remember, choosing the PRINTER profile will automatically select the 
right Inkset and Quality settings, so normally you should not change those settings. 
PROOFER should normally be left at NONE. If the settings look correct in the PTA 
settings window, try clicking each field within that settings window and re-selecting 
the entries. 

The PTA Settings window does not show ImagePrint related entries

	 - 	 This could indicate that you are not choosing the right printer (the PTA printer driver 
will be named exactly as your installed ImagePrint driver is).  Make sure the PTA 
driver is selected before clicking the ADVANCED button in the Print Dialog box.

	 - 	 If you’re sure you’re picking the right PTA driver and the Options button doesn’t 
show the right options, there may be a problem with the PTA installation.  Try going 
to Windows PRINTERS and FAXES, removing the PTA driver, then run IP SETUP to 
remove, and reinstall, your ImagePrint printer, then run the PTA Manager.exe utility 
to re-add the PTA driver. (Warning: when removing a printer, any older jobs in the 
SpoolFace window will be removed as well).

Jobs sent via PTA make it to Spoolface, but don’t print

	 - 	 Confirm that the correct settings are being selected in the Advanced Settings win-
dow accessed from your application’s Print Dialog.  The wrong Printer or Bitmap 
profile can cause jobs to fail.  Inkset and Quality are typically chosen when the 
PRINTER PROFILE is chosen, so those normally do not need to be set.  And the 
PROOFER PROFILE should in most cases be NONE.  Manually reselecting each 
entry in the Advanced window can sometimes help to reset the selections.	

	 - 	 Error 97 may indicate that you are printing more than one page from the application, 
or you are printing a multi-page spread.  Try sending just one page at a time in this 
case.  

Always remember to remove any older jobs from the top pane of the SpoolFace window, 
and make sure SpoolFace is not paused before trying any new prints.
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PTA (Continued)
TroubleShooting PTA - Windows (continued)

Adobe Lightroom issues:

	 - Colors do not look correct when printed
		  Unlike most applications, the colorspace that Lightroom outputs its job data to can 

not be changed via the Print dialog.  For Lightroom 2.0 and below, SRGB is the 
colorspace it uses, so it’s vital that in the Bitmap (Input) field of the PTA settings win-
dow, SRGB be selected to ensure PTA properly handles Lightroom’s data.

 For LightRoom 3.0 and above on the PC, Pro Photo RGB is the space Lightroom 	
 uses, so the BITMAP field of the PTA settings window should reflect that.

There have been reported differences between the Windows/Mac versions, and 32 bit vs 
64 bit, of Lightroom on some systems regarding the best color space to use for the Bitmap 
field when printing with Lightroom PTAP.  Therefore, when initially testing PTAP with your 
version of Lightroom, if you see color issues with SRGB or Pro Photo as the Bitmap, a 
quick solution may simply be to try the other color space.
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PTA (Continued)

TroubleShooting PTA - Macintosh

ImagePrint printer type does not appear in the PRINT CENTER when 
installing

	 - 	 If on OSX 10.5 (Leopard), reboot the computer, then try re-running the PTA 
installation procedure to reinstall the necessary drivers. 

Jobs sent from applications never make it to SpoolFace

	 - 	 If you have added your PTA printer in the Print Center, and picked it as your 
printer in the application, then this may be a permissions problem.  Try the fol-
lowing procedure:

Open a Macintosh Terminal window by going to the Utilities folder on 
your system (within the Applications folder) and double-clicking the 
TERMINAL application.

When the terminal window appears, type in the following command 
exactly as it appears below and hit return:

 sudo chmod -R 777 /applications/imageprint

You will usually be prompted for your Macintosh password.  Enter it and 
hit return again.  You should see no error messages.  If you do see 
any errors, the above command was likely entered incorrectly--enter it 
again, being especially careful of spacing/spelling.

Close the terminal window and try printing via PTA again.

- 		  Sometimes incorrect settings (such as no Printer profile being chosen) can 
cause a job not to make it to spoolface.  Double-check all of the settings in the 
PTA settings section of the Print dialog to ensure they are correct.
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PTA (Continued)

TroubleShooting PTA - Macintosh (continued)

Only an “ImagePrint Settings” window appears in the application’s 
Print Dialog boxes, not “ImagePrint Profile Settings” and “ImagePrint 
Paper Settings”

	 - 	 This indicates that the older PostScript method of printing through applications 
is still installed on your system.  You will need an update for the latest version 
(only available on ImagePrint 6.1 or later).  Contact ColorByte’s support dept. at 
support@colorbytesoftware.com for the necessary procedures.

The PTA settings windows are not available in the Print dialog (or 
only one of them is)

	 - 	 Reboot, and try rerunning the PTA installation procedure documented earlier in 
this chapter.  Sometimes permissions on the system prevents the proper files 
from copying in, and rebooting and re-running the script corrects the problem.

Adobe Lightroom issues:

	 - Not able to access PTA print dialog settings
		  This issue can occur with the 64 bit mode of Lightroom.  Currently, PTA only 

supports Lightroom in 32 bit mode.

	 - Colors do not look correct in print
		  The Mac version of Lightroom (at least through version 3) converts to an SRGB 

colorspace when sending to a software RIP, so it’s vital that in the INPUT (bit-
map) field of the PTA settings window, SRGB be selected to ensure PTA proper-
ly handles Lightroom’s data (This is true up to Lightroom version 3. It’s possible 
that future versions may have different requirements).



Appendix
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Appendix A - Keyboard Shortcuts
The following keyboard shortcuts can be used within ImagePrint

 

Function			    Macintosh			   Windows 

Open File Command - o Control - o
Quit Command - q Control - q
Zoom in Command -Shift - + (plus) Control - Shift - + (plus)
Zoom out Command - - (minus) Control - - (minus)
Print Command - p Control - p
Preferences Command - . (period) Not available
Hide ImagePrint Command - h Not available
Step and Repeat images Drag corner/edge of image 

while holding shift
Drag corner/edge of image 
while holding shift

Step and Repeat - Increase 
spacing between stepped/
repeated images

Drag interior of image while 
holding shift

Drag interior of image while 
holding shift

Context sensitive “mouse” 
menu

Click image while holding 
Control key

Click image while holding 
Control key

Run into a Problem?

The ImagePrint trouble shooting guide is located in 
your ImagePrint folder (or on the Technical Support 

page at www.colorbytesoftware.com) 
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Appendix B - ImagePrint as a Lightroom “External 
Editor”
Many ImagePrint customers use Adobe’s Lightroom to process and organize their imag-
es.  But… getting them from one Lightroom to ImagePrint can be a bit of a chore: Export 
the image from Lightroom, find the file on your computer, then re-open it in ImagePrint. 

Wouldn’t it be nice to avoid those extra steps and go straight from Lightroom to 
ImagePrint? Good news, you can!

Lightroom’s External Editor feature is the key. Once ImagePrint is set up as an external 
editor, you can place an image directly into ImagePrint’s layout window right from the 
Lightroom menu. 

Setting up ImagePrint as an external editor is easy. The following steps are based on 
Lightroom 4.0, but should be similar in later versions.

  �In Lightroom, choose Preferences from the top menu. Then, choose the External 
Editing tab at the top of the Preferences window. Look for the section labeled: 
Additional External Editor and click Choose. This will open a new window where 
you’ll select the ImagePrint executable file:

► �On Macintosh computers, the file you’re looking for is “ImagePrint.app” You’ll 
find it in the ImagePrint folder inside your Mac’s Application folder.

► �On Windows computers, look for the file “ImagePrint.exe”. You’ll find it in the 
ImagePrint folder which is located in your Program Files (x86) folder.

Once you find the ImagePrint executable, click Choose to lock in your choice.

 �The next thing to do is set some rules for Lightroom to follow when it sends images 
to ImagePrint.

- In the File Format drop-down, choose TIFF.

- �In the Color Space drop-down, choose your preferred source space (usually Adobe 
1998 or Pro Photo RGB).

- In the Bit-Depth drop-down, choose 16-bit.

- �For Resolution, if you don’t plan to scale the image in ImagePrint, 240 or above is 
fine. If you plan to use ImagePrint’s scaling, you may want to go higher to avoid 
losing detail.

- Finally, for Compression leave it at None
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 �Now that you’ve set up ImagePrint as an editor and set the rules that Lightroom 
will follow, you need to save your new settings as a Preset. Click the Preset drop-
down menu at the top of the Additional External Editor area and choose Save 
Current Preset. Type ImagePrint for the preset’s name. Click Create.

That’s it--ImagePrint is now an external editor for Lightroom!

To use your new preset, right-click (or control-click) an image in Lightroom and choose 
“Edit in ImagePrint”.  You can also select that option from the Photo menu at the top 
of the Develop screen. 

After choosing that option, ImagePrint will launch (if it’s not already running), and 
the Lightroom image will appear in the layout window. From there you can use 
ImagePrint’s workflow tools to position, resize and print the image. 

Remember: ImagePrint’s editing tools are always non-destructive, meaning the tweaks 
you make with ImagePrint are not saved to the file and will not appear in the original 
image back in Lightroom. 

ImagePrint as a Lightroom External Editor (continued)
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Appendix C - Printer Specific Settings
Different printers may have specific settings available.  Typically, these settings 
reflect different ink sets or ink combinations supported by ImagePrint.  Some 
printers also support Extended features, such as use of the ImagePrint Tint 
Picker, optional Paper Thickness controls and borderless printing.

Note: Unless otherwise noted, ImagePrint’s maximum print length is 327 inches.

Following is a summary of specific settings for printers supporting additional ink 
sets, or other extended features.

Canon IPG 1000

Canon IPG 2000, 4000, 6000 

Epson P600 and P800

Epson 2100 and 2200

Epson 2400 and 2880

Epson 3800/3880 (and 3850)

Epson 4000

Epson 4800, 7800 and 9800

Epson 4880, 7880 and 9880

Epson 4900, 7900 and 9900

Epson Surecolor P5000

Epson Surecolor P6000 and P8000

Epson Surecolor P7000 and P9000 Standard 

Epson Surecolor P7000 and P9000 Commercial (Violet)

Epson 7600 and 9600

Epson 7890 and 9890

Epson Surecolor P10000 and P20000

Epson 11880

Run into a Problem?

The ImagePrint trouble shoot-
ing guide is located in your 
ImagePrint folder (or on the 
Technical Support page at 
www.colorbytesoftware.com) 
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Canon IPG 1000

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

Standard Ink Sets 

 PHOTO - Full color printing utilizing Photo Black ink.
 MATTE - Full color printing utilizing Matte Black ink.

Limitations: 

This printer is limited to 25.5 inches in print length. 

This printer is not able to utilize ImagePrint’s grey profiles. To print grayscale, you should 
convert your images to grayscale or neutral RGB in Photoshop or another image pro-
cessing program and use a normal (color) profile.  The “wide gamut” tint picker can be 
used to create tint effects similar to that of the narrow gamut tint picker when using grey 
profiles. 

The Canon driver (available on the Canon website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. For Windows this must be the XPS ver-
sion of the driver. On Macintosh, do not install the printer as an “Air Print” printer.  
See the last page of the Installation chapter of this manual for more information on 
installing the driver.

Extended Features:

This printer requires the installation of the Canon driver in order to operate. On 
Windows, the driver must be the XPS version.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Margins on this printer vary depending on the type of paper (matte/photo) used. When 
switching profiles, make sure to compensate for differences in your layout caused by 
changing margins.

Borderless Printing:

Borderless is supported for Photo (not Matte Papers only). Choose Borderless in the 
Margin Styles section of the Dashboard.  For this printer type, supported borderless 
widths are (in inches):4x6, 5x7, 8x10, Letter, A4, 10x12, A3, A3+, 14x17, A2, 17x22.  

Printer Specific Settings (Continued)
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Canon IPG Pro 2000, 4000, 6000

Calibration Information:
These printers support the generation of onboard calibration tables to linearize the device based 
on the media type being used.  It is important that you calibrate your printer using the same 
paper that your profile manufacturer used when creating their profile to achieve optimum results.

All of ColorByte Software’s Canon 2000, 4000 and 6000 profiles are made after calibrating the 
printer using Canon Glossy Photo 200 or 170 media (as per Canon’s recommendations).  For 
best results it is strongly recommended that your printer be calibrated using the same media.

InkSets:
The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

Standard Ink Sets 

 PHOTO - Full color printing utilizing Photo Black ink.

 MATTE - Full color printing utilizing Matte Black ink.

Limitations: 
This printer is currently not able to utilize ImagePrint’s grey profiles. To print grayscale, 
you should convert your images to grayscale or neutral RGB in Photoshop or another 
image processing program and use a normal (color) profile.  The “wide gamut” tint picker 
can be used to create tint effects similar to that of the narrow gamut tint picker when using 
grey profiles. 

The Canon driver (available on the Canon website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. On Windows the driver must be the XPS 
version. On Macintosh, do not install the printer as an “Air Print” printer.  See the 
last page of the Installation chapter of this manual for more information on installing the 
driver.

Extended Features:
This printer requires the installation of the Canon driver in order to operate. On Windows, 
the driver must be the XPS version.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Printer Specific Settings (Continued)
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Borderless Printing:

This printer supports full borderless on roll paper. Choose Borderless in the Margin Styles 
section of the Dashboard.  For this printer type, rolls of the following width are recom-
mended for borderless:  (10”, 14”, 17”, 515mm, 594mm, 24” - Canon 2000/4000/6000)  
(36”/42”/44” - Canon 4000/6000)  (50”/54”/60” -- Canon 6000).  Rolls of the following 
width, while can be used for borderless, may have small white margins on the left and 
right sides - 8”, 257mm, 297mm, 300mm, 329mm, 16”, 420mm,  

Epson P800 and P600

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

Standard Ink Sets (using Light-Light black)

KCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Photo 
Black ink. 
KMCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Matte 
Black ink.

K Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome inkset 
with Photo Black ink (rarely used). 
K Matte Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome 
inkset with Matte Black ink (rarely used). 
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this setting.

Extended Features:

This printer supports WiFi Printing.

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Canon IPG Pro 2000, 4000, 6000 (continued)
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Borderless Printing:

This printer supports full borderless on roll and sheet paper. Choose Borderless in the 
Margin Styles section of the Dashboard.  For this printer type, supported borderless 
widths are (in inches): 3.5” x 5”, 4” x 6”, 5” x 7”, 8” x 10”, A4 (8.3” x 11.7”), letter (8.5” 
x 11”), 11” x 14”, 12” x 12”, B (11” x 17”), A3 (11.7” x 16.5”), Super B (13” x 19”) and C 
(17” x 22” - P800 only) sizes

Epson 2100/2200

The printing characteristics of the Epson 2200 and Epson 2100 are identical, and pro-
files created for them can be used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

KCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Photo 
Black ink. 
KMCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Matte 
Black ink. 
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this set-
ting. 

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Borderless Printing:

These printers support full borderless on roll and sheet paper. To enable this feature, 
choose Borderless in the Margin Styles section of the Dashboard.  For this printer type, 
supported borderless widths are (in inches): 4, 5, 8.25, 8.5, 11, 11.7 and 13.

Epson P800 and P600 (continued)
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Epson 2400/2880

Profiles:

Profiles for this printer will have the name “ep24” or “ep28” in the title.

Quality:

Only Photo (ph) quality should be used when printing with this printer.  Other quality 
choices (Best, Fine or Draft) may result in over inking.

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

KCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Photo 
Black ink. 
KMCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Matte 
Black ink.

Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this set-
ting. 

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Borderless Printing:

This printer supports full borderless on roll and sheet paper. Choose Borderless in the 
Margin Styles section of the Dashboard.  For this printer type, supported borderless 
widths are (in inches):  4, 5, 8.25, 8.5, 11, 11.7 and 13.

Printer Specific Settings (Continued)
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Epson 3800, 3880 (and 3850)

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the cor-
rect Printer Profile for the ink set used.

Standard Ink Sets (using Light-Light black)

KCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Photo Black 
ink. 
KMCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Matte 
Black ink.

K Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome inkset 
with Photo Black ink (rarely used). 
K Matte Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome 
inkset with Matte Black ink (rarely used). 
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this setting.

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, see 
the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Borderless Printing:

This printer supports full borderless on roll and sheet paper. Choose Borderless in the 
Margin Styles section of the Dashboard.  For this printer type, supported borderless widths 
are (in inches): 3.5”, 4”, 5”, 8.27” (A4 paper), 8.5” (Letter), 10”, 11”, 13”, 16”, 16.5” and 17” 
wide

Printer Specific Settings (Continued)
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Epson 4000

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

KCMYcm Pigment - Color printing using the Ultrachrome inkset with Photo Black. 
KMCMYcm Pigment - Color printing using the Ultrachrome inkset with Matte Black.

K Pigment - NOT SUPPORTED.  
K Matte Pigment - NOT SUPPORTED. 

Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this setting.

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Borderless Printing:

This printer supports left/right marginless printing on sheet, full borderless on roll. Choose 
Borderless in the Margin Styles section of the Dashboard.  For this printer type, support-
ed borderless widths are (in inches): 8, 8.5, 10, 12, 13, 14, 16, 17.

Center Margins (Centering on sheet paper)

When printing on Sheet paper, these printers have different top and bottom non-printable 
margin sizes (top 1/8 inch, bottom 5/8 inch).  In normal printing, this can cause your out-
put to appear shifted vertically on the page.  The Center Margins option can be used to 
compensate for the different sized margins, effectively “equalizing” the layout area so that 
the top and bottom margins are 5/8 inch, reducing total print area but balancing the mar-
gins so centered images will look properly centered on the physical page.   To enable this 
feature, choose Center Margins in the Margin Styles section of the Dashboard.

Printer Specific Settings (Continued)
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Epson 4800, 7800 and 9800

All profiles generated by ColorByte for the Epson 4800, 7800 and 9800 will have the desig-
nation X800 in their names.  

InkSets:

The available ink sets, and their descriptions, are listed below. Using a ColorByte 
printer profile will cause the proper selection to be automatically made for you.

Standard Ink Sets (using Light-Light black)

KCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Photo 
Black. 
KMCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Matte 
Black.

K Pigment - NOT SUPPORTED.  
K Matte Pigment - NOT SUPPORTED.  
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” pk profiles with this set-
ting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this 
setting.

Phatte Black Ink Sets (Matte black and Photo black loaded simultaneously)

KCMYcm7 Pigment - Full color printing utilizing the Ultrachrome inkset with Photo 
Black ink (no light-light black). 
KMCMYcm7 Pigment - Full color printing utilizing the Ultrachrome inkset with 
Matte Black ink (no light-light black). 
 
Gray7 Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink (no light-light black).  Only use “Gray” pro-
files with this setting.  
Gray7 Matte Pigment - Grayscale printing with Tint Picker enhancements, utiliz-
ing the Ultrachrome inkset with Matte Black ink (no light-light black).  Only use 
“Gray”  profiles with this setting. 

Printer Specific Settings (Continued)
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Extended Features:

These printers support the use of ImagePrint’s Phatte Black mode, allowing you to load 
Matte Black ink in place of the standard light-light black.  This mode allows you to switch 
between photo black and matte black printing without purging your inks, with no loss in 
image quality.  

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, see 
the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Borderless Printing:

These printers support left/right marginless printing on sheet, full borderless on roll. To 
enable this feature, choose Borderless in the Margin Styles section of the Dashboard.  For 
this printer type, all printers support borderless widths (in inches) of: 8.3, 10, 12, 14, 16.   
In addition to these sizes, the 4800 printers support a 13 and 17 inch wide borderless 
size, the 7800/9800s support 20 and 24 inch borderless, and the 9800s support 36 and 44 
inch borderless.

Center Margins (Centering on sheet paper)

When printing on Sheet paper, these printers have different top and bottom non-printable 
margin sizes (top 1/8 inch, bottom 5/8 inch).  In normal printing, this can cause your out-
put to appear shifted vertically on the page.  The Center Margins option can be used to 
compensate for the different sized margins, effectively “equalizing” the layout area so that 
the top and bottom margins are 5/8 inch, reducing total print area but balancing the mar-
gins so centered images will look properly centered on the physical page.   To enable this 
feature, choose Center Margins in the Margin Styles section of the Dashboard -- the page 
area will update to show the equalized margins.

Epson 4800, 7800 and 9800 (continued)
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Epson 4880, 7880 and 9880

All profiles generated by ColorByte for the Epson 4880, 7880 and 9880 will have the designation 
X880 in their names.  

InkSets:

The available ink sets, and their descriptions, are listed below. Using a ColorByte 
printer profile will cause the proper selection to be automatically made for you.

Standard Ink Sets (using Light-Light black)

KCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Photo 
Black 
KMCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Matte 
Black 
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Photo Black ink.  Only use “Gray” pk profiles with 
this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, uti-
lizing the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles 
with this setting.

Phatte Black Ink Sets (Matte black and Photo black loaded simultaneously)

KCMYcm7 Pigment - Full color printing utilizing the Ultrachrome inkset with 
Photo Black ink (no light-light black). 
KMCMYcm7 Pigment - Full color printing utilizing the Ultrachrome inkset with 
Matte Black ink (no light-light black). 
Gray7 Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Photo Black ink (no light-light black).  Only use 
“Gray” profiles with this setting  
Gray7 Matte Pigment - Grayscale printing with Tint Picker enhancements, 
utilizing the Ultrachrome inkset with Matte Black ink (no light-light black).  Only 
use “Gray”  profiles with this setting. 

Extended Features:

These printers support the use of ImagePrint’s Phatte Black mode, allowing you 
to load Matte Black ink in place of the standard light-light black.  This mode allows 
you to switch between photo black and matte black printing without purging your 

Printer Specific Settings (Continued)
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inks, with no loss in image quality.  

IMPORTANT: The Epson 4880 will not accept “modified” phatte black cartridges (car-
tridges with the smart chip altered to appear as lite-lite).  While Phatte black mode is 
supported on that printer, use of it with the 4880 requires manually modifying a Matte 
Black cartridge by replacing it’s smart chip with a chip from a lite-lite cartridge, and then 
re-setting the ink count. (Note that the 7880 and 9880 modified cartridges will accept 
modified phatte cartridges with no problem--only the 4880 will not.)

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Borderless Printing:

These printers support left/right marginless printing on sheet, full borderless on roll. To 
enable this feature, choose Borderless in the Margin Styles section of the Dashboard.  
For this printer type, all printers support borderless widths (in inches) of: 8.3, 10, 12, 
14, 16.   In addition to these sizes, the 4880 printers support a 13 and 17 inch wide 
borderless size, the 7880/9880s support 20 and 24 inch borderless, and the 9880s sup-
port 36 and 44 inch borderless.

Center Margins (Centering on sheet paper)

When printing on Sheet paper, these printers have different top and bottom non-printable 
margin sizes (top 1/8 inch, bottom 5/8 inch).  In normal printing, this can cause your 
output to appear shifted vertically on the page.  The Center Margins option can be used 
to compensate for the different sized margins, effectively “equalizing” the layout area so 
that the top and bottom margins are 5/8 inch, reducing total print area but balancing the 
margins so centered images will look properly centered on the physical page.   To enable 
this feature, choose Center Margins in the Margin Styles section of the Dashboard -- the 
page area will update to show the equalized margins.

Epson 4880, 7880 and 9880 (continued)
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Epson 4900, 7900 and 9900

All profiles generated by ColorByte for the Epson 4900, 7900 and 9900 will have the designation X900 
in their names.  

IMPORTANT NOTE ON PROFILING:  Currently, these printers require special lineariza-
tions when profiling to control ink usage.  Before attempting to create your own custom 
calibrations, contact ColorByte support for information regarding procedures.

InkSets:

The available ink sets, and their descriptions, are listed below. Using a ColorByte 
printer profile will cause the proper selection to be automatically made for you.

Standard Ink Sets (using Light-Light black)

KCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Photo 
Black 
KMCMYcm Pigment - Color printing utilizing the Ultrachrome inkset with Matte 
Black

K Pigment - NOT SUPPORTED.  
K Matte Pigment - NOT SUPPORTED.  
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” pk profiles with this 
setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utiliz-
ing the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with 
this setting.

Borderless Printing:

These printers support left/right marginless printing on sheet, full borderless on 
roll. To enable this feature, choose Borderless in the Margin Styles section of the 
Dashboard.  For this printer type, all printers support borderless widths (in inches) 
of: 10, 12, 14, 16.   In addition to these sizes, the 7900/9900 support 20 and 24 
inch borderless, and the 9900s also support 36 and 44 inch borderless.

Profiles

(See the note on custom profiles, above)

Printer Specific Settings (Continued)
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Unlike most other Epson printers, the Quality modes supported by the 4900/7900/9900 
are designated by name, not actual droplet size.  Therefore, the printer profiles for this 
printer will use the following designations at the end of the filenames to denote the 
Quality they were created for:

 best	 for Best Quality (2880) mode (NOT SUPPORTED AT THE TIME OF 	
 						     THIS DOCUMENTATION)

 ph	 Photo Quality (1440) mode

NOTE: Due to these printer’s use of variable droplet sizes (which enhances the smooth-
ness of the print) ColorByte recommends Photo Quality mode for most output.

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Center Margins (Centering on sheet paper)

When printing on Sheet paper, these printers have different top and bottom non-printable 
margin sizes (top 1/8 inch, bottom 5/8 inch).  In normal printing, this can cause your 
output to appear shifted vertically on the page.  The Center Margins option can be used 
to compensate for the different sized margins, effectively “equalizing” the layout area so 
that the top and bottom margins are 5/8 inch, reducing total print area but balancing the 
margins so centered images will look properly centered on the physical page.   To enable 
this feature, choose Center Margins in the Margin Styles section of the Dashboard -- the 
page area will update to show the equalized margins.

Matte Black - Photo Black ink usage:

The 4900, 7900 and 9900 require that you select the proper black ink via the front panel 
of the printer.  Make sure to switch to Matte black when using a Matte black (MK) profile, 
and switch to Photo black when using a Photo black (PK) profile.  

Epson 4900, 7900 and 9900 (continued)
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Epson Surecolor P5000

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select the 
correct Printer Profile for the ink set used.

Photo - Color printing using the Ultrachrome inks with Photo Black ink. 
Matte - Color printing using the Ultrachrome inks with Matte Black ink. 

Extended Features and Limitations: 

The Epson driver (available on the Epson website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. On Macintosh, do not install the print-
er as an “Air Print” printer. See the last page of the Installation chapter of this manual 
for more information on installing the driver.

Borderless Printing: 

Full borderless printing is supported on rolls - 10”, 11.8”, 13”, 14”, 16” and 17” wide. 
Borderless on 8”, 11” and 16.5” wide rolls requires use of the borderless spacer.

Epson Surecolor P6000/P8000 

Profiles:

The printing characteristics of the Epson Surecolor P6000 and Epson Surecolor P8000 
are identical, and profiles created for them can be used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select the 
correct Printer Profile for the ink set used.

Photo - Color printing using the Ultrachrome inks with Photo Black ink. 
Matte - Color printing using the Ultrachrome inks with Matte Black ink.

Extended Features and Limitations: 

The Epson driver (available on the Epson website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. On Macintosh, do not install the print-
er as an “Air Print” printer.  See the last page of the Installation chapter of this manual 
for more information on installing the driver.

Printer Specific Settings (Continued)
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Borderless Printing: 

Full borderless printing is supported on rolls at widths of: 10”, 11.8”, 13”, 16”, 17”, 20.3”, 
23.4”, 24”, 33.1”*, 36”*, 44”*  

*SC-P8000 only

Epson Surecolor P7000/P9000 Standard 
(with lite-lite black)

Profiles:

The printing characteristics of the Epson Surecolor P7000 and Epson Surecolor P9000 
are identical, and profiles created for them can be used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select the 
correct Printer Profile for the ink set used.

Photo - Color printing using the Ultrachrome inks with Photo Black ink. 
Matte - Color printing using the Ultrachrome inks with Matte Black ink. 

Extended Features and Limitations: 

The Epson driver (available on the Epson website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. On Macintosh, do not install the print-
er as an “Air Print” printer. See the last page of the Installation chapter of this manual 
for more information on installing the driver.

Borderless Printing: 

Full borderless printing is supported on rolls at widths of: 10”, 11.8”, 13”, 16”, 17”, 20.3”, 
23.4”, 24”, 33.1”*, 36”*, 44”*  

*SC-P9000 only

Epson Surecolor P6000/8000 (continued)
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Epson Surecolor P7000/P9000 Commercial 
(with Violet in place of lite lite black)

Profiles:

The printing characteristics of the Epson Surecolor P7000 and Epson Surecolor 
P9000 Commercial (Violet) version are identical, and profiles created for them can be 
used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select 
the correct Printer Profile for the ink set used.

Photo - Color printing using the Ultrachrome inks with Photo Black ink. 
Matte - Color printing using the Ultrachrome inks with Matte Black ink. 

Extended Features and Limitations: 

The Epson driver (available on the Epson website) must be installed for this printer 
in addition to ImagePrint to allow for connectivity. On Macintosh, do not install the 
printer as an “Air Print” printer. See the last page of the Installation chapter of this 
manual for more information on installing the driver.

Borderless Printing: 

Full borderless printing is supported on rolls at widths of: 10”, 11.8”, 13”, 16”, 17”, 
20.3”, 23.4”, 24”, 33.1”*, 36”*, 44”*  

*SC-P9000 only

Epson 7600/9600

The printing characteristics of the Epson 7600 and Epson 9600 are identical, and 
profiles created for them can be used interchangeably.

InkSets:

KCMYcm Pigment - Color printing using the Ultrachrome inks with Photo Black ink. 
KMCMYcm Pigment - Color printing using the Ultrachrome inks with Matte Black 

Printer Specific Settings (Continued)
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ink.

KCMYcm Dye - Full color printing utilizing the DYE inkset.

K Pigment - NOT SUPPORTED.   
K Matte Pigment - NOT SUPPORTED. 

Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment- Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Matte Black ink. Only use “Gray” profiles with this setting.

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Borderless Printing:

These printers support left/right marginless printing only on sheet, full borderless on roll. 
To enable this feature, choose Borderless in the Margin Styles section of the Dashboard.  
For this printer type, supported borderless widths are (in inches): 8, 10, 12, 14, 16, 20, 
24.  (plus 36 and 44 on 9600 only).

Center Margins (Centering on sheet paper)

When printing on Sheet paper, these printers have different top and bottom non-print-
able margin sizes (top 1/8 inch, bottom 5/8 inch).  In normal printing, this can cause 
your output to appear shifted vertically on the page.  The Center Margins option can be 
used to compensate for the different sized margins, “equalizing” the layout area so the 
top and bottom margins are 5/8 inch, reducing total print area but balancing the mar-
gins.   To enable this feature, choose Center Margins in the Margin Styles section of the 
Dashboard. 

Printer Specific Settings (Continued)
Epson Surecolor P7000/P9000 Commercial (continued)
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Epson 7890/9890 

Profiles:

The printing characteristics of the Epson 7890 and Epson 9890 are identical and pro-
files created for them can be used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select 
the correct Printer Profile for the ink set used.

Photo - Color printing using the Ultrachrome inks with Photo Black ink. 
Matte - Color printing using the Ultrachrome inks with Matte Black ink. 

Extended Features and Limitations: 

This printer is not currently able to utilize ImagePrint’s grey profiles. That feature 
is expected to be added in a future update.  To print grayscale, you should convert 
your images to grayscale or neutral RGB in Photoshop or another image processing 
program and use a normal (color) profile.  The “wide gamut” tint picker can be used 
to create tint effects similar to that of the narrow gamut tint picker when using grey 
profiles. 

The Epson driver (available on the Epson website) must be installed for this printer 
in addition to ImagePrint to allow for connectivity. On Macintosh, do not install the 
printer as an “Air Print” printer.  See the last page of the Installation chapter of this 
manual for more information on installing the driver.

Borderless Printing: 

Full borderless printing is supported on rolls at widths of:  10”, 13”, 16”, 17”, 24”, 36”*, 
44”*

* 9890 only

Printer Specific Settings (Continued)

Epson Surecolor 7600/9600 (continued)
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Epson Surecolor P10000/P20000 

Profiles:

The printing characteristics of the Epson Surecolor P10000 and Epson Surecolor 
P20000 are identical, and profiles created for them can be used interchangeably.

InkSets:

The available ink sets, and their descriptions, are listed below:  Make sure to select the 
correct Printer Profile for the ink set used.

KCMYcm Pigment - Color printing using the Ultrachrome inks with Photo Black ink. 
KMCMYcm Pigment - Color printing using the Ultrachrome inks with Matte Black ink. 

Extended Features and Limitations: 

This printer is not currently able to utilize ImagePrint’s grey profiles. That feature is 
expected to be added in a future update.  To print grayscale, you should convert your 
images to grayscale or neutral RGB in Photoshop or another image processing program 
and use a normal (color) profile.  The “wide gamut” tint picker can be used to create tint 
effects similar to that of the narrow gamut tint picker when using grey profiles. 

The Epson driver (available on the Epson website) must be installed for this printer in 
addition to ImagePrint to allow for connectivity. On Macintosh, do not install the print-
er as an “Air Print” printer. See the last page of the Installation chapter of this manual 
for more information on installing the driver.

The non-printable margins on these printers can vary according to the media type. 
Please consult your printer documentation for more information on what margins are 
allowed with your specific media.

For this printer type, supported borderless widths are (in inches): 10, 11.8, 13, 16, 17, 
20.3, 24, 33, 36, 44, (50, 54, 60 for the P20000 only).  

For these printers, user defined pages should be larger than 13.5 for roll paper to avoid 
paper waste.

Printer Specific Settings (Continued)
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Epson 11880

InkSets:

The available ink sets, and their descriptions, are listed below. Make sure to select the 
correct Printer Profile for the ink set used.

Standard Ink Sets

KCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Photo 
Black ink. 
KMCMYcm Pigment - Full color printing utilizing the Ultrachrome inkset with Matte 
Black ink.

K Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome inkset 
with Photo Black ink (rarely used). 
K Matte Pigment - NOT SUPPORTED. Black only printing utilizing the Ultrachrome 
inkset with Matte Black ink (rarely used). 
 
Gray Pigment - Grayscale printing with Tint Picker enhancements, utilizing the 
Ultrachrome inkset with Photo Black ink.  Only use “Gray” profiles with this setting. 
Gray Matte Pigment - Grayscale printing with Tint Picker enhancements, utilizing 
the Ultrachrome inkset with Matte Black ink. Only use “Gray” mk profiles with this 
setting.

Profiles

Unlike most other Epson printers, the Quality modes supported by the 11880 are des-
ignated by name, not droplet size.  Therefore, the printer profiles for this printer will use 
the following designations in their names to denote the Quality they were created for:

 best	 for Best Quality (2880) mode

 ph	 Photo Quality (1440 8 pass) mode

 sf	 SuperFine Quality (1440 4 pass) mode

Due to its use of variable droplet sizes (which enhances the smoothness of the print) 
ColorByte recommends Photo Quality mode for most output.

Extended Features:

This printer supports the use of the ImagePrint Tint Picker when using the Gray or Gray 
Matte inkset with a Tint Picker Gray printer profile. For details on using the Tint Picker, 
see the Tint Picker section in Chapter 9, Correction Tools.

Epson P10000/P20000 (continued)
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Paper thickness controls are available via the Media Type menu (accessed by clicking 
Options in the Print Setup section of the Dashboard.)

Maximum print length is 1000 inches.

Borderless Printing:

This printer supports left/right marginless printing on sheet, full borderless on roll. To 
enable this feature, choose Borderless in the Margin Styles section of the Dashboard.  
For this printer type, supported borderless widths are (in inches): 10, 13, 16, 17, 24, 36, 
44, 50 and 54.

Epson 11880 (continued)
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Appendix D - Networked Printer Settings
Getting the Printer IP Address

When printing to a printer via an Ethernet connection, the TCP/IP communication protocol will be used, 
which depends on each device on the network having a valid, unique IP Address. 

You will need to provide the IP Address of the printer to IPSetup during installation so ImagePrint can 
communicate with it at print time.  Although different printers and network cards may vary, some method of 
accessing the ip address, either by printing a status page or via the front panel of the device, will be avail-
able.

Front Panel: Many new printers allow you to see and specify the IP Address via the front panel controls on 
the printer.  Consult your printer’s manual for instructions for how to do this.

Status Page: In cases where you are not able to use the front panel to set the IP Address, check for a 
small or recessed button beside the port where the network cable plugs into the printer.  Pushing this but-
ton for one second will cause most printers to output a page showing their current settings, including the IP 
Address. (Make sure to load scrap paper on the printer--not expensive art paper!)

The IP Address will consist of 4 numbers, each between 0 and 255, separated by periods.  This is 
the number you will need to use in the Network fields when installing the printer with IPSetup.

Checking connectivity

Once you have the printer’s IP Address, type it into the address field of a web browser (like Internet 
Explorer, Safari or Firefox). Just type the 4 numbers of the ip address, separated by periods, into the 
address field--no other text (like http://) is needed.  You should see the Printer’s HTML setup screen. Using 
a web browser in this way is a good test of your computer’s TCP/IP connectivity to the printer--if the brows-
er fails to show the printer’s setup screen, then you know you have a TCP/IP communications problem.  

Even if you can print to the printer via the manufacturer’s driver, it does not necessarily mean you 
have TCP/IP communication to the printer.  TCP/IP is required by ImagePrint when printing to a 

printer connected via Ethernet.

Different IP Address sub-nets between printer and computer: Communication problems can 
arise if the IP Address numbering scheme of the printer is different than that of computer.  For 
example, if the printer’s IP Address is: 192.168.0.12, and your computer’s is 30.40.16.8, then it is 
likely there will be no communication via TCP/IP between the devices.  Compare the IP Address 
of your computer to that of your printer.  If the first 3 sets of numbers are not the same, this may 
be the problem (the last number should always be unique for each device). In cases where the 
network schemes differ, you may not be able to communicate with the printer until the IP Address 
is changed to one that is compatible with the rest of your network. 
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Networked Printer Settings (cont.)

You can check the ip address of your computer on Macs via the Network Control Panel in 
System Preferences, on PC’s it is available in the TCP/IP properties of your network card.

Changing the printer’s IP Address (if needed)

Front panel: If the printer allows you to change the IP Address via the front panel on the printer, 
changing the address is relatively easy--consult your printer’s manual for instructions.

Manufacturer’s utility: In cases where you can’t set the IP Address via the front panel,  you 
may need to use a setup utility provided by the manufacturer.  For Epson printers, the Net Assist 
utility is used to setup the network parameters on your printer.  That utility is provided on the 
Epson printer setup cd and is also available for download from the Epson web page.

Reset the printer to factory defaults: If your network uses a router, another method of chang-
ing the printer’s IP Address is to reset the printer to its factory default settings by holding down 
the recessed button on the network card of the printer while turning the printer off, then on.  
When the printer comes back up, it will default to DHCP mode, which will cause it to get a new 
IP Address from the router which should then be correct for your network.  Press the recessed 
button again (for 1 second) to output a new status page showing the current IP Address and try 
to reach the again with the new IP Address in a web browser.

Setting the printer to a Manual (Static) IP Address

Once you have the printer’s IP Address (and have used it to specify the connection to the printer in IP 
Setup), it is important that this IP Address doesn’t change in the future.  Otherwise, ImagePrint will no lon-
ger be able to find the printer.  An IP Address that doesn’t change is called “Static”, or “Manual”.

To set your printer to a Manual IP Address, log into the printer via a web browser as described earlier 
in this section by putting the IP Address of the printer into the browser’s address field and pressing the 
return key.  If the printer is reachable on your network, you should get a login window, with access to the 
printer’s configuration settings.

Once you are on the printer’s setup page, you need to specify the “Method for Acquiring the IP 
Address”.  For most printers this setting is in the TCP/IP portion of the  Configuration section of the 
Printer Setup window, however the specific location and terminology may vary for some printers.   The 
choices are typically:   AUTO or MANUAL  Make sure it is set to MANUAL to prevent the IP Address from 
changing each time the printer is restarted.  After changing the setting (if necessary) apply the settings-
-usually that is done via the SUBMIT button at the bottom of the setup screen.  

Note: Most printer setup screens will ask for a user name and/or password when applying new 
settings.  Unless you have previously set a password for your printer, the entries should be left 
blank for most printers as that is the default username and password.  If that fails, try using the 

name “admin” for the username and nothing for the password.
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Appendix E - Phatte Black
ImagePrint version 6.1 introduced Phatte Black, a new printing option that enables you to utilize 
both Photo Black (pk)  and Matte Black (mk) inks at the same time on your Epson 4800/4880, 
7800/7880 or 9800/9880.  This amazing feature means that, without the expense and inconve-
nience of purging your inks, you can switch between glossy and matte printing with no loss in qual-
ity!

The following section provides answers to common questions about Phatte Black in a FAQ 
(Frequently Asked Questions) format.  Then the procedures for setting up ImagePrint and your 
printer to use Phatte Black printing are described.

1. Phatte Black FAQ
What advantages are there to printing in Phatte Black Mode?

With the Phatte Black option, you don’t need to purge inks when switching between printing that 
requires the matte black ink and the photo black ink.  This saves money, as any purge results in the 
wastage of ink (as much as $70.00 worth for each such switch).  Purging also takes time--fifteen 
minutes or so.  With Phatte Black, switching between Matte and Glossy printing is just a matter of 
loading the right paper.

How does Phatte Black Mode work?

To utilize this feature, a modified Matte Black cartridge is used in the “light-light” cartridge slot of 
your printer.  Once loaded, you’ll need to print a “purge” file that will clear the ink lines of remain-
ing light-light ink.  For detailed instructions, see the second part of this section, Phatte Black 
Quickstart.

Will not having the light-light black ink affect print quality?

Other than a slight increase in bronzing on Grayscale prints on glossy papers, the quality 
is the same.

Amazingly, the light-light black offers very little when printing with ImagePrint, as our 
advanced ink mixing and screening already provides the improved tonality that this new 
ink was put in place to provide   While this ink may help avoid the deficiencies of other 
less sophisticated printing methods, ImagePrint’s technology doesn’t need it to get results 
far superior to the output of any other driver or RIP. 

What is a “modified” Matte Black cartridge?

All Epson K3 ink cartridges utilize “smart chip” technology that allows the printer to read 
each ink cartridge to determine its ink type, capacity, remaining ink levels, etc.  A modified 
cartridge is one whose smart chip has been altered to appear different to the printer.  

Modifying the cartridge means that the smart chip will be changed, or replaced, to 
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make it look like a light light black cartridge to the printer.  It may also be necessary to snip 
off the small, plastic fin on the top of the cartridge that physically “keys” the cartridge to the 
proper slot on the printer.

How do I obtain a modified Matte Black cartridge?

Your ColorByte ImagePrint dealer may stock modified Matte black cartridges, which you can 
then purchase as you would any other ink cartridge.  If your dealer doesn’t stock these car-
tridges, contact ColorByte’s Sales dept. to obtain the name of a dealer who can provide them.

Another method of modifying the cartridge involves replacing the Matte black smart chip on 
your cartridge with a light light black one.  One way of doing this is to simply remove the chip 
from an existing light-light black cartridge and use it on the matte cartridge.  (When the car-
tridge is empty, the chip will tell the printer that there is no more ink in it--to avoid this, and 
reuse the chip, “chip resetters” that reset the chip to show full ink are available from many 
vendors.)  Currently replacing the chip is the only way to modify a cartridge for use with 
the Epson 4880.

Note that ColorByte can offer no support for modifying the cartridge itself--that support is han-
dled through the provider of the chip.

Will this void my Epson warranty?

This process uses Epson inks and Epson cartridges, and is not modifying the printer in any 
way.  That said, ColorByte doesn’t speak for Epson.  If you have concerns, you may want to 
contact Epson before using modified cartridges.

Can I still use my Epson driver with Matte and Photo black loaded?

No.  With both the Matte and Photo black cartridges loaded, the Epson driver will not print cor-
rectly as it has no support for that combination.  You can only use this mode with ImagePrint. 
(The Epson status monitor should work fine however, and you can always choose to return to 
the standard ink configuration if you need to use the Epson driver.)

Will I need new profiles?

ImagePrint will provide profiles for Phatte Black mode for both color and grayscale printing. These pro-
files will be designated with the letters “DK” instead of the normal “pk” or “mk” in the title.  Since the pro-
files are made at the same time as the “standard mode” profiles, there should be a Phatte Black profile 
for every standard profile we provide.  

Can I still make my own custom color profiles for use with ImagePrint?

Yes.  Printing a calibration target while in Phatte mode is exactly the same as with the normal ink con-
figuration--just make sure to use the proper (Phatte) ink selection in ImagePrint’s Print dialog.

Phatte Black Mode FAQ (cont.)
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How do I switch to Phatte Black mode within ImagePrint?

Switching to Phatte Black mode in ImagePrint is as simple as picking a Phatte Black (DK) profile as the 
Printer/Paper profile.  When the software senses such a profile has been chosen, it will switch to Phatte 
Black mode automatically.  

Can I go back to the standard K3 ink configuration after using Phatte Black?

It’s easy to go back to the standard K3 ink set after using Phatte Black.  Just put the light-light black 
cartridge back in the light light slot, and print the purge file again to clear the excess matte ink from the 
lines (you will find you need to print more this time, though, as the matte black is heavier and takes lon-
ger for the last traces to clear the lines). 

Do you still support the standard mode of printing with K3 inks (including light-light)

Of course.  Printing with the K3 inks in their standard configuration is still the “default” way of  printing 
with ImagePrint, and is fully supported.  

Can I initially load my printer with a phatte black cartridge, without ever inserting the light-light black

Yes.  You can start with the Phatte Black cartridge in the light light slot and the Photo Black cartridge 
in the black slot when inking your printer for the very first time.  Initializing the printer this way will allow 
you to avoid the Phatte purge procedure entirely.  You’ll be ready to print with Phatte profiles right 
from the start.

Phatte Black Mode FAQ (cont.)

Run into a Problem?

The ImagePrint trouble shooting guide is located in 
your ImagePrint folder (or on the Technical Support 

page at www.colorbytesoftware.com) 
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Appendix  (cont.)

2. Phatte Black Quick Start  

Follow the below steps to setup your printer and ImagePrint for printing with Phatte 
Black. These steps assume you have already acquired the proper Phatte Black car-
tridge for your printer.

 If this is a new printer that has never been loaded with inks, you can skip steps 
2 and 3 as there is no need to purge old ink from the light-light slot.  Just load the 
phatte cartridge in the light-light slot and make sure photo black is in the black slot 

when initializing the printer.

Step 1    Load the modified Matte Black Cartridge into your printer

First, make very sure that Photo Black is loaded in the regular black cartridge slot 
of the printer and your printer is online and ready.  Then, insert the modified “phatte” 
matte black cartridge into the light-light black slot of the printer.  

Step 2    Acquire the Purge profile and Purge TIFF file

Once the modified (Phatte) Matte Black Cartridge has been loaded in the printer, it is 
necessary to clear the remaining light-light black inks from the tubing of the printer. 
(This is a one time only step). To accomplish this, two files are needed: a special TIFF 
file and a special color profile.  The TIFF file will be printed with the profile in place 
as the Printer/Paper profile--this will cause  only the light-light black ink is used when 
printing this file, so no other ink is wasted. 

The purge TIFF file and the special printer profile needed for printing it are included 
in current ImagePrint cd’s and downloads.  After installing ImagePrint, you’ll find the 
purge profile in the Color folder, within the ImagePrint folder of your system.  The 
purge tiff file is found in the Test Images folder within the ImagePrint folder.  (If not 
available, you can download the files from the FTP link on ColorByte’s Technical 
Support page at www.colorbytesoftware.com)

Continued
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Step 3    Print the Purge File

• Launch ImagePrint. 

Note: Crop marks and annotations should not be used when printing the purge file or 
errors may result.  If you have those features enabled in ImagePrint, make sure to turn 

them off now.

• Choose the proper page size  

To properly purge the inks, it’s necessary to print about 1700 square inches. To accom-
plish this, you may need to create a user defined page size in ImagePrint that fits those 
dimensions (about 20 letter size sheets).  You can set up your custom page size in 
whichever way best accommodates your media.  A few common configurations are:

       -- For 44 inch wide rolls:  A custom size of 44 wide, 34 inches high

       -- For 24 inch wide rolls: A custom size of 24 wide, 70 inches high

       -- For 8.5x11 sheets: Use letter as the paper size, and print the purge file 20 times.

• Expand the Profiles section of the ImagePrint Dashboard.

- Select “Choose by Profile” and select the profile called “x800 Ink Purge 720” 
if printing on the 4800, 7800 or 9800.  Choose “x8800 Ink Purge 720” if printing 
on the 4880, 7880 or 9880.

• Access the ImagePrint Preferences window (Under the ImagePrint menu on Mac, the 
File menu on Windows).

- In the Profiles section of the Preferences window, select NONE in the RGB 
field of the Missing Color Profile section. (Make a note of what the previous 
setting was so you can go back to that setting later).

• Using the ImagePrint file browser, or via the File->Open command, locate open the 
“x800_llk_purge.tif” file from your Test Images folder (within the ImagePrint folder).  The 
file will appear red and black or blank on the screen--that’s normal--it will print with the 
light-light black ink.

• Choose “FILL”, from the ImagePrint floating tool palette.

Phatte Black Quickstart    (cont.)

Continued
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• Print the file using the normal ImagePrint printing procedures.  

Once done, the ink lines will be purged, and you will be ready to print using Phatte 
Black mode.

When the print is done, remember to return the Missing Color Profile->RGB setting of 
the Color Management window  to the setting it had before you changed it to NONE.

Step 4    Set up ImagePrint for Phatte Black Mode printing

Printing in Phatte Black mode with ImagePrint is just a matter of choosing the proper 
Printer/Paper profile in ImagePrint’s Color Management window.

If using the Profile Valet, just make sure to only select “Phatte” as the profile type.

If not using the Profile Valet, the Phatte Black mode profiles will have a “DK” in their 
titles (instead of “pk” or “mk”).  These profiles can be downloaded using the Profile 
Manager, the Profile utility automatically installed in your ImagePrint folder.

Once a profile is in the Color folder, you can choose it as your Printer/Paper profile 
in ImagePrint’s Color Management window.  When a profile is picked in this way, 
ImagePrint will automatically switch to Phatte Black Mode.  No other changes need to 
be made.  You can now switch between Photo Black and Matte Black printing by pick-
ing the right Phatte Black (DK) Profile for the Media you plan to use, and loading the 
desired paper in the printer.

Going back to the standard ink configuration

If you ever need to go back to the standard (non-phatte black) ink configuration, just 
follow the above steps as before, but with the Epson Light Light cartridge in the Light 
Light slot instead of the Phatte black cartridge.  You may find that more scrap paper is 
needed to purge the ink line than when switching to phatte but once the scrap sheets 
began to print significantly lighter (usually after 30 letter sized sheets) then the line is 
clear of the matte ink and is back to the normal ink configuration.

Phatte Black Quickstart    (cont.)
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Appendix F - Creating your own profiles  
With ImagePrint’s collection of excellent paper profiles, most users find there’s no advan-
tage to creating their own profiles.  However, for those who still prefer the ability to create 
custom RGB or CMYK profiles for their printer using off the shelf profiling software.  Its 
easy to do by following the below steps.  (These steps assume you are generating an 
RGB profile, which is recommended.  CMYK profiles require slightly different settings.)

Remember--if ColorByte does not have a profile available for a paper that is valid for your 
printer, we may make it for free.  Contact ColorByte’s support dept. for more information 
(make sure to include the exact paper name, and the printer you are using, along with 

your 6 digit dongle number) 

Important: Only color profiles can be created in this way.  ImagePrint’s grayscale 
profiles are non-standard ICC profiles, and can only be created by ColorByte.

Important note for Canon Pro 1000, 2000, 4000, 6000 and Epson 4900, 7900 and 
9900, P5000, P6000, P7000, P8000, P9000, P10000 and P20000 users: These printers 
require specialized linearizations (recipes) to control inking.  Because of this, custom pro-
file generation require additional steps.  Before attempting to create calibrations for, please 
contact ColorByte technical support for information on how to proceed.

Step 1   Turn off color management

	 - 	 In the PROFILES section of the Dashboard choose and apply a profile that uses 
the type of black ink (matte or photo) you will be using and one that is close in 
thickness to your actual paper. Though the profile you apply won’t be used for 
Color Management, it will be used to tell the printer what ink configuration and 
paper feed controls to use.

	 - 	 In the PREFERENCES window (found under the View menu on Windows, under 
the ImagePrint menu on Macs). Make sure “Untagged Image/Missing Profile” sec-
tion of the Preferences->Profile area is set to NONE in the RGB field. Also in that 
window, make sure the “Simulation Setup” profile is set to NONE.	

     -     �When printing a calibration target, no Color Correction Tools such as Tonal curves 
or Histograms should be in use.

Step 2.  Open your profiling target image

	 - 	 Open the profiling target you plan to use into Imageprint using ImagePrint’s Image 
Strip or the File->Open command.  Make sure you pick a page size that matches 
what’s loaded on the printer and that accommodates the size of the target

(Continued on next page)
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Step 3   Choose the inkset and media type, then print

	 - 	 Choose PRINT SETUP from the Advanced Section of the Dashboard.

	 - 	 Choose OPTIONS, and make sure you have selected a Media Type that 
matches (in thickness) closely to the paper you are using, then click OK

	 - 	 Back in the PRINT SETUP section make sure the inkset is correct for 
the paper/ink combination you are using.  For information on the different 
ink sets available for your printer, check the Printer specific setting in the 
Appendix of this  manual.  (Note that for Phatte Black printing on Epson K3 
printers, the inkset choices will be the ones with “7” in the title).

	 - 	 Also in the PRINT SETUP area set the print Quality you plan to use (720, 
1440, 2880, photo, best, etc.) For more information on quality settings, see 
the Printing section of this manual.	

	 - 	 Finally,  choose PRINT at the top of the Dashboard to have the target sent to 
the printer.

Step 4  Use your new profile

	 -  	 Once you have printed the profile target, create the profile in the normal way 
using your profiling software. 

IMPORTANT: ImagePrint only works with version 2 ICC profiles.  Most pro-
filing software allows saving to version 2 or 4--make sure your profiles are 

created as version 2. 

	 - 	 To use the profile within ImagePrint, copy it to the COLOR folder within the 
ImagePrint folder on your system.  

On Macs, this folder is in:  /Applications/ImagePrint

On Windows: In your Windows start menu, choose the ColorByte 
Software folder in your list of programs and choose COLOR FOLDER to 
open the folder.

	 - 	 Restart ImagePrint, and choose the new profile as the PRINTER/PAPER 
profile in the PROFILE section of the Dashboard (using the Choose by 
Profile method--NOT the Profile Valet) 

 

Unlike profiles created by ColorByte, profiles generated by other methods 
will not cause Imageprint to automatically choose the right Quality and Inkset 
settings, so those parameters must always be set manually.  See chapter 15, 
Printing and Print Setup, for more information.
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Appendix G - Understanding Profile Names

Important:  With the Profile Valet, most users will never need to know much 
about the filenames of the profiles they are using as the Profile Valet allows you 

to acquire profiles by specifying the name of the paper.  
 

Therefore the next few pages are only of interest to those who are not using the 
Profile Valet or simply want to know more about the underlying workings of the 

software.

The color profiles supplied with ImagePrint are named according to the type of printer they char-
acterize and the paper they are made for.  The profile name may also contain references to the 
type of ink used, the printer resolution it was created for, and the lighting condition (temperature) 
the profile is made for.  Because of the potentially large number of parameters any profile may 
reflect abbreviations must be used, and profile names can sometimes be hard to decipher. 
 

ColorByte keeps  a list of profile names and descriptions within each printer 
folder on the Online Profile Download site.  You can easily access these lists via 
the Profile Manager utility.  Description files will be listed at the top of the paper 

manufacturer’s folders and can be accessed by double-clicking them.  The Profile 
Manager will also display the paper name and other information for the currently 

selected profile at the bottom of the utility’s window.

Following are details on the various naming conventions used by the default profiles supplied 
with ImagePrint. 

Printer Type:  The first part of the profile name contains the printer type.  In the case 
of printers with identical printing characteristics, the name may reflect a different printer, 
such as the Epson 4800/7800/9800.  In those cases, profiles for these printers can be 
used interchangeably.  For a listing of how this applies to specific printers, please see the 
“Printer Specific Settings” section of the Appendix of this manual.  

Important:  One special case is the Epson 4800, 7800 and 9800 printers.  Those 
printers use the same print head technology, and can therefore share the same 
profiles.  All profiles made for those printers will have the designation: X800 in 

their name.
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Paper Type:  The paper that the profile was generated for is usually listed as the 2nd part 
of the profile name. Typically, the papers manufacturer is listed as a two letter abbrevia-
tion, followed by an abbreviation of the paper type.  Common manufacturer abbreviations 
are:

 
 ep - Epson		  hp - Hewlett Packard		   
 cn  - Canon		  il   - Ilford 
 lj   - Lexjet		  hn - Hahnamule 
 bc - BrightCube 	 dp - Dupont 
 	

Ink Set:  If no ink set is specified in the profile name, it can be assumed the profile was 
generated with the default, printer manufacturers ink set for that printer.  For printers that 
accept different ink sets, an abbreviation will appear in the title of the profile reflecting this.  
Current ink set abbreviations are:

 mk - Matte Black ink 
 pk -  Photo Black Ink 
 dk -  Phatte Black (using ColorByte’s Phatte Black option 
 Dye - Dye (non-archival) ink set 
 CF - Pigment (Color Fast archival) ink set

DCM:  For older printers the number “7” appears right after the Ink Set designation in a 
Color (not gray) profile then DCM (dynamic contrast matching) is incorporated in that pro-
file. (For more on DCM see the DCM section at the end of this chapter)

Soft Proof Gray: Grayscale profiles for older printers with the number “7” in the title are 
newer “soft proof” profiles which contain information that will allow them to be soft proofed 
in Photoshop via its “Proof Setup” feature. (For more on DCM see the DCM section at the 
end of this chapter)

Color Space: Most of ImagePrint’s default printer profiles are 3-color profiles or grayscale 
profiles.  If no color space is listed in the profile name, 3 colors can be assumed.  Although 
4 color (CMYK) profiles are fully supported, the technology utilized by ImagePrint in gener-
ating a black curve specific for supported printers generally causes 3 color profiles to yield 
optimal results.

For many printers, ColorByte creates special Grayscale profiles that use almost no color 
inks when printing, resulting in very neutral prints that show no inconstancy (alteration in 
different lighting conditions).  These grayscale profiles also can be used with ImagePrint’s 
narrow gamut controls to tone your images (see Toning within the Corrections chapter in 
this manual).  Gray scale profiles will have the word GRAY in their title.  

Understanding Profile Names    (cont.)
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Lighting Conditions:  Its a fact of life: Color prints from ink jet printers will look 
different, to one degree or another, when viewed under different lighting condi-
tions.  

View a print under tungsten lighting, then walk it outside, and you’re likely to see 
differences in the overall cast.  A print that looks fine in your studio may take on 
a green cast when your client views it in his house, or warm when viewed in his 
office.  

To help limit the effects that different lighting conditions have on inks (inconstancy 
and/or metamerism), ColorByte provides profiles for multiple lighting environ-
ments.  Using the correct profile for the lighting condition you plan to view your 
prints in can have a strong effect on the appearance of your prints.  

All  printing profiles, no matter who makes them, are made for a specific lighting 
condition.  Most profile makers and printing software provide a single profile for a 
single lighting condition--daylight.  

If you don’t want to be bothered with choosing a temperature, you may want to just 
use the DAYLIGHT versions of our profiles.  Those will give you the most similar 

results to standard profiles you may have used before.

While sometimes its hard to know just where your prints will be viewed, having 
more than one profile type can give you a fighting chance in making sure your 
prints are viewed to their best potential.  We even provide mixed lighting profiles 
(F3) for situations where you expect the print to viewed in a mix of daylight and 
fluorescent lighting.

For example, if you know your images are going to be seen in an office environ-
ment, under fluorescent lighting, then using our F2 or F3 profile will probably be 
best.  (Taking that same print outside will likely show a color shift under daylight).

The lighting condition a specific profile is made for can be found at the end of the 
profile’s name.  (They may or may not be preceded by an “E” or and “R”).  These 
abbreviations are:

TUNG		 Tungsten lighting

Day		  Daylight lighting

CWF		  Cool White Fluorescent lighting

Understanding Profile Names    (cont.)
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Lighting Conditions (Cont.)

F2 		  (Sometimes labeled as “CWF2”). Cool White Fluorescent lighting 
optimized for portraiture work (less warm than the standard CWF pro-
file).  This is a good general purpose profile for mixed lighting condi-
tions.

F3 		  Mixed Lighting (This is the best general purpose profile to use).  

What about Gray Profiles?

ImagePrint’s grayscale profiles do NOT have a temperature designation.  That’s 
because these profiles avoid the use of colored inks in such a way as to eliminate 
color inconstancy--only one grayscale profile is used for ALL lighting conditions.

Special Note: Recipied Profiles - You may see some profiles with the letter R at the 
end of the name, just before the light temperature designation (such as RF3, or RDAY).  
These are profiles with embedded “recipes”.  A recipe profile is a special profile made by 
ColorByte that contains additional information used to control the inks in a special way for 
particular paper/ink combinations.  For instance, a recipe profile might be used to adjust 
for printing on Matte Papers with Photo Black inks (not the normal ink/paper combination).  

Generally, using a recipe profile is no different than using a “normal” one.  The only time 
it is important to know if you are using a recipe profile is when outputting profiling targets 
with Color Management turned off.  For more information on recipe profiles effect on profil-
ing targets, see the Appendix section entitled “Printing a Profiling Target”

Ink Limits: It’s rare, but if Ink Limitation was in effect when the target for the profile was 
created, the profile will also have a percent number specifying the ink reduction percent-
age to use with this profile (see Ink Limits within the Printing Chapter of this manual). 

Understanding Profile Names    (cont.)
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Naming Example:

As an example, the profile: ep3800_glossyfilm_1440_day represents a profile 
for an Epson Stylus 3800, made for glossy film media for 1440 quality, best 
viewed in daylight lighting conditions. 

Because of restrictions in name size length, profile names can be confus-
ing and hard to decipher.  If in doubt about a specific profile, use the Profile 
Manager.  Clicking on any profile name will typically show the paper it was 
made for in the lower section of the utility’s window.

Note: PROFILE DESCRIPTIONS vs PROFILE FILENAMES 
 

ICC and ICM color profiles have internal descriptions embedded at the time 
of their creation.  These descriptions are used in the profile display lists 

within the Imageprint Color Management window, and may not match the 
actual filename of the profile.  Therefore, if a profile’s filename does not 
appear in the ImagePrint profile list it may be listed elsewhere in the list  

by its internal description.

Understanding Profile Names    (cont.)
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Appendix H - ImagePrint HOST and CLIENT setup
A powerful feature of ImagePrint is network printing.  Each ImagePrint license allows 
unlimited CLIENT installations, meaning you can run the full ImagePrint interface from 
any computer on your network.  When jobs are sent to print from these remote worksta-
tions, they will automatically be sent to the spooler on the ImagePrint HOST computer, 
which takes care of sending them to the printer.

 

CLIENT 
Computer(s) 
(no dongle)

Printer

CLIENT Computer(s)  
(no dongle)

HOST Computer (with dongle)

Ethernet, USB, or 
Firewire connection

Note: Don’t confuse Host/Client printing 
with having to do with how your printer is 

connected to the Host computer--it doesn’t 
matter if the printer is connected via USB, 
Firewire or Ethernet for Host/Client printing 

to work.
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ImagePrint HOST and CLIENT setup (continued)

HOST Installation details  

During your ImagePrint installation, in IP Setup choose HOST if you are installing to 
the computer that will be printing directly to the printer.  

•	 There must be one HOST ImagePrint computer in order to print

•	 A HOST computer MUST have a dongle attached to print in non-DEMO mode

•	 The actual physical connection to the printer has no bearing on Host vs 
Client installs.  Regardless of if the printer is connected to the Host computer via 
Ethernet or some other direct connection, you will need one designated ImagePrint 
HOST computer in order to print.

•	 The HOST computer will do the processing of all print jobs to the printer

If you’re not sure if you want to install as a HOST or CLIENT, you probably should 
install as a HOST.  Most single printer setups print from just one ImagePrint HOST 
computer.

PrinterHOST Computer (with dongle)

Ethernet, USB, 
Firewire or SCSI con-

nection

One ImagePrint HOST must 
exist in order to print.  This 
HOST will have the dongle 

attached, and must be enabled 
to print in non-demo mode.
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ImagePrint HOST and CLIENT setup (continued)

CLIENT Installation details  

INSTALLING: Choose CLIENT in IP Setup if you are installing on a computer that will 
print to another computer that already has ImagePrint installed as a HOST.  Then enter 
that HOST computer’s IP Address (or, alternatively, its name if on a Windows client) in 
the PRINTER HOST FIELD.

•	 	There can be an unlimited number of CLIENT computers

•	 	The IP Address of the ImagePrint HOST computer needs to be entered into the 
PRINTER HOST field at the top of the  IP Setup window--NOT the PRINTER’S IP 
ADDRESS, which does not need to be entered at all for a CLIENT install.  (The 
HOST computer will take care of finding the printer when it receives the jobs.)

•     On Windows PC’s, instead of using the HOST computer’s IP Address when installing 
on the client, you can use the HOST computer’s NAME.  This is not an option when 
installing on a Macintosh client--on Mac client’s, the host computer’s IP Address is 
always used.  This is also true if the client is a Windows PC and the Host is a Mac.

•	 	CLIENT computers send their jobs to the HOST computer, not directly to the printer 
(even if the printer is physically reachable on the network).  

•	 	A CLIENT computer does NOT need a dongle attached and does NOT need to have 
your ImagePrint encryption enabled. If it shows in IP Setup as disabled, that’s OK.

•	 	 It is important that the IP ADDRESS of the HOST computer be STATIC (sometimes 
called Manual) in order to print to it from a CLIENT installation.  (A Static IP Address 
means that the IP ADDRESS is permanent, and will not change each time the com-
puter is rebooted.) The CLIENT IP ADDRESS does not need to be static, just the 
HOST’S.   NOTE: If on a Windows Client, and you used the HOST’s computer name 
in the Printer Host field, then a Static IP Address on the Host is not necessary.

HOST Computer (with dongle)

CLIENT 
Computer(s) 
(no dongle)

Clients communicate 
with the ImagePrint Host 
computer, not the Printer
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ImagePrint HOST and CLIENT setup (continued)

Finding the HOST computer’s IP ADDRESS

It is only necessary to know the IP ADDRESS of the HOST computer if you are installing 
a CLIENT version of ImagePrint to communicate with an ImagePrint HOST.  For stand-
alone ImagePrint installations, there is no need to know the computer’s IP Address. 

If the HOST computer is a MACINTOSH

•	 Under the Apple Menu, choose System Preferences.  

•	 In the System Preferences window, choose NETWORK.  

•	 When the NETWORK preferences panel appears, choose TCP/IP.  

•	 The IP ADDRESS of the computer will be displayed at the top of the TCP/IP 
window.

•	 Make sure the Address is listed as STATIC (also called “Manual”), not 
assigned via DHCP

If the HOST computer is a Windows PC

•	 From the Start Menu, choose Settings, then Control Panel

•	 In the Control Panels window, choose NETWORK or NETWORK 
CONNECTIONS.  

•	 Choose your NETWORK card from the NETWORK window that appears.

•	 Choose PROPERTIES (either through the FILE menu, or via the 
PROPERTIES button if available)

•	 Double-click “Internet Protocol - TCP/IP Properties”

•	 If the IP Address is a static one, it will be available in the “Use the Following 
IP Address” field.  

•	 If “Obtain an IP Address Automatically” is selected, then the IP Address is 
NOT currently static.  (A static IP Address needs to be assigned in order for 
ImagePrint Clients to print to this computer).  A valid static IP Address will 
need to be entered in the “Use the Following IP Address” fields.  If unsure of 
what IP Address to enter in this field, you should contact the administrator of 
your network.  
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